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Preface

The DES-3028/DES-3028P/DES-3052/DES-3052P User Manual is divided into sections that describe the system installation and
operating instructions with examples.

Section 1, Introduction - Describes the Switch and its features.

Section 2, Installation - Helps you get started with the basic installation of the Switch and also describes the front panel, rear
panel, side panels, and LED indicators of the Switch.

Section 3, Connecting the Switch - Tells how you can connect the Switch to your Ethernet/Fast Ethernet network.

Section 4, Introduction to Switch Management - Introduces basic Switch management features, including password protection,
SNMP settings, IP address assignment and connecting devices to the Switch.

Section 5, Introduction to Web-based Switch Management - Talks about connecting to and using the Web-based switch
management feature on the Switch.

Section 6, Administration - A detailed discussion about configuring the basic functions of the Switch, including Device
Information, IP Address, Port Configuration, DHCP/BOOTP Relay, User Accounts, Port Mirroring, System Log Settings, Log
Settings, SNTP Settings, MAC Notification Settings, TFTP Services, Multiple Image Services, Ping Test, Safeguard Engine,
SNMP Manager, PoE System, Single IP Settings, Forwarding & Filtering, and SMTP Service.

Section 7, Layer 2 Features - A discussion of Layer 2 features of the Switch, including VLAN, Trunking, IGMP Snooping, and
Spanning Tree.

Section 8, CoS - Features information on CoS, including Port Bandwidth, 802.1P Default Priority, 802.1P User Priority, CoS
Scheduling Mechanism, CoS Output Scheduling, Priority Settings, TOS Priority Settings, DSCP Priority Settings, Port Mapping
Priority Settings, and MAC Priority.

Section 9, ACL - Discussion on the ACL function of the Switch, including Time Range, Access Profile Table and CPU Interface
Filtering.

Section 10, Security - A discussion on the Security functions on the Switch, including Traffic Control, Port Security, Port Lock
Entries, SSL, SSH, 802.1X, Trusted Host, Access Authentication Control, and Traffic Segmentation.

Section 11, Monitoring - Features information on Monitoring including CPU Ultilization, Port Utilization, Packets, Packet Errors,
Packet Size, MAC Address, Switch Log, IGMP Snooping Group, Browse Router Port, Static ARP Settings, Session Table, and
Port Access Control.

Appendix A, Technical Specifications - Technical specifications for the DES-3028/DES-3028P/DES-3052 and the DES-3052P.
Appendix B, System Log Entries - Information on the System Log Entries
Appendix C, Cable Lengths - Information on cable types and maximum distances.

Appendix D, Glossary - Lists definitions for terms and acronyms used in this document.
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Intended Readers

The DES-3028/DES-3028P/DES-3052/DES-3052P User Manual contains information for setup and management of the Switch.
The term, “the Switch” will be used when referring to all four switches. This manual is intended for network managers familiar
with network management concepts and terminology.

Typographical Conventions

\ Convention Description
[] In a command line, square brackets indicate an optional entry. For example: [copy filename]
means that optionally you can type copy followed by the name of the file. Do not type the
brackets.
Bold font Indicates a button, a toolbar icon, menu, or menu item. For example: Open the File menu

and choose Cancel. Used for emphasis. May also indicate system messages or prompts
appearing on your screen. For example: You have mail. Bold font is also used to represent
filenames, program names and commands. For example: use the copy command.

Bol df ace Indicates commands and responses to prompts that must be typed exactly as printed in the

Typewiter Font manual.

Initial capital letter Indicates a window name. Names of keys on the keyboard have initial capitals. For example:
Click Enter.

Italics Indicates a window name or a field. Also can indicate a variables or parameter that is

replaced with an appropriate word or string. For example: type filename means that you
should type the actual filename instead of the word shown in italic.

Menu Name > Menu Menu Name > Menu Option Indicates the menu structure. Device > Port > Port
Option Properties means the Port Properties menu option under the Port menu option that is
located under the Device menu.

Notes, Notices, and Cautions

JE% A NOTE indicates important information that helps you make better use of your device.

B

(' A NOTICE indicates either potential damage to hardware or loss of data and tells you
how to avoid the problem.

A CAUTION indicates a potential for property damage, personal injury, or death.
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Safety Instructions

Use the following safety guidelines to ensure yonr awn personal safety and to help protect your system from potential damage.
Throughout this document, the caution icon ( ! ) is used to indicate cautions and precautions that you need to review and
follow. )

Safety Cautions

To reduce the risk of bodily injury, electrical shock, fire, and damage to the equipment, observe the following precautions.
e  Observe and follow service markings.
. Do not service any product except as explained in your system documentation.

e Opening or removing covers that are marked with the triangular symbol with a lightning bolt may expose you to
electrical shock.

. Only a trained service technician should service components inside these compartments.

e If any of the following conditions occur, unplug the product from the electrical outlet and replace the part or contact your
trained service provider:

. The power cable, extension cable, or plug is damaged.

e An object has fallen into the product.

. The product has been exposed to water.

. The product has been dropped or damaged.

. The product does not operate correctly when you follow the operating instructions.
e  Keep your system away from radiators and heat sources. Also, do not block cooling vents.

e Do not spill food or liquids on your system components, and never operate the product in a wet environment. If the system
gets wet, see the appropriate section in your troubleshooting guide or contact your trained service provider.

e Do not push any objects into the openings of your system. Doing so can cause fire or electric shock by shorting out interior
components.

e  Use the product only with approved equipment.
e Allow the product to cool before removing covers or touching internal components.

e  Operate the product only from the type of external power source indicated on the electrical ratings label. If you are not sure
of the type of power source required, consult your service provider or local power company.

e  To help avoid damaging your system, be sure the voltage on the power supply is set to match the power available at your
location:

. 115 volts (V)/60 hertz (Hz) in most of North and South America and some Far Eastern countries such as South
Korea and Taiwan

. 100 V/50 Hz in eastern Japan and 100 V/60 Hz in western Japan
. 230 V/50 Hz in most of Europe, the Middle East, and the Far East
e Also, be sure that attached devices are electrically rated to operate with the power available in your location.

e  Use only approved power cable(s). If you have not been provided with a power cable for your system or for any AC-
powered option intended for your system, purchase a power cable that is approved for use in your country. The power cable
must be rated for the product and for the voltage and current marked on the product's electrical ratings label. The voltage and
current rating of the cable should be greater than the ratings marked on the product.

e  To help prevent electric shock, plug the system and peripheral power cables into properly grounded electrical outlets. These
cables are equipped with three-prong plugs to help ensure proper grounding. Do not use adapter plugs or remove the
grounding prong from a cable. If you must use an extension cable, use a 3-wire cable with properly grounded plugs.

e  Observe extension cable and power strip ratings. Make sure that the total ampere rating of all products plugged into the
extension cable or power strip does not exceed 80 percent of the ampere ratings limit for the extension cable or power strip.
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To help protect your system from sudden, transient increases and decreases in electrical power, use a surge suppressor, line
conditioner, or uninterruptible power supply (UPS).

Position system cables and power cables carefully; route cables so that they cannot be stepped on or tripped over. Be sure
that nothing rests on any cables.

Do not modify power cables or plugs. Consult a licensed electrician or your power company for site modifications. Always
follow your local/national wiring rules.

When connecting or disconnecting power to hot-pluggable power supplies, if offered with your system, observe the
following guidelines:

. Install the power supply before connecting the power cable to the power supply.
e Unplug the power cable before removing the power supply.

. If the system has multiple sources of power, disconnect power from the system by unplugging all power cables from
the power supplies.

Move products with care; ensure that all casters and/or stabilizers are firmly connected to the system. Avoid sudden stops
and uneven surfaces.

General Precautions for Rack-Mountable Products

Observe the following precautions for rack stability and safety. Also, refer to the rack installation documentation accompanying
the system and the rack for specific caution statements and procedures.

Systems are considered to be components in a rack. Thus, "component" refers to any system as well as to various peripherals
or supporting hardware.

Before working on the rack, make sure that the stabilizers are secured to the rack, extended to the floor, and that the full
weight of the rack rests on the floor. Install front and side stabilizers on a single rack or front stabilizers for joined multiple
racks before working on the rack.

Always load the rack from the bottom up, and load the heaviest item in the rack first.
Make sure that the rack is level and stable before extending a component from the rack.

Use caution when pressing the component rail release latches and sliding a component into or out of a rack; the slide rails
can pinch your fingers.

After a component is inserted into the rack, carefully extend the rail into a locking position, and then slide the component
into the rack.

Do not overload the AC supply branch circuit that provides power to the rack. The total rack load should not exceed 80
percent of the branch circuit rating.

Ensure that proper airflow is provided to components in the rack.

Do not step on or stand on any component when servicing other components in a rack.

NOTE: A qualified electrician must perform all connections to DC power and to safety
4 grounds. All electrical wiring must comply with applicable local, regional or national codes
and practices.

L

CAUTION: Never defeat the ground conductor or operate the equipment in the absence of a
suitably installed ground conductor. Contact the appropriate electrical inspection authority or
an electrician if you are uncertain that suitable grounding is available.



CAUTION: The system chassis must be positively grounded to the rack cabinet frame. Do
not attempt to connect power to the system until grounding cables are connected. A
qualified electrical inspector must inspect completed power and safety ground wiring. An
energy hazard will exist if the safety ground cable is omitted or disconnected.

CAUTION: Do not replace the battery with an incorrect type. The risk of explosion exists if
the replacement battery is not the correct lithium battery type. Dispose of used batteries

according to the instructions.

Protecting Against Electrostatic Discharge

Static electricity can harm delicate components inside your system. To prevent static damage, discharge static electricity from
your body before you touch any of the electronic components, such as the microprocessor. You can do so by periodically touching

an unpainted metal surface on the chassis.
You can also take the following steps to prevent damage from electrostatic discharge (ESD):

1.  When unpacking a static-sensitive component from its shipping carton, do not remove the component from the antistatic
packing material until you are ready to install the component in your system. Just before unwrapping the antistatic

packaging, be sure to discharge static electricity from your body.
2. When transporting a sensitive component, first place it in an antistatic container or packaging.

3. Handle all sensitive components in a static-safe area. If possible, use antistatic floor pads, workbench pads and an
antistatic grounding strap.
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Section 1

Introduction

DES-3028/28P/52/52P Switch Description
Features

Ports

Front-Panel Components

Side Panel Description

Rear Panel Description

DES-3028/28P/52/52P

The DES-3028, DES-3028P, DES-3052, and the DES-3052P are all members of the D-Link Switch family. These Switches
provides unsurpassed performance, fault tolerance, scalable flexibility, robust security, standard-based interoperability and
impressive technology to future-proof departmental and enterprise network deployments with an easy migration path.

The following manual describes the installation, maintenance, and configurations concerning the DES-3028, DES-3028P,
DES-3052, and DES-3052P. These four Switches are identical in configuration and very similar in basic hardware and
consequentially, most of the information in this manual will be universal to the total group of switches. Corresponding screen
pictures of the web manager may be taken from any one of these switches but the configuration will be identical, except for
varying port counts. For the remainder of this document, we will use the DES-3028P as the Switch in question for examples,
screen shots, configurations, and explanations.

Features

. IEEE 802.3ad Link Aggregation Control Protocol support

o  IEEE 802.1x Port-based and MAC-based Access Control

« IEEE 802.1Q VLAN

o IEEE 802.1D Spanning Tree, IEEE 802.1W Rapid Spanning Tree and IEEE 802.1s Multiple Spanning Tree support
. Access Control List (ACL) support

. Single IP Management support

e Access Authentication Control utilizing TACACS, XTACACS and TACACS+
. Internal Flash Drive for saving configurations and firmware

. Simple Network Time Protocol support

. MAC Notification support

. System and Port Utilization support

. System Log Support

. Support port-based enable and disable

. Address table: Supports up to 8K MAC addresses per device

. Supports a packet buffer of up to 512K bytes

. Supports Port-based VLAN Groups

e Port Trunking with flexible load distribution and fail-over function
e  IGMP Snooping support

. SNMP support

. Secure Sockets Layer (SSL) and Secure Shell (SSH) support

. Port Mirroring support

. MIB support for:

« RFCI1213MIB II

e  RFC1493 Bridge

« RFC2819 RMON



RFC2665 Ether-like MIB

RFC2863 Interface MIB

Private MIB

RFC2674 for 802.1p

IEEE 802.1x MIB

IEEE 802.3x flow control in full duplex mode
IEEE 802.1p Priority Queues

IEEE 802.3u 100BASE-TX compliant

RS-232 DCE console port for Switch management
Provides parallel LED display for port status such as link/act, speed, etc.
IEEE 802.3 10BASE-T compliant

High performance switching engine performs forwarding and filtering at wire speed, maximum 14,881 packets/sec
on each 10Mbps Ethernet port, maximum 148,810 packet/sec on 100Mbps Fast Ethernet port and 1,488,100 for each
Gigabit port

Full and half-duplex for both 10Mbps and 100Mbps connections. Full duplex allows the switch port to
simultaneously transmit and receive data. It only works with connections to full-duplex-capable end stations and
switches. Connections to a hub must take place at half-duplex

Support Broadcast/Multicast storm control

Non-blocking store and forward switching scheme capability to support rate adaptation and protocol conversion
Supports by-port Egress/Ingress rate control

Efficient self-learning and address recognition mechanism enables forwarding rate at wire speed



Ports

The following table lists the relative ports that are present within each switch:

DES-3028 and DES-3028P DES-3052 and DES-3052P
Twenty-four 10/100BASE-T Forty-eight 10/100Mbps Ports
Two 1000Base-T/SFP Combo Two 1000Base-T/SFP Combo Ports
Ports Two 1000Base-T Ports
Two 1000Base-T Ports One female DCE RS-232 DB-9
One female DCE RS-232 DB-9 console port
console port

The following table lists the features and compatibility for each type of port present in the DES-3028/28P/52/52P.

10/100/1000BASE-T SFP Combo 1000BASE-T Combo

IEEE 802.3 compliant SFP Transceivers Supported: | |EEE 802.3 compliant

. DEM-310GT (1000BASE-LX) .
IEEE 802.3u compliant DEM-311GT (1000BASE-SX) IEEE 802.3u compliant

IEEE 802.3x flow control | DEM-314GT (1000BASE-LH) IEEE 802.3ab compliant

support in full-duplex DEM-315GT (1000BASE-ZX) .

Auto MDIX/MDLI DEM-210 (Single Mode IEEE 802.3z compliant

ver suooort 0% | 100BASE-FX) IEEE 802.3x flow control
PP DEM-211 (Multi Mode | support in full-duplex

100BASE-FX)

WDM Transceiver Supported:

DEM-330T (TX-1550/RX-
1310nm), up to 10km,Single-
Mode

DEM-330R (TX-1310/RX-
1550nm), up to 10km,Single-
Mode
DEM-331T (TX-1550/RX-
1310nm), up to 40km, Single-
Mode
DEM-331R (TX-1310/RX-
1550nm), up to 40km, Single-
Mode

Compliant to the following
standards:
1. IEEE 802.3z compliance

2.IEEE 802.3u compliance

[, NOTE: The SFP combo ports on the Switch cannot be used simultaneously with the
22% corresponding 1000BASE-T ports. If both ports are in use at the same time (ex. port 25
{ {j of the SFP and port 25 of the 1000BASE-T), the SFP ports will take priority over the
- combo ports and render the 1000BASE-T ports inoperable.



Front-Panel Components

DES-3028P

o Twenty-four 10/100Mbps BASE-T ports

e Two Combo 1000BASE-T/SFP ports located to the right

e Two 1000BASE-T ports located to the right

e  One female DCE RS-232 DB-9 console port

e LEDs for Power, Console, PoE, Link/Act/Speed for each port

F?????ﬁl CI T 1T T 1) C1]
S T 10 98 0 10 0 0 [0 O O 0 O | |
Figure 1- 1. Front Panel of the DES-3028P
DES-3052P
e Forty-eight 10/100Mbps BASE-T ports
e Two Combo 1000BASE-T/SFP ports located to the right
e Two 1000BASE-T ports located to the right
e  One female DCE RS -232 DB-9 console port
e LEDs for Power, Console, PoE, Link/Act/Speed for each port
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Figure 1- 2. Front Panel of the

DES-3052P




LEDs

The following table lists the LEDs located on models of the DES-30xx Switches along with their corresponding description:

Location

LED Indicative

Color

Status

Description

Per Device

Power

Green

Solid Light

Power On

Light off

Power Off

Console

Green

Solid Light

Console on

Blinking

POST is in progress/ POST
is failure.

Light off

Console off

“Mode Select
Button”

Link/Act/ Speed

Green

Solid Light

Link/Act/Speed Mode

PoE

Green

Solid Light

PoE Mode

LED Per
10/100 Mbps
Port

Link/Act/Speed

Green/Amber

Solid Green

When there is a secure
100Mbps Fast Ethernet
connection (or link) at any of
the ports.

Blinking Green

When there is reception or
transmission (i.e. Activity—
Act) of data occurring at a
Fast Ethernet connected
port.

Solid Amber

When there is a secure
10Mbps Ethernet connection
(or link) at any of the ports.

Blinking Amber

When there is reception or
transmission (i.e. Activity—
Act) of data occurring at an
Ethernet connected port.

Light off

No link

PoE

Green

Solid Green

Powered device is

connected.

Blinking

Port has detected a error
condition

Light off

Powered Device may receive
power from an AC power
source or no 802.3af PD is
found

LED Per GE
Port

Link/Act/Speed
mode for
1000BASE-T ports

Green/Amber

Solid Green

When there is a secure
1000Mbps connection (or
link) at any of the ports.

Blinking Green

When there is reception or
transmission (i.e. Activity--
Act) of data occurring at a
1000Mbps connected port.

Solid Amber

When there is a secure
10/100Mbps Fast Ethernet
connection (or link) at any of
the ports.

Blinking Amber

When there is reception or
transmission (i.e. Activity—
Act) of data occurring at a
Fast Ethernet connected
port.

Light off

No link




Link/Act/Speed
mode for SFP
ports

Green/Amber

Solid Green

When there is a secure
1000Mbps connection (or
link) at the ports.

Blinking Green

When there is reception or
transmission (i.e. Activity--
Act) of data occurring at a
1000Mbps connected port.

Solid Amber

When there is a secure
100Mbps connection (or link)
at any of the ports.

Blinking Amber

When there is reception or
transmission (i.e. Activity—
Act) of data occurring at the
ports.

Light off

No link

Installing the SFP ports

The DES-3028/28P/52/52P Switches are equipped with SFP (Small Form Factor Portable) ports, which are to be used with fiber-
optical transceiver cabling in order to uplink various other networking devices for a gigabit link that may span great distances.
These SFP ports support full-duplex transmissions, have auto-negotiation and can be used with the DEM-310GT (1000BASE-
LX), DEM-311GT (1000BASE-SX), DEM-210 (Single Mode 100BASE-FX), DEM-211 (Multi Mode 100BASE-FX), DEM-
314GT (1000BASE-LH), DEM-315GT (1000BASE-ZX), DEM-330T/R (WDM) and DEM-331T/R (WDM) transceivers. See the

figure below for installing the SFP ports in the Switch.

Figure 1- 3. Inserting the fiber-optic transceivers into the DES-3028/28P/52/52P Switch




Section 2

Installation

Package Contents

Before You Connect to the Network
Installing the Switch without the Rack
Rack Installation

Power On

Package Contents

Open the shipping carton of the Switch and carefully unpack its contents. The carton should contain the following items:
. One Stand-alone Switch
. One AC power cord
. This Manual on CD
. Mounting kit (two brackets and screws)
o  Four rubber feet with adhesive backing
e  DCE RS-232 console cable

If any item is missing or damaged, please contact your local D-Link Reseller for replacement.

Before You Connect to the Network

The site where you install the Switch may greatly affect its performance. Please follow these guidelines for setting up the Switch.

. Install the Switch on a sturdy, level surface that can support at least 4.24kg (9.351bs) of weight. Do not place heavy
objects on the Switch.

. The power outlet should be within 1.82 meters (6 feet) of the Switch.
e  Visually inspect the power cord and see that it is fully secured to the AC/DC power port.

. Make sure that there is proper heat dissipation from and adequate ventilation around the Switch. Leave at least 10 cm
(4 inches) of space at the front and rear of the Switch for ventilation.

. Install the Switch in a fairly cool and dry place for the acceptable temperature and humidity operating ranges.

. Install the Switch in a site free from strong electromagnetic field generators (such as motors), vibration, dust, and
direct exposure to sunlight.

. When installing the Switch on a level surface, attach the rubber feet to the bottom of the device. The rubber feet
cushion the Switch, protect the casing from scratches and prevent it from scratching other surfaces.



Installing the Switch without the Rack

When installing the Switch on a desktop or shelf, the rubber feet included with the Switch should first be attached. Attach these
cushioning feet on the bottom at each corner of the device. Allow enough ventilation space between the Switch and any other

objects in the vicinity.

i Rubber Feet

Figure 2 - 1. Prepare Switch for installation on a desktop or shelf

Installing the Switch in a Rack

The Switch can be mounted in a standard 19" rack. Use the following diagrams to guide you.

Figure 2 - 2. Fasten mounting brackets to Switch

Fasten the mounting brackets to the Switch using the screws provided. With the brackets attached securely, users can mount the
Switch in a standard rack as shown in the next figure.



Mounting the Switch in a Standard 19" Rack

CAUTION: Installing systems in a rack without the front and side stabilizers installed could cause the
rack to tip over, potentially resulting in bodily injury under certain circumstances. Therefore, always
install the stabilizers before installing components in the rack. After installing components in a rack, do
not pull more than one component out of the rack on its slide assemblies at one time. The weight of
more than one extended component could cause the rack to tip over and may result in injury.

)

000 000

Figure 2 - 3. Installing Switch in a rack

Power on AC Power
Plug one end of the AC power cord into the power connector of the Switch and the other end into the local power source outlet.

After the Switch is powered on, the LED indicators will momentarily blink. This blinking of the LED indicators represents a reset
of the system.

Power Failure

For AC power supply units, as a precaution, in the event of a power failure, unplug the Switch. When power has resumed, plug the
Switch back in.

CAUTION: Installing systems in a rack without the front and side stabilizers installed could cause the
rack to tip over, potentially resulting in bodily injury under certain circumstances. Therefore, always
install the stabilizers before installing components in the rack. After installing components in a rack, do
not pull more than one component out of the rack on its slide assemblies at one time. The weight of
more than one extended component could cause the rack to tip over and may result in injury.



Section 3

Connecting the Switch

Switch to End Node
Switch to Hub or Switch

Connecting to Network Backbone or Server

NOTE: All 10/100/1000Mbps NWay Ethernet ports can support both MDI-
f Il and MDI-X connections.
B

Switch to End Node

End nodes include PCs outfitted with a 10, 100 or 1000 Mbps RJ 45 Ethernet/Fast Ethernet Network Interface Card (NIC) and
most routers. An end node can be connected to the Switch via a twisted-pair Category 3, 4, or 5 UTP/STP cable. The end node
should be connected to any of the ports of the Switch.

DLink * .+ =.% .5 &,: = W &% 8.8 8.8 4,8 .4 4,8 8,8 8.8 8,8 8,8 &,8:)

Tttt Tl ol 1 o ] IO
3NN N NN [N PN NN N | N N LN NN L i |

[ ]
——

RJ-45 Connector

Figure 3- 1. Switch connected to an end node

The Link/Act LEDs for each UTP port will light green or amber when the link is valid. A blinking LED indicates packet activity
on that port.



Switch to Hub or Switch

These connections can be accomplished in a number of ways using a normal cable.

. A 10BASE-T hub or switch can be connected to the Switch via a twisted-pair Category 3, 4 or 5 UTP/STP cable.
e A 100BASE-TX hub or switch can be connected to the Switch via a twisted-pair Category 5 UTP/STP cable.

e A 1000BASE-T switch can be connected to the Switch via a twisted pair Category Se UTP/STP cable.

e A switch supporting a fiber-optic uplink can be connected to the Switch’s SFP ports via ﬁber—optlc cabling.

DO

AT AT [

OO [ )|

o

b

L |

v

STRAIGHT CABLE ——»—|

Figure 3- 2. Switch connected to a normal (non-Uplink) port on a hub or switch using a straight or crossover

NOTICE: When the SFP transceiver acquires a link, the associated integrated

~¢——— CROSSOVER CABLE

Switch or Hub

D-Link

o 6553

cable

10/100/1000BASE-T port is disabled.
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Section 4

Introduction to Switch Management

Management Options

Web-based Management Interface

SNMP-Based Management

Managing User Accounts

Command Line Console Interface through the Serial Port
Connecting the Console Port (RS-232 DCE)

First Time Connecting to the Switch

Password Protection

SNMP Settings

IP Address Assignment

Management Options

This system may be managed out-of-band through the console port on the front panel or in-band using Telnet. The user may also
choose the web-based management, accessible through a web browser.

Web-based Management Interface

After you have successfully installed the Switch, you can configure the Switch, monitor the LED panel, and display statistics
graphically using a web browser, such as Netscape Navigator (version 6.2.3 and higher) or Microsoft® Internet Explorer (version
6.0).

SNMP-Based Management

You can manage the Switch with an SNMP-compatible console program. The Switch supports SNMP version 1.0, version 2.0 and
version 3.0. The SNMP agent decodes the incoming SNMP messages and responds to requests with MIB objects stored in the
database. The SNMP agent updates the MIB objects to generate statistics and counters.

Connecting the Console Port (RS-232 DCE)

The Switch provides an RS-232 serial port that enables a connection to a computer or terminal for monitoring and configuring the
Switch. This port is a female DB-9 connector, implemented as a data terminal equipment (DTE) connection.

To use the console port, you need the following equipment:

. A terminal or a computer with both a serial port and the ability to emulate a terminal.

. A null modem or crossover RS-232 cable with a female DB-9 connector for the console port on the Switch.
To connect a terminal to the console port:

1. Connect the female connector of the RS-232 cable directly to the console port on the Switch, and tighten the captive
retaining screws.

2. Connect the other end of the cable to a terminal or to the serial connector of a computer running terminal emulation
software. Set the terminal emulation software as follows:

Select the appropriate serial port (COM port 1 or COM port 2).
Set the data rate to 9600 baud.
Set the data format to 8 data bits, 1 stop bit, and no parity.

S kAW

Set flow control to none.
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10.
11.

12.

13.
14.

Under Properties, select VT100 for Emulation mode.

Select Terminal keys for Function, Arrow, and Ctrl keys. Ensure that you select Terminal keys (not Windows keys).

£, NOTE: When you use HyperTerminal with the Microsoft® Windows® 2000 operating sys-
‘E% tem, ensure that you have Windows 2000 Service Pack 2 or later installed. Windows 2000
i {j Service Pack 2 allows you to use arrow keys in HyperTerminal's VT100 emulation. See
- www.microsoft.com for information on Windows 2000 service packs.

After you have correctly set up the terminal, plug the power cable into the power receptacle on the back of the Switch.
The boot sequence appears in the terminal.
After the boot sequence completes, the console login screen displays.

If you have not logged into the command line interface (CLI) program, press the Enter key at the User name and
password prompts. There is no default user name and password for the Switch. The administrator must first create user
names and passwords. If you have previously set up user accounts, log in and continue to configure the Switch.

Enter the commands to complete your desired tasks. Many commands require administrator-level access privileges. Read
the next section for more information on setting up user accounts. See the DES-3028/28P/52/52P CLI Manual on the
documentation CD for a list of all commands and additional information on using the CLI.

When you have completed your tasks, exit the session with the logout command or close the emulator program.

Make sure the terminal or PC you are using to make this connection is configured to match these settings.

If you are having problems making this connection on a PC, make sure the emulation is set to VT-100. You will be able to set the
emulation by clicking on the File menu in you HyperTerminal window, clicking on Properties in the drop-down menu, and then
clicking the Settings tab. This is where you will find the Emulation options. If you still do not see anything, try rebooting the
Switch by disconnecting its power supply.

Once connected to the console, the screen below will appear on your console screen. This is where the user will enter commands
to perform all the available management functions. The Switch will prompt the user to enter a user name and a password. Upon
the initial connection, there is no user name or password and therefore just press enter twice to access the command line interface.

DES-3028P Fast Ethernet Switch Command Line Interface

Firmware: Build 1.00-B22
Copyright{C) 2006-20069 D-Link Corporation. All rights reserved.
UserName:

Figure 4- 1. Initial screen after first connection
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First Time Connecting to the Switch

The Switch supports user-based security that can allow you to prevent unauthorized users from accessing the Switch or changing
its settings. This section tells how to log onto the Switch.

$ o NOTE: The passwords used to access the Switch are case-sensitive; therefore, "S" is
Il ‘ not the same as "s."

When you first connect to the Switch, you will be presented with the first login screen.

l--\.\.!
e:? : NOTE: Press Ctrl+R to refresh the screen. This command can be used at any time to
i i force the console program in the Switch to refresh the console screen.

=

Press Enter in both the Username and Password fields. You will be given access to the command prompt DES-3028P:4# shown
below:

There is no initial username or password. Leave the Username and Password fields blank.

DES-3028P Fast Ethernet Switch Command Line Interface

Firmware: Build 1.00-B22
Copyright{C} 20085-20809 D-Link Corporation. All rights reserved.
UserName:
PassHord:

DES-3028P : &4 _

Figure 4- 2. Command Prompt

="r1r = NOTE: The first user automatically gets Administrator level privileges. It is recommended to
i ’ create at least one Admin-level user account for the Switch.
'

Password Protection

The Switch does not have a default user name and password. One of the first tasks when settings up the Switch is to create user
accounts. Once logged in using a predefined administrator-level user name, users will have privileged access to the Switch's
management software.

After your initial login, define new passwords for both default user names to prevent unauthorized access to the Switch, and
record the passwords for future reference.

To create an administrator-level account for the Switch, follow these steps:

e At the CLI login prompt, enter create account admin followed by the <user name> and press the Enter key.

13



. The switch will then prompt the user for a password. Type the <password> used for the administrator account being
created and press the Enter key.

. Again, the user will be prompted to enter the same password again to verify it. Type the same password and press
the Enter key.

. Successful creation of the new administrator account will be verified by a Success message.

-\l\'l

NOTE: Passwords are case sensitive. User names and passwords can be
{ {§ up to 15 characters in length.
'

The sample below illustrates a successful creation of a new administrator-level account with the user name "newmanager".

DES-3028:4# create account admin newmanager
Command: create account admin newmanager

Enter a case-sensitive new password: ********
Enter the new password again for confirmation: ********

Success.

DES-3028:4#

NOTICE: CLI configuration commands only modify the running configuration file
and are not saved when the Switch is rebooted. To save all your configuration
changes in nonvolatile storage, you must use the save command to copy the
running configuration file to the startup configuration.

SNMP Settings

Simple Network Management Protocol (SNMP) is an OSI Layer 7 (Application Layer) designed specifically for managing and
monitoring network devices. SNMP enables network management stations to read and modify the settings of gateways, routers,
switches, and other network devices. Use SNMP to configure system features for proper operation, monitor performance and
detect potential problems in the Switch, switch group or network.

Managed devices that support SNMP include software (referred to as an agent), which runs locally on the device. A defined set of
variables (managed objects) is maintained by the SNMP agent and used to manage the device. These objects are defined in a
Management Information Base (MIB), which provides a standard presentation of the information controlled by the on-board
SNMP agent. SNMP defines both the format of the MIB specifications and the protocol used to access this information over the
network.

The DES-3028/28P/52/52P supports SNMP versions 1, 2¢, and 3. You can specify which version of SNMP you want to use to
monitor and control the Switch. The three versions of SNMP vary in the level of security provided between the management
station and the network device.

In SNMP v.1 and v.2, user authentication is accomplished using 'community strings', which function like passwords. The remote
user SNMP application and the Switch SNMP must use the same community string. SNMP packets from any station that has not
been authenticated are ignored (dropped).

The default community strings for the Switch used for SNMP v.1 and v.2 management access are:
e  public - Allows authorized management stations to retrieve MIB objects.
e  private - Allows authorized management stations to retrieve and modify MIB objects.

SNMP v.3 uses a more sophisticated authentication process that is separated into two parts. The first part is to maintain a list of
users and their attributes that are allowed to act as SNMP managers. The second part describes what each user on that list can do
as an SNMP manager.

The Switch allows groups of users to be listed and configured with a shared set of privileges. The SNMP version may also be set
for a listed group of SNMP managers. Thus, you may create a group of SNMP managers that are allowed to view read-only
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information or receive traps using SNMP v.1 while assigning a higher level of security to another group, granting read/write privi-
leges using SNMP v.3.

Using SNMP v.3 individual users or groups of SNMP managers can be allowed to perform or be restricted from performing
specific SNMP management functions. The functions allowed or restricted are defined using the Object Identifier (OID)
associated with a specific MIB. An additional layer of security is available for SNMP v.3 in that SNMP messages may be
encrypted. To read more about how to configure SNMP v.3 settings for the Switch read the section entitled Management.

Traps

Traps are messages that alert network personnel of events that occur on the Switch. The events can be as serious as a reboot
(someone accidentally turned OFF the Switch), or less serious like a port status change. The Switch generates traps and sends
them to the trap recipient (or network manager). Typical traps include trap messages for Authentication Failure, Topology Change
and Broadcast\Multicast Storm.

MIBs

The Switch in the Management Information Base (MIB) stores management and counter information. The Switch uses the
standard MIB-II Management Information Base module. Consequently, values for MIB objects can be retrieved from any SNMP-
based network management software. In addition to the standard MIB-II, the Switch also supports its own proprietary enterprise
MIB as an extended Management Information Base. Specifying the MIB Object Identifier may also retrieve the proprietary MIB.
MIB values can be either read-only or read-write.

IP Address Assignment

Each Switch must be assigned its own IP Address, which is used for communication with an SNMP network manager or other
TCP/IP application (for example BOOTP, TFTP). The Switch's default IP address is 10.90.90.90. You can change the default
Switch IP address to meet the specification of your networking address scheme.

The Switch is also assigned a unique MAC address by the factory. This MAC address cannot be changed, and can be found by
entering the command "show switch" into the command line interface, as shown below.

Device Type : DES-3028P Fast Ethernet Switch
MAC Address : Bp-50-BA-30-28-00

IP Address : 10.90.90.91 (Manual)

YLAN Name : default

Subnet HMask : 295.0.0.0

Default Gateway : 0.0.0.0

Boot PROH VYersion : Build 1.00-BB4
Firmware VYersion : Build 1.88-B22
Hardware VYersion : 1A16

System Name :

Svystem Location

System Contact

Spanning Tree : Disabled
GYRP : Disabled
IGHP Snooping : Disabled
802 .1x : Disabled
TELHET : Enabled(TCP 23)
WEB : Enabled(TCP 80)
RMON : Disabled
SSH : Disabled
SSL : Disabled

Clipagin . Enabled
m%ﬁi h B Quit FHiEE @ Next Page [N Next Entry [ All

Figure 4- 3. Show switch command

The Switch's MAC address can also be found from the Web management program on the Switch Information (Basic Settings)
window on the Configuration menu.

The IP address for the Switch must be set before it can be managed with the Web-based manager. The Switch IP address can be
automatically set using BOOTP or DHCP protocols, in which case the actual address assigned to the Switch must be known.

The IP address may be set using the Command Line Interface (CLI) over the console serial port as follows:

Starting at the command line prompt, enter the commands
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config ipif System ipaddress xxx.xxx.Xxx.xxx/yyy.yyy.yyy.yyy

Where the x's represent the IP address to be assigned to the IP interface named System and the y's represent the corresponding
subnet mask.

Alternatively, you can enter config ipif System ipaddress xxx.xxx.xxx.xxx/z. Where the x's represent the IP address to be
assigned to the IP interface named System and the z represents the corresponding number of subnets in CIDR notation.

The IP interface named System on the Switch can be assigned an IP address and subnet mask, and then be used to connect a
management station to the Switch's Telnet or Web-based management agent.

DES-3028P: 4Hconfig ipif System ipaddress 10.90.960.91/8
Command: config ipif System ipaddress 10.90.90.91/8

Success.

DES-3028P: &#_

Figure 4- 4. Assigning the Switch an IP Address

In the above example, the Switch was assigned an IP address of 10.90.90.91 with a subnet mask of 255.0.0.0. (the CIDR form was
used to set the address (10.90.90.91/8). The system message Success indicates that the command was executed successfully. The
Switch can now be configured and managed via Telnet and the CLI or via the Web-based management.
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Section 5

Web-based Switch Configuration

Introduction

Login to Web manager
Web-Based User Interface
Basic Setup

Reboot

Basic Switch Setup
Network Management
Switch Utilities

Network Monitoring

IGMP Snooping Status

Introduction

All software functions of the Switch can be managed, configured and monitored via the embedded web-based (HTML) interface.
The Switch can be managed from remote stations anywhere on the network through a standard browser such as Opera, Netscape
Navigator/Communicator, or Microsoft Internet Explorer. The browser acts as a universal access tool and can communicate
directly with the Switch using the HTTP protocol.

The Web-based management module and the Console program (and Telnet) are different ways to access the same internal
switching software and configure it. Thus, all settings encountered in web-based management are the same as those found in the
console program.

Login to Web Manager

To begin managing the Switch, simply run the browser you have installed on your computer and point it to the I[P address you
have defined for the device. The URL in the address bar should read something like: http://123.123.123.123, where the numbers
123 represent the IP address of the Switch.

o

ﬁ% NOTE: The Factory default IP address for the Switch is 10.90.90.90.
M

=

This opens the management module's user authentication window, as seen below.
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Connect to 10.90.90.90

DES-3025P
Liser narme; | £ admin v |
Password: | YT T) |

[ 1remember my password

[ Ok l [ Cancel

Figure 5- 1. Enter Network Password dialog

Enter “admin” in both the User Name and Password fields and click OK. This will open the Web-based user interface. The
Switch management features available in the web-based manager are explained below.

Web-based User Interface

The user interface provides access to various Switch configuration and management windows, allows you to view performance
statistics, and permits you to graphically monitor the system status.

Areas of the User Interface

The figure below shows the user interface. The user interface is divided into three distinct areas as described in the table.
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2R DES-3028P - Microsoft Internet Explorer @@
File Edit View Favorites Tools Help .','
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B DESSOZBP Fast Ethernet Switch
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- R e = 100204
2 prmere vorn (R
il
e
|
e frea?
: A Disabled Dietail settings
- Disabled Detail settings
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Single IP Management Enabled Detail settings
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SSL Disabled Detail settings
G Serial Port Auto Logout 10 Minutes v
| MAC Address Aging Time (10- 300
- 1000000)
s Rt Oty | IS
z 3 Telnet Status Enabled v W AL ENSN s
-g‘]npplet MultiTablez started ® Internet
Figure 5- 2. Main Web-Manager page
Area Function
Area 1 Select the folder or window to be displayed. The folder icons can be opened to display the hyper-
linked window buttons and subfolders contained within them. Click the D-Link logo to go to the D-
Link website.
Area 2 Presents a graphical near real-time image of the front panel of the Switch. This area displays the

Switch's ports and expansion modules, showing port activity, duplex mode, or flow control,
depending on the specified mode.

Various areas of the graphic can be selected for performing management functions, including port
configuration.

Area 3 Presents switch information based on your selection and the entry of configuration data.

NOTICE: Any changes made to the Switch configuration during the current
(t session must be saved in the Save Changes web menu (explained below)
or use the command line interface (CLI) command save.




Web Pages

When you connect to the management mode of the Switch with a web browser, a login window is displayed. Enter a user name
and password to access the Switch's management mode.

Below is a list and description of the main folders available in the web interface:

Administration — Contains windows concerning configuring the basic functions of the Switch, including Device Information, IP
Address, Port Configuration, DHCP/BOOTP Relay, User Accounts, Port Mirroring, System Log Settings, Log Settings, SNTP
Settings, MAC Notification Settings, TFTP Services, Multiple Image Services, Ping Test, Safeguard Engine, SNMP Manager,
PoE System, Single IP Settings, Forwarding & Filtering, and SMTP Service.

Layer 2 Features — Contains windows concerning Layer 2 features of the Switch, including VLAN, Trunking, IGMP Snooping,
and Spanning Tree.

CoS — Contains windows concerning Port Bandwidth, 802.1P Default Priority, 802.1P User Priority, CoS Scheduling Mechanism,
CoS Output Scheduling, Priority Settings, TOS Priority Settings, Port Mapping Priority Settings, and MAC Priority.

ACL - Contains the window for the Time Range, Access Profile Table, and CPU Interface Filtering.

Security — Contains windows for Traffic Control, Port Security, Port Lock Entries, SSL, SSH, 802.1x, Trusted Host, Access
Authentication Control, and Traffic Segmentation.

Monitoring — Contains windows for CPU Utilization, Port Utilization, Packets, Packet Errors, Packet Size, MAC Address, Switch
Log, IGMP Snooping Group, Browse Router Port, Static ARP Settings, Session Table, and Port Access Control.

Switch Maintenance — Contains information regarding Reset, Reboot System, Save Changes, and Logout.

NOTE: Be sure to configure the user name and password in the User
Accounts window before connecting the Switch to the greater network.

L

20



Section 6

Administration

IP Address

Port Configuration
DHCP/BOOTP Relay
User Accounts

Port Mirroring

System Log Settings
Log Settings

SNTP Settings

MAC Notification Settings
TFTP Services

Multiple Image Services
Ping Test

Safeguard Engine
SNMP Manager

PoE System

Single IP Setting
Forwarding & Filtering
SMTP Service

21



Device Information
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This window contains the main settings for all major functions
for the Switch and appears automatically when you log on. To
return to the Device Information window, click the DES-
30xx Web Management Tool folder. The Device
Information window shows the Switch’s MAC Address
(assigned by the factory and unchangeable), the Boot PROM,
Firmware Version, and Hardware Version. This
information is helpful to keep track of PROM and firmware
updates and to obtain the Switch's MAC address for entry into
another network device's address table, if necessary. The user
may also enter a System Name, System Location and
System Contact to aid in defining the Switch, to the user's
preference. In addition, this window displays the status of
functions on the Switch to quickly assess their current global
status. Some functions are hyper-linked to their configuration

Device Type DES-3028P Fast Ethernet Switch
MAC Address 00:50BA:30:28:00

IP Address 10.90.90.91 (Mlanual)

default

Subnet Mask 255.0.0.0

Default Gateway 0.0.0.0

Boot PROM Version Build 1.00-B04

Firmware Version Build 1.00-B22

Hardware Version 141G

System Name

window for easy access from the Device Information Spanning Tree Disabled Detad setings
window. MAC Notification Digabled Detail sethings

Port Mirror Dizabled Detail settmgs
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[7]
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eb TCP Port Number(1-65535) a0
RMON Status Digahled
Link Aggregation Algorithm MAC Source v
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Switch 802.1x Disabled  »
Anth Protocol
Syslog Status Disabled v

Port Security Trap Log Dizabled
ARP Aging Time(0-65535) 20
GVRP Dizakled

Figure 6- 1. Device Information window

The fields that can be configured are described below:

Parameter Description

System Name Enter a system name for the Switch, if so desired. This name will identify it in the Switch
network.

System Location Enter the location of the Switch, if so desired.

System Contact Enter a contact name for the Switch, if so desired.

Serial Port Auto Select the logout time used for the console interface. This automatically logs the user out after

Logout Time an idle period of time, as defined. Choose from the following options: 2 Minutes, 5 Minutes, 10
Minutes, 15 Minutes or Never. The default setting is 10 minutes.

Serial Port Baud This field specifies the baud rate for the serial port on the Switch. there are four possible baud
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Rate

rates to choose from, 9600, 19200, 38400 and 115200. For a connection to the Switch using
the CLlI interface, the baud rate must be set to 9600, which is the default setting.

MAC Address
Aging Time

This field specifies the length of time a learned MAC Address will remain in the forwarding
table without being accessed (that is, how long a learned MAC Address is allowed to remain
idle). To change this, type in a different value representing the MAC address age-out time in
seconds. The MAC Address Aging Time can be set to any value between 70 and 1,000,000
seconds. The default setting is 300 seconds.

IGMP Snooping

To enable system-wide IGMP Snooping capability select Enabled. IGMP snooping is Disabled
by default. Enabling IGMP snooping allows you to specify use of a multicast router only (see
below). To configure IGMP Snooping for individual VLANSs, use the IGMP Snooping window
located in the IGMP Snooping folder contained in the L2 Features folder.

Multicast Router
Only

This field specifies that the Switch should only forward all multicast traffic to a multicast-
enabled router, if enabled. Otherwise, the Switch will forward all multicast traffic to any IP
router. The default is Disabled.

Telnet Status

Telnet configuration is Enabled by default. If you do not want to allow configuration of the
system through Telnet choose Disabled.

Telnet TCP Port
Number (1-65535)

The TCP port number. TCP ports are numbered between 1 and 65535. The "well-known" TCP
port for the Telnet protocol is 23.

Web Status Web-based management is Enabled by default. If you choose to disable this by selecting
Disabled, you will lose the ability to configure the system through the web interface as soon as
these settings are applied.

Web TCP Port The TCP port number. TCP ports are numbered between 1 and 65535. The "well-known" TCP

Number (1-65535)

port for the Web is 80.

RMON Status

Remote monitoring (RMON) of the Switch is Enabled or Disabled here.

Link Aggregation
Algorithm

The algorithm that the Switch uses to balance the load across the ports that make up the port
trunk group is defined by this definition. Choose MAC Source, MAC Destination, MAC Src &
Dest, (See the Link Aggregation section of this manual).

Switch 802.1x

MAC Address may enable by port or the Switch’s 802.1x function; the default is Disabled. This
field must be enabled to view and configure certain windows for 802.1x. More information
regarding 802.1x, its functions and implementation can be found later in this section, under
the Port Access Entity folder.

Port-Based 802.1x specifies that ports configured for 802.1x are initialized based on the port
number only and are subject to any authorization parameters configured.

MAC-based Authorization specifies that ports configured for 802.1x are initialized based on
the port number and the MAC address of the computer being authorized and are then subject
to any authorization parameters configured.

Auth Protocol

The 802.1x authentication protocol on the Switch is set to RADIUS Eap and cannot be
altered.

Syslog Status

Enables or disables Syslog State; default is Disabled.

Port Security Trap
Log

Toggle this setting to enable or disable the port security trap log feature. The default is
Disabled.

ARP Aging Time

The user may globally set the maximum amount of time, in minutes, an Address Resolution

(0-65535) Protocol (ARP) entry can remain in the Switch’s ARP table, without being accessed, before it
is dropped from the table. The value may be set in the range of 0 to 65535 minutes with a
default setting of 20 minutes.

GVRP Use this pull-down menu to enable or disable GVRP on the Switch.

Click Apply to implement changes made.
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IP Address

The IP address may initially be set using the console interface prior to connecting to it through the Ethernet. If the Switch IP
address has not yet been changed, read the introduction of the DES-3028/28P/52/52P CLI Manual or return to Section 4 of this
manual for more information. To change IP settings using the web manager you must access the IP Address window located in
the Administration folder.

To configure the Switch's IP address:

Open the Administration folder and click the IP Address link. The web manager will display the Switch's current IP settings in
the IP Address window, as seen below.

IP Address

Get IP From banual w
10.90.90.91
Subnet Mask 255.00.0
Default Gateway 0.0.0.0
VLAN Name default

Auto Config State Disahled v

Figure 6- 2. IP Address Settings window
To manually assign the Switch's IP address, subnet mask, and default gateway address:
1. Select Manual from the Get IP From drop-down menu.
2. Enter the appropriate IP Address and Subnet Mask.

3. If you want to access the Switch from a different subnet from the one it is installed on, enter the IP address of the Default
Gateway. If you will manage the Switch from the subnet on which it is installed, you can leave the default address
(0.0.0.0) in this field.

4. If no VLANSs have been previously configured on the Switch, you can use the default VLAN Name. The default VLAN
contains all of the Switch ports as members. If VLANs have been previously configured on the Switch, you will need to
enter the VLAN ID of the VLAN that contains the port connected to the management station that will access the Switch.
The Switch will allow management access from stations with the same VID listed here.

q._z,::p j NOTE: The Switch's factory default IP address is 10.90.90.90 with a
o j subnet mask of 255.0.0.0 and a default gateway of 0.0.0.0.
(o

To use the BOOTP or DHCP protocols to assign the Switch an IP address, subnet mask, and default gateway address:

Use the Get IP From pull-down menu to choose from BOOTP or DHCP. This selects how the Switch will be assigned an IP
address on the next reboot.

[\
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The IP Address Settings options are:

Parameter

Description

BOOTP

The Switch will send out a BOOTP broadcast request when it is powered up. The BOOTP
protocol allows IP addresses, network masks, and default gateways to be assigned by a central
BOOTP server. If this option is set, the Switch will first look for a BOOTP server to provide it with
this information before using the default or previously entered settings.

DHCP

The Switch will send out a DHCP broadcast request when it is powered up. The DHCP protocol
allows IP addresses, network masks, and default gateways to be assigned by a DHCP server. If
this option is set, the Switch will first look for a DHCP server to provide it with this information
before using the default or previously entered settings.

Manual

Allows the entry of an IP address, Subnet Mask, and a Default Gateway for the Switch. These
fields should be of the form xxx.xxx.xxx.xxx, where each xxx is a number (represented in decimal
form) between 0 and 255. This address should be a unique address on the network assigned for
use by the network administrator.

Subnet Mask

A Bitmask that determines the extent of the subnet that the Switch is on. Should be of the form
XXX.XXX.XXX.XXX, Where each xxx is a number (represented in decimal) between 0 and 255. The
value should be 255.0.0.0 for a Class A network, 255.255.0.0 for a Class B network, and
255.255.255.0 for a Class C network, but custom subnet masks are allowed.

Default Gateway

IP address that determines where packets with a destination address outside the current subnet
should be sent. This is usually the address of a router or a host acting as an IP gateway. If your
network is not part of an intranet, or you do not want the Switch to be accessible outside your
local network, you can leave this field unchanged.

VLAN Name

This allows the entry of a VLAN Name from which a management station will be allowed to
manage the Switch using TCP/IP (in-band via web manager or Telnet). Management stations that
are on VLANs other than the one entered here will not be able to manage the Switch in-band
unless their IP addresses are entered in the Security IP Management window. If VLANs have
not yet been configured for the Switch, the default VLAN contains all of the Switch's ports. There
are no entries in the Security IP Management table, by default, so any management station that
can connect to the Switch can access the Switch until a management VLAN is specified or
Management Station IP Addresses are assigned.

Auto Config
State

When autoconfig is Enabled, the Switch is instructed to get a configuration file via TFTP, and it
becomes a DHCP client automatically. The configuration file will be loaded upon booting up. In
order to use Auto Config, the DHCP server must be set up to deliver the TFTP server IP address
and configuration file name information in the DHCP reply packet. The TFTP server must be
running and have the requested configuration file stored in its base directory when the request is
received from the Switch. Consult the DHCP server and/or TFTP server software instructions for
information on loading a configuration file for use by a client.

If the Switch is unable to complete the autoconfiguration process the previously saved
configuration file present in Switch memory will be loaded.

Click Apply to allow changes to take effect.
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Setting the Switch's IP Address using the Console Interface

@,

Each Switch must be assigned its own IP Address, which is used for communication
with an SNMP network manager or other TCP/IP application (for example BOOTP,
TFTP). The Switch's default IP address is 10.90.90.90. You can change the default
Switch 1P address to meet the specification of your networking address scheme.

The 1P address for the Switch must be set before it can be managed with the Web-based
manager. The Switch TP address can be automatically set using BOOTP or DHCP
protocols, in which case the actual address assigned to the Switch must be known. The
IP address may be set using the Command Line Interface (CLI) over the console serial
port as follows:

Starting at the command line prompt, enter the commands config ipif System ipaddress
XXX.XXX.XXX XXX/ VYY.YYY.¥yy.yvy. Where the x's represent the IP address to be assigned
to the IP interface named System and the y's represent the corresponding subnet mask.

Alternatively, you can enter config ipif System ipaddress xXX.XXX.XXX.Xxx/z, Where
the x's represent the IP address to be assigned to the IP interface named System and the z
represents the corresponding number of subnets in CIDR notation.

The IP interface named System on the Switch can be assigned an [P address and subnet
mask which can then be used to connect a management station to the Switch's Telnet or
Web-based management agent.

The system message Success indicates that the command was executed successfully.
The Switch can now be configured and managed via Telnet and the CLI or via the Web-
based management agent using the above IP address to connect to the Switch.
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Port Configuration

This section contains information for configuring various attributes and properties for individual physical ports, including port
speed and flow control.

Port Settings

Click Administration > Port Configuration > Port Settings to display the following window:
To configure switch ports:
1. Choose the port or sequential range of ports using the From...To... port pull-down menus.

Use the remaining pull-down menus to configure the parameters described below:

Port Configuration

Flnw Medium

Fortl Fortl Enabled Auto b Dizabled ﬂxpply

The Port Information Table

Speed/Duplex Flow Control Connection/DuplexFlowCirl

1 Enahled Auto Dizabled LinkD owrny Enabled
2 Enahbled Auto Dizabled LinkDiown Enabled
3 Enabled Auto Dizahled LinkDowrn Enabled
4 Enabled Auto Disabled LinkD oarn Enabled
& Enahled Auto Dizabled LinkDown Enabled
il Enabled Auto Dizahled LinkDowrn Enabled
i Enabled Auto Dizabled LinkD oary Enabled
i Enahled Auto Dizabled LinkD owrn Enabled
a Enabled Auto Dizahled LinkDowrn Enabled
10 Enabled Auto Dizahled LinkDiown Enabled
11 Enahled Auto Dizabled LinkD owrn Enabled
12 Enabled Auto Dizabled LinkDown Enabled
13 Enabled Auto Dizahled LitkDowrn Enabled
14 Enahled Auto Disabled LinkD oarn Enabled
15 Enahled Auto Dizabled LinkDown Enabled
16 Enabled Auto Dizahled LinkDiowrn Enabled
17 Enahbled Auto Dizabled LinkD oary Enabled
12 Enahled Auto Dizabled LinkD oarty Enabled
19 Enahbled Auto Dizabled 10081 Fullt one Enabled
20 Enabled Auto Dizahled LinkDiowrn Enabled
21 Enahled Auto Dizabled LinkD owrn Enabled
2 Enahled Auto Dizabled LinkDown Enabled
23 Enabled Auto Dizahled LinkDown Enabled
24 Enahled Auto Disabled LinkD oarn Enabled
25012 Enahled Auta Digahled LinkDann Enahled
25(F) Enabled At Disahbled LinkDown Enahled
260C0 Enabled &uto Disabled LinkDiowrty Enabled
260F) Enabled Auto Digabled LinkDowrs Enahled
27 Enahled Auto Dizabled LinkDiown Enabled
28 Enabled Auto Dizahled LinkDiown Enabled

Figure 6- 3. Port Configuration window
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The following parameters can be configured:

Parameter Description
From.... To Use the pull-down menus to select the port or range of ports to be configured.
State Toggle this field to either enable or disable a given port or group of ports.

Speed/Duplex Toggle the Speed/Duplex field to either select the speed and duplex/half-duplex state of the
port. Auto denotes auto-negotiation between 10 and 100 Mbps devices, in full- or half-duplex.
The Auto setting allows the port to automatically determine the fastest settings the device the
port is connected to can handle, and then to use those settings. The other options are Auto,
10M/Half, 10M/Full, 100M/Half and 100M/Full, 1000M/Full_M and 1000M/Full_S. There is no
automatic adjustment of port settings with any option other than Auto.

The Switch allows the user to configure two types of gigabit connections; 1000M/Full_M and
1000M/Full_S. Gigabit connections only support full duplex connections and take on certain
characteristics that are different from the other choices listed.

The 1000M/Full_M (master) and 1000M/Full_S (slave) parameters refer to connections running
a 1000BASE-T cable for connection between the Switch port and other device capable of a
gigabit connection. The master setting (1000M/Full_M) will allow the port to advertise capabilities
related to duplex, speed and physical layer type. The master setting will also determine the
master and slave relationship between the two connected physical layers. This relationship is
necessary for establishing the timing control between the two physical layers. The timing control
is set on a master physical layer by a local source. The slave setting (7000M/Full_S) uses loop
timing, where the timing comes form a data stream received from the master. If one connection
is set for 1000M/Full_M, the other side of the connection must be set for 1000M/Full_S. Any
other configuration will result in a link down status for both ports.

Flow Control Displays the flow control scheme used for the various port configurations. Ports configured for
full-duplex use 802.3x flow control, half-duplex ports use backpressure flow control, and Auto
ports use an automatic selection of the two. The default is Disabled.

Medium Type This applies only to the Combo ports. If configuring the Combo ports this defines the type of
transport medium used. SFP ports should be set at Fiber and the Combo 1000BASE-T ports
should be set at Copper.

Learning When Enabled, destination and source MAC addresses are automatically listed in the forwarding
table. The default setting is Enabled and cannot be modified.

Click Apply to implement the new settings on the Switch.

Port Error Disabled

The following window will display the information about ports that have had their connection status disabled, for reasons such as
STP loopback detection or link down status. To view this window, click Port Configuration > Port Error Disabled.

Port Error Disabled

Figure 6- 4. Port Error Disabled window

The following parameters are displayed:

Parameter Description
Port Displays the port that has been error disabled.
State Describes the current running state of the port, whether Enabled or Disabled.
Connection This field will read the uplink status of the individual ports, whether enabled or Disabled.
Reason Describes the reason why the port has been error-disabled, such as a STP loopback
occurrence.
Description This field further describes the specifics of the action.
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Port Description

The Switch supports a port description feature
where the user may name various ports on the
Switch. To assign names to various ports, click
Administration > Port Configuration > Port
Description to view the following window:

Use the From and To pull-down menu to choose a
port or range of ports to describe, and then enter a
description of the port(s). Click Apply to set the
descriptions in the Port Description Table.

The Medium Type applies only to the Combo
ports. If configuring the Combo ports this defines
the type of tranport medium used. SFP ports
should be nominated Fiber and the Combo
1000BASE-T ports should be nominated Copper-.
The result will be displayed in the appropriate
switch port number slot (C for copper ports and F
for fiber ports).

Port Description

Feom [fo iedium Type Deseripion [y |
Pott1 +| Patl v Apply

Port Description Table

Lo o B [ R B N e N O O

—
—

Figure 6- 5. Port Description window




DHCP/BOOTP Relay

To enable and configure DHCP/BOOTP Relay Global Settings on the Switch, click Administration > DHCP/BOOTP Relay>:

DHCP/BOOTP Relay Global Settings

DHCPIBOOTP Relay Global Settings
BOOTP Relay State

BOOTP Relay Hops Count Limit (1-16) 4
BOOTP Relay Time Threshold (0-65535) 0

DHCP Relay Agent Information Option 82 State
DHCP Relay Agent Information Option 82 Check
DHCP Relay Agent Information Option 82 Policy

Disahled

Disahled
Disabled

Feplace #

Figure 6- 6. DHCP/ BOOTP Relay Global Settings window

The following fields can be set:

Parameter

Description

BOOTP Relay State

This field can be toggled between Enabled and Disabled using the pull-down menu. It is
used to enable or disable the DHCP/BOOTP Relay service on the Switch. The default is
Disabled

BOOTP Relay Hops
Count Limit (1-16)

This field allows an entry between 7 and 716 to define the maximum number of router hops
DHCP/BOOTP messages can be forwarded across. The default hop count is 4.

BOOTP Relay Time
Threshold (0-65535)

Allows an entry between 0 and 65535 seconds, and defines the maximum time limit for
routing a DHCP/BOOTP packet. If a value of 0 is entered, the Switch will not process the
value in the seconds field of the BOOTP or DHCP packet. If a non-zero value is entered,
the Switch will use that value, along with the hop count to determine whether to forward a
given BOOTP or DHCP packet.

DHCP Relay Agent
Information Option 82
State

This field can be toggled between Enabled and Disabled using the pull-down menu. It is
used to enable or disable the DHCP Agent Information Option 82 on the Switch. The default
is Disabled.

Enabled — When this field is toggled to Enabled the relay agent will insert and remove
DHCP relay information (option 82 field) in messages between DHCP servers and clients.
When the relay agent receives the DHCP request, it adds the option 82 information, and the
IP address of the relay agent (if the relay agent is configured), to the packet. Once the
option 82 information has been added to the packet it is sent on to the DHCP server. When
the DHCP server receives the packet, if the server is capable of option 82, it can implement
policies like restricting the number of IP addresses that can be assigned to a single remote
ID or circuit ID. Then the DHCP server echoes the option 82 field in the DHCP reply. The
DHCP server unicasts the reply to the back to the relay agent if the request was relayed to
the server by the relay agent. The switch verifies that it originally inserted the option 82
data. Finally, the relay agent removes the option 82 field and forwards the packet to the
switch port that connects to the DHCP client that sent the DHCP request.

Disabled - If the field is toggled to Disabled the relay agent will not insert and remove DHCP
relay information (option 82 field) in messages between DHCP servers and clients, and the
check and policy settings will have no effect.

DHCP Relay Agent
Information Option 82

This field can be toggled between Enabled and Disabled using the pull-down menu. It is
used to enable or disable the Switches ability to check the validity of the packet’s option 82
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Check

field.

Enabled — When the field is toggled to Enable, the relay agent will check the validity of the
packet’s option 82 field. If the switch receives a packet that contains the option-82 field from
a DHCP client, the switch drops the packet because it is invalid. In packets received from
DHCP servers, the relay agent will drop invalid messages.

Disabled - When the field is toggled to Disabled, the relay agent will not check the validity of
the packet’s option 82 field.

DHCP Relay Agent
Information Option 82
Policy

This field can be toggled between Replace, Drop, and Keep by using the pull-down menu.
It is used to set the Switches policy for handling packets when the DHCP Agent
Information Option 82 Check is set to Disabled. The default is Replace.

Replace - The option 82 field will be replaced if the option 82 field already exists in the
packet received from the DHCP client.

Drop - The packet will be dropped if the option 82 field already exists in the packet received
from the DHCP client.

Keep -The option 82 field will be retained if the option 82 field already exists in the packet
received from the DHCP client.

Click Apply to implement any changes that have been made.

NOTE: If the Switch receives a packet that contains the option-82 field from a DHCP client and the

oo information-checking feature is enabled, the switch drops the packet because it is invalid. However, in

.-."F = some instances, you might configure a client with the option-82 field. In this situation, you should

[ - disable the information-check feature so that the switch does not remove the option-82 field from the

= packet. You can configure the action that the switch takes when it receives a packet with existing
option-82 information by configuring the DHCP Agent Information Option 82 Policy.
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The Implementation of DHCP Information Option 82 in the DES-3028/28P/52/52P
switches

The config dhcp_relay option_82 command configures the DHCP relay agent information option 82 setting of the switch. The
formats for the circuit ID sub-option and the remote ID sub-option are as follows:

oy at
£§;§ NOTE: For the circuit ID sub-option of a standalone switch, the module field is always zero.
f L}

=

Circuit ID sub-option format:

1. 2. 3. 4. 5. 6. 7.
1 6 0 4 VLAN Module| Port
1 byte 1byte 1byte 1byte 2 bytes 1 byte 1 byte
a. Sub-option type
b. Length
c. Circuit ID type
d. Length

e. VLAN: the incoming VLAN ID of DHCP client packet.
f.  Module : For a standalone switch, the Module is always 0; For a stackable switch, the Module is the Unit ID.

g. Port: The incoming port number of DHCP client packet, port number starts from 1.

Remote ID sub-option format:

1. 2. 3. 4. 5.

2 8 0 6 MAC address

1byte 1byte 1byte 1byte 6 bytes

1. Sub-option type

2. Length

3. Remote ID type

4. Length

5. MAC address: The Switch’s system MAC address.

Figure 6- 7. Circuit ID and Remote ID Sub-option Format

DHCP/BOOTP Relay Interface Settings

This window allows the user to set up a server, by IP address, for relaying DHCP/ BOOTP information to the Switch. The user
may enter a previously configured IP interface on the Switch that will be connected directly to the DHCP/BOOTP server using the
following window. Properly configured settings will be displayed in the BOOTP Relay Table at the bottom of the following
window, once the user clicks the Add button under the Apply heading. The user may add up to four server IPs per IP interface on
the Switch. Entries may be deleted by clicking it’s corresponding 24, To enable and configure DHCP/BOOTP Relay Global
Settings on the Switch, click Configuration > Layer 3 Networking > DHCP/BOOTP Relay > DHCP/BOOTP Relay
Interface Settings:
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DHCFIBOOTP Relay Interface Settings

0.0.0.0 Add

DHCFIBOOTP Relay Interface Table

e

Figure 6- 8. DHCP/BOOTP Relay Interface Settings and DHCP/BOOTP Relay Interface Table window

The following parameters may be configured or viewed.

Parameter Description

Interface The IP interface on the Switch that will be connected directly to the Server.

Server IP Enter the IP address of the DHCP/BOOTP server. Up to four server IPs can be configured
per IP Interface

User Accounts

Use the User Account Management window to control user privileges. To view existing User Accounts, open the
Administration folder and click on the User Accounts link. This will open the User Account Management window, as shown

below.

User Accounts

Access Right

ctenow A drmin todify

User Name

Figure 6- 9. User Accounts window

To add a new user, click on the Add button.

User Account Modify Table

New Password

Confirm New Password

Access Right Adrmin v

show Al UTzer Account Entries

Figure 6- 10. User Account Modify Table window

Add a new user by typing in a User Name, and New Password and retype the same password in the Confirm New Password.
Choose the level of privilege (Admin or User) from the Access Right drop-down menu.

To modify or delete an existing user, click on the Modify button for that user.
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User Account Modify Table

Old Password
New Password

Confirmmn New Password

Access Right

Apply ] [ Delete

chow Al TTzer Account Entries

Figure 6- 11. User Account Modify Table window

Modify or delete an existing user account in the User Account Modify Table. To delete the user account, click on the Delete
button. To change the password, type in the New Password and retype it in the Confirm New Password entry field. The level of
privilege (Admin or User) can be viewed in the Access Right field.
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Port Mirroring

The Switch allows you to copy frames transmitted and received on a port and redirect the copies to another port. You can attach a
monitoring device to the mirrored port, such as a sniffer or an RMON probe, to view details about the packets passing through the
first port. This is useful for network monitoring and troubleshooting purposes. To view the Port Mirroring window, click Port
Mirroring in the Administration folder.

Port Mirroring
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Figure 6- 12. Port Mirroring window
To configure a mirror port:

1. Select the Source Port from where you want to copy frames and the Target Port, which receives the copies from the
source port.

2. Select the Source Direction, Ingress, Egress, or Both and change the Status drop-down menu to Enabled.

3. Click Apply to let the changes take effect.

NOTE: You cannot mirror a fast port onto a slower port. For example, if you try to mirror the

£ traffic from a 100 Mbps port onto a 10 Mbps port, this can cause throughput problems. The port
'f_-'; you are copying frames from should always support an equal or lower speed than the port to
!i- k which you are sending the copies. Also, the target port for the mirroring cannot be a member of

a trunk group. Please note a target port and a source port cannot be the same port.
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System Log Settings

The Switch can send Syslog messages to up to four designated servers using the System Log Server. In the Administration
folder, click System Log Settings, to view the window shown below.

Al

System Log Settings

Figure 6- 13. System Log Host window

The parameters configured for adding and editing System Log Server settings are the same. See the table below for a description.
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Figure 6- 14. System Log Host — Add window

The following parameters can be set:

Parameter Description

Index Syslog server settings index (1-4).

Host IP The IP address of the Syslog server.

Severity This drop-down menu allows you to select the level of messages that will be sent. The options
are Warning, Informational, and All.

Facility Some of the operating system daemons and processes have been assigned Facility values.

Processes and daemons that have not been explicitly assigned a Facility may use any of the
"local use" facilities or they may use the "user-level" Facility. Those Facilities that have been
designated are shown in the following: Bold font indicates the facility values that the Switch is
currently employing.

Numerical Facility
Code




kernel messages

user-level messages

mail system

system daemons

security/authorization messages

messages generated internally by syslog line printer subsystem
network news subsystem

UUCP subsystem

0 Nk WwWDN -~ O

9 clock daemon

10 security/authorization messages
11 FTP daemon

12 NTP subsystem

13 log audit

14 log alert

15 clock daemon

16 local use 0 (local0)
17 local use 1 (local1)
18 local use 2 (local2)
19 local use 3 (local3)
20 local use 4 (local4)
21 local use 5 (local5)
22 local use 6 (local6)
23 local use 7 (local7)

UDP Port (514 or | Type the UDP port number used for sending Syslog messages. The default is 574.
6000-65535)

Status Choose Enabled or Disabled to activate or deactivate.

System Log Host-Add

g
Host TP 10.0.0.0
Severity YWarming v
Facility Locall
UDP Port(514 or 6000-65535) E14
Status Disabled v

chow Al Svstem Log Servers

Figure 6- 15. System Log Host — Add window

To set the System Log Server configuration, click Apply. To delete an entry from the System Log Host window, click the
corresponding # under the Delete heading of the entry to delete. To return to the System Log Host window, click the Show All
System Log Servers link.
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Log Settings

The Log settings can be changed by clicking the System Log Settings link to open the following window:

Log Settings

On Demand  + Apply

Log Mode Table

Log Mode
on Demand

Figure 6- 16. Log Settings window

The following parameters can be set:

Parameter Description

Log Mode Use this drop-down menu to choose the method that will trigger a log entry. You can choose
between On Demand, Log Trigger, and Time Interval.

Time Interval Enter a time interval, in seconds, for which you would like a log entry to be made.
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SNTP Settings

Time Settings

To configure the time settings for the Switch, open the Administration folder. Then the SNTP Settings folder and click on the

Time Settings link, revealing the following window for the user to configure.

ear

¥

Time Settings-Current Time

Current Time

Time Source

SNTP Settings

SNTP Poll Interval in Seconds -

Time Settings: Set Current Time

Month

Time in HH MM S8

0 days 02:53:10

System Clock

Disahled

Apply

Figure 6- 17. Time Settings window

The following parameters can be set or are displayed:

Parameter

Description

Current Time

Current Time

Displays the Current Time set on the Switch.

Time Source

Displays the time source for the system.

SNTP Settings

SNTP State Use this pull-down menu to Enabled or Disabled SNTP.

SNTP Primary Server | This is the IP address of the primary server the SNTP information will be taken from.
SNTP Secondary This is the IP address of the secondary server the SNTP information will be taken from.
Server

SNTP Poll Interval in
Seconds

This is the interval, in seconds, between requests for updated SNTP information.

Set Current Time

Year Enter the current year, if you want to update the system clock.
Month Enter the current month, if you would like to update the system clock.
Day Enter the current day, if you would like to update the system clock.

Time in HH MM SS

Enter the current time in hours, minutes, and seconds.
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Click Apply to implement changes made.

Time Zone and DST

The following are windows used to configure time zones and Daylight Savings time settings for SNTP. Open the Administration
folder, then the SNTP Settings folder and click on the Time Zone and DST link, revealing the following window.

=
3
- |
N
o
3
(1]
| m
3
o
)
7]
_l

Disahled w

5
=
E
2]
:
1]
[
5
o
=4
B
o

(=]
=

=4

5
=
B
4
:
']
o
5
m
o
7
o
5
:
@

Time Zone Offset:from GMT in +-HH: MM |SEESRIERR LIRS

DST Repeating Settings
of the Month

DST Annual Settings

o | a | o | | g |9
555555 ; g |8 |8 |2
HHHEHHE HHEHEEEE
11028 (558 ﬁﬁuﬁ'@";‘;‘;‘
AT 2 IEE|E 22|02

28|58 EE*- 135|182

- - EEE’F
S e |
:

Figure 6- 18. Time Zone and DST Settings window

The following parameters can be set:

Parameter Description
Time Zone and DST
Daylight Saving Use this pull-down menu to enable or disable the DST Settings.
Time State
Daylight Saving Use this pull-down menu to specify the amount of time that will constitute your local DST offset
Time Offset in - 30, 60, 90, or 120 minutes.
Minutes
Time Zone Offset Use these pull-down menus to specify your local time zone's offset from Greenwich Mean
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from GMT in +/-
HH:MM

Time (GMT.)

DST Repeating Settings

Using repeating mode will enable DST seasonal time adjustment. Repeating mode requires that the DST beginning
and ending date be specified using a formula. For example, specify to begin DST on Saturday during the second
week of April and end DST on Sunday during the last week of October.

From Which Week
of the Month

Enter the week of the month that DST will start.

From Which Day of
the Week

Enter the day of the week that DST will start on.

From Which Month

Enter the month DST will start on.

From What Time
HH:MM

Enter the time of day that DST will start on.

To Which Week

Enter the week of the month the DST will end.

To Which Day

Enter the day of the week that DST will end.

To Which Month

Enter the month that DST will end.

To What Time
HH:MM

Enter the time DST will end.

DST Annual Settings

Using annual mode will enable DST seasonal time adjustment. Annual mode requires that the DST beginning and
ending date be specified concisely. For example, specify to begin DST on April 3 and end DST on October 14.

From What Month

Enter the month DST will start on, each year.

From What Date

Enter the day of the week DST will start on, each year.

From What Time

Enter the time of day DST will start on, each year.

To What Month

Enter the month DST will end on, each year.

To What Date

Enter the date DST will end on, each year.

To What Time

Enter the time of day that DST will end on, each year.

Click Apply to implement changes made to the Time Zone and DST window.
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MAC Notification Settings

MAC Notification is used to monitor MAC addresses learned and
entered into the forwarding database. To globally set MAC notification 11“ :
on the Switch, open the following window by opening the MAC .
Notification Settings in the Administration folder.
Global Settings el
1
The following parameters may be viewed and modified:
\ Parameter  Description \ MAC Natification Port Setlings
State Enable or disable MAC notification globally on the Port1_ S eort? WY Oiscbied
Switch —
MAC Notification Port State Table
Interval The time in seconds between notifications. ; e
(SEC) 2 Disabled
3 Disabled
History The maximum number of entries listed in the i i
Size history log used for notification. Up to 500 entries 2 Bl
can be specified. : b
@ Disabled
3 Disabled
= 9 Disabled
Port Settings i
11 Disabled
To change MAC notification settings for a port or group of ports on the iz B
Switch, configure the following parameters. L Bl
14 Disabled
Parameter Description 13 Disabled
From...To | Select a port or group of ports to enable for MAC | Figure 6-19. MAC Notification Settings window
notification using the pull-down menus.
State Enable MAC Notification for the ports selected
using the pull-down menu.

Click Apply to implement changes made.

TFTP Services

Trivial File Transfer Protocol (TFTP)
services allow the Switch's firmware to
be upgraded by transferring a new
firmware file from a TFTP server to the
Switch. A configuration file can also be
loaded into the Switch from a TFTP
server. Switch settings can be saved to
the TFTP server, and a history log can be
uploaded from the Switch to the TFTP
server. The TFTP server must be running
TFTP server software to perform the file
transfer.

TFTP Services
Active

Server IP Address

Diownload Firmware v

0.0.0.0

File Name

Figure 6- 20. TFTP Services window
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The user also has the

option of transferring firmware and configuration files to and from the internal Flash drive, located on the

Switch. Using this window, the user can add a configuration or firmware file from a TFTP server to the flash memory, or transfer
that firmware or configuration file to a TFTP server. More about configuring the internal Flash drive can be found in the next

section entitled Flash

File Services.

TFTP server software is a part of many network management software packages — such as NetSight, or can be obtained as a
separate program. To update the Switch's firmware or configuration file, open the TFTP Services hyperlink, located in the
Administration folder.

The following parameters can be configured:

Parameter

Description

Active

Select a service for the TFTP server to perform from the drop down window:

. Download Firmware - Enter the IP address of the TFTP server and specify the
location of the new firmware on the TFTP server. Click Start to record the IP
address of the TFTP server and to initiate the file transfer.

« Download Configuration - Enter the IP address of the TFTP server, and the path
and filename for the Configuration file on the TFTP server. Click Start to record the
IP address of the TFTP server and to initiate the file transfer.

. Upload Configuration - Enter the IP address of the TFTP server and the path and
filename for the switch settings on the TFTP server. Click Start to record the IP
address of the TFTP server and to initiate the file transfer.

. Upload Log - Enter the IP address of the TFTP server and the path and filename
for the history log on the TFTP server. Click Start to record the IP address of the
TFTP server and to initiate the file transfer.

Server IP Address

Enter the IP address of the server from which to download firmware or configuration files.

File Name Enter the path and filename of the firmware or configuration file to upload or download, located
on the TFTP server.
Image ID To select a firmware file from the internal Flash drive to which the firmware file will be

transferred.

Click Start to initiate the file transfer.
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Multiple Image Services

To configure the files located on the Flash memory, use the following windows to guide you.

Firmware Information

This window is used to view boot up firmware images.

Firmware Information

Frmware ormaton
D Version e [(pine Tme — Jprom [

*1 100-B22 1532344 0000,/00/00 00:0%:03 10,24 22 5(COMNE0LE) Anenyrmous
2 1.00-BOS 1518404 0000/00/00 00:01:01 10,530 20 1(CONS0OLE) Anonymous

b : Boot up firtnware

(SSH) - Firmwrare update through S5H

{(WER) . Firmware update through WEE

(I . Firmware update through Single IP Management
(S - Firmmware update through SHLEP

(TELIET) - Firmweare update through TELINET

(CONSOLE) : Firmware update through COMNSOLE

Figure 6- 21. Firmware Information window

Config Firmware Image

The following window is used to determine which of the two firmware images will be used as the default boot file. You can also
delete either of the two images.

Config Firmware Image

1w

Image
Apply

Figure 6- 22. Config Firmware Image window



Ping Test

Ping is a small program that sends ICMP Echo packets to the IP address you specify. The destination node then responds to or
"echoes" the packets sent from the Switch. This is very useful to verify connectivity between the Switch and other nodes on the

network.
Ping Test

Target IP Address:

Repeat Pmging for: &) Infinite times
@) times (1 - 255)

Time Out: 1 seconds(1-~-99)

Figure 6- 23. Ping Test window

The user may use Infinite times radio button, in the Repeat Pinging for field, which will tell the ping program to keep sending
ICMP Echo packets to the specified IP address until the program is stopped. The user may opt to choose a specific number of
times to ping the Target IP Address by clicking its radio button and entering a number between / and 255. Click Start to initiate
the Ping program.

Safeguard Engine

Periodically, malicious hosts on the network will attack the Switch by utilizing packet flooding (ARP Storm) or other methods.
These attacks may increase the Safeguard Engine beyond its capability. To alleviate this problem, the Safeguard Engine function
was added to the Switch’s software.

The Safeguard Engine can help the overall operability of the Switch by minimizing the workload of the Switch while the attack is
ongoing, thus making it capable to forward essential packets over its network in a limited bandwidth. When the Switch either (a)
receives too many packets to process or (b) exerts too much memory, it will enter an Exhausted mode. When in this mode, the
Switch will drop all ARP and IP broadcast packets for a calculated time interval. Every five seconds, the Switch will check to see
if there are too many packets flooding the Switch. If the threshold has been crossed, the Switch will initially stop all ingress ARP
and IP broadcast packets for five seconds. After another five-second checking interval arrives, the Switch will again check the
ingress flow of packets. If the flooding has stopped, the Switch will again begin accepting all packets. Yet, if the checking shows
that there continues to be too many packets flooding the Switch, it will stop accepting all ARP and IP broadcast packets for double
the time of the previous stop period. This doubling of time for stopping ingress ARP and IP broadcast packets will continue until
the maximum time has been reached, which is 320 seconds and every stop from this point until a return to normal ingress flow
would be 320 seconds. For a better understanding, examine the following example of the Safeguard Engine.
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60

Time in . :
A Checking intervals occur every 5 seconds
0 10 20 30 40 50
Stop RateLnterval ‘ I I
| 0 0 A O L L . v o
;*—5 Seconds—] - 10 Secor } 20 Seconds i
. Ifthe second checking If the third checking If the fourth interval
If the Switch deteCtIS |nter\l’a| reveals .there are interval reveals there are reveals the packe-t f|00ding
too many papkets, it still too many ingress still too many ingress has subsided, the Switch
will drop all ingress packets, the Switch will packets, the Switch will will return to accepting
ARP and IP stop all ARP and IP stop all ARP and IP ARP and IP broadcast
broadcast packets broadcast packets for 10 broadcast packets for 20 packets.
for 5 seconds. seconds (5* 2 = 10). seconds (10 * 2 = 10).

Safeguard Engine Checking Interval Example

Figure 6- 24. Safeguard Engine example

For every consecutive checking interval that reveals a packet flooding issue, the Switch will double the time it will discard ingress
ARP and IP broadcast packets. In the example above, the Switch doubled the time for dropping ARP and IP broadcast packets
when consecutive flooding issues were detected at 5 second intervals. (First stop = 5 seconds, second stop = 10 seconds, third stop
= 20 seconds) Once the flooding is no longer detected, the wait period for dropping ARP and IP broadcast packets will return to 5
seconds and the process will resume.

Once in Exhausted mode, the packet flow will decrease by half of the level that caused the Switch to enter Exhausted mode. After
the packet flow has stabilized, the rate will initially increase by 25% and then return to a normal packet flow.

& NOTE: While in Exhausted mode, only trusted IP addresses are accepted to connect to the Switch.

To configure the Safeguard Engine for the Switch, click Security > Safeguard Engine which will open the following window.

Safeguard Engine Settings

[ CPUUtilization Seftings | [ Apply |

Developed by D-Link, the Safeguard Engine is a robust and imnovative technology which will automatically reduce the negative impact of repeated paclket
flooding to the Swatch's CPT. As a result, D-Link Switches will be better protected frotn fequent intermiptions by malicious wituses of wortn attacks.

Figure 6- 25. Safeguard Engine Settings window
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To configure the Switch’s Safeguard Engine, change the State to Fnabled. To configure the parameters for the Safeguard Engine,
click the CPU Utilization Settings button, which will alter the previous window to look like this:

Safeguard Engine Settings

Disahbled v

CPU Utilization Settings
Rising Threshold (20%5-100%)

Falling Threshold (20%-100%:)

Safeguard Engine Current Status tiormal mode

Develeped by D-Link, the Safeguard Engme 15 a robust and mmowvative technology which will automatically reduce the negative impact of repeated packet
flooding to the Switch's CPU. As a result, D-Link Switches will be better protected from frequent nterruptions by malicious viruses or worm attacks.

Figure 6- 26. Safeguard Engine Settings window — CPU Utilization Settings
To set the Safeguard Engine for the Switch, complete the following fields:

Parameter Description
State Toggle this field to either Enabled or Disabled for the Safeguard Engine of the Switch.
Rising Threshold Used to configure the acceptable level of CPU utilization before the Safeguard Engine

mechanism is enabled. Once the CPU utilization reaches this percentage level, the Switch
will move into the Exhausted state.

Falling Threshold Used to configure the acceptable level of CPU utilization as a percentage, where the Switch
leaves the Exhausted state and returns to normal mode.

Trap/Log Use the pull-down menu to enable or disable the sending of messages to the device’s SNMP
agent and switch log once the Safeguard Engine has been activated by a high CPU utilization
rate.

Mode You can choose between Fuzzy and Strict.
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SNMP Manager
SNMP Settings

Simple Network Management Protocol (SNMP) is an OSI Layer 7 (Application Layer) designed specifically for managing and
monitoring network devices. SNMP enables network management stations to read and modify the settings of gateways, routers,
switches, and other network devices. Use SNMP to configure system features for proper operation, monitor performance and
detect potential problems in the Switch, switch group or network.

Managed devices that support SNMP include software (referred to as an agent), which runs locally on the device. A defined set of
variables (managed objects) is maintained by the SNMP agent and used to manage the device. These objects are defined in a
Management Information Base (MIB), which provides a standard presentation of the information controlled by the on-board
SNMP agent. SNMP defines both the format of the MIB specifications and the protocol used to access this information over the
network.

The DES-3028/28P/52/52P supports the SNMP versions 1, 2c, and 3. The default SNMP setting is disabled. You must enable
SNMP. Once SNMP is enabled you can choose which version you want to use to monitor and control the Switch. The three
versions of SNMP vary in the level of security provided between the management station and the network device.

In SNMP v.1 and v.2, user authentication is accomplished using 'community strings', which function like passwords. The remote
user SNMP application and the Switch SNMP must use the same community string. SNMP packets from any station that has not
been authenticated are ignored (dropped).

The default community strings for the Switch used for SNMP v.1 and v.2 management access are:
e public - Allows authorized management stations to retrieve MIB objects.
e private - Allows authorized management stations to retrieve and modify MIB objects.

SNMPv3 uses a more sophisticated authentication process that is separated into two parts. The first part is to maintain a list of
users and their attributes that are allowed to act as SNMP managers. The second part describes what each user on that list can do
as an SNMP manager.

The Switch allows groups of users to be listed and configured with a shared set of privileges. The SNMP version may also be set
for a listed group of SNMP managers. Thus, you may create a group of SNMP managers that are allowed to view read-only
information or receive traps using SNMPv1 while assigning a higher level of security to another group, granting read/write privi-
leges using SNMPv3.

Using SNMPv3 individual users or groups of SNMP managers can be allowed to perform or be restricted from performing
specific SNMP management functions. The functions allowed or restricted are defined using the Object Identifier (OID)
associated with a specific MIB. An additional layer of security is available for SNMPv3 in that SNMP messages may be
encrypted. To read more about how to configure SNMPv3 settings for the Switch read the next section.

Traps

Traps are messages that alert network personnel of events that occur on the Switch. The events can be as serious as a reboot
(someone accidentally turned OFF the Switch), or less serious like a port status change. The Switch generates traps and sends
them to the trap recipient (or network manager). Typical traps include trap messages for Authentication Failure, Topology Change
and Broadcast\Multicast Storm.

MIBs

The Switch in the Management Information Base (MIB) stores management and counter information. The Switch uses the
standard MIB-II Management Information Base module. Consequently, values for MIB objects can be retrieved from any SNMP-
based network management software. In addition to the standard MIB-II, the Switch also supports its own proprietary enterprise
MIB as an extended Management Information Base. Specifying the MIB Object Identifier may also retrieve the proprietary MIB.
MIB values can be either read-only or read-write.

The DES-3028/28P/52/52P incorporates a flexible SNMP management for the switching environment. SNMP management can
be customized to suit the needs of the networks and the preferences of the network administrator. Use the SNMP V3 menus to
select the SNMP version used for specific tasks.

The DES-3028/28P/52/52P supports the Simple Network Management Protocol (SNMP) versions 1, 2c, and 3. The administrator
can specify the SNMP version used to monitor and control the Switch. The three versions of SNMP vary in the level of security
provided between the management station and the network device.

SNMP settings are configured using the menus located on the SNMP V3 folder of the web manager. Workstations on the network
that are allowed SNMP privileged access to the Switch can be restricted with the Management Station IP Address window.
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SNMP Traps Settings

The following window is used to enable and disable trap settings for the SNMP function on the Switch. To view this window for
configuration, click Administration > SNMP Manager > SNMP Trap Settings:

SNMP Trap Settings
Traps State Enakbled +

Authenticate Traps State Ernabled =

Figure 6- 27. SNMP Trap Settings window

To enable or disable the Traps State and/or the Authenticate Traps State, use the corresponding pull-down menu to change and
click Apply.

SNMP User Table

This window displays all of the SNMP User's currently configured on the Switch.

In the SNMP Manager folder, located in the Administration folder, click on the SNMP User Table link. This will open the
SNMP User Table window, as shown below.

A

SNMP User Table

SMNMP Version

va )(_

B

itnitial ituit

Figure 6- 28. SNMP User Table window

To delete an existing SNMP User Table entry, click the % below the Delete heading corresponding to the entry you wish to
delete.

To display the detailed entry for a given user, click on the View button under the Display heading. This will open the SNMP User
Table Display window, as shown below.

SNMP User Table Display

BMAMP Version

Auth-Protocol

Priv-Protocol

Shoar A1 SHIIP [Taer Tahle Entries

Figure 6- 29. SNMP User Table Display window

The following parameters are displayed:

Parameter Description

User Name An alphanumeric string of up to 32 characters. This is used to identify the SNMP users.




Group Name

This name is used to specify the SNMP group created can request SNMP messages.

SNMP Version

V1 - Indicates that SNMP version 1 is in use.
V2 - Indicates that SNMP version 2 is in use.

V3 - Indicates that SNMP version 3 is in use.

Auth-Protocol

None - Indicates that no authorization protocol is in use.
MD?5 - Indicates that the HMAC-MD5-96 authentication level will be used.
SHA - Indicates that the HMAC-SHA authentication protocol will be used.

Priv-Protocol

None - Indicates that no authorization protocol is in use.

DES - Indicates that DES 56-bit encryption is in use based on the CBC-DES (DES-56)
standard.

To return to the SNMP User Table, click the Show All SNMP User Table Entries link. To add a new entry to the SNMP User
Table Configuration window, click on the Add button on the SNMP User Table window. This will open the SNMP User Table
Configuration window, as shown below.

SNMP User Table Configuration

e

Shoar A1 ZHNIE [Taer Tahle Entries

Figure 6- 30. SNMP User Table Configuration window

The following parameters can set:

Parameter

Description

User Name

Enter an alphanumeric string of up to 32 characters. This is used to identify the SNMP user.

Group Name

This name is used to specify the SNMP group created can request SNMP messages.

SNMP Version

V1 - Specifies that SNMP version 1 will be used.
V2 - Specifies that SNMP version 2 will be used.
V3 - Specifies that SNMP version 3 will be used.

Auth-Protocol

MD5 - Specifies that the HMAC-MD5-96 authentication level will be used. This field is only
operable when V3 is selected in the SNMP Version field and the Encryption field has been
checked. This field will require the user to enter a password.

SHA - Specifies that the HMAC-SHA authentication protocol will be used. This field is only
operable when V3 is selected in the SNMP Version field and the Encryption field has been
checked. This field will require the user to enter a password.

Priv-Protocol

None - Specifies that no authorization protocol is in use.

DES - Specifies that DES 56-bit encryption is in use, based on the CBC-DES (DES-56)
standard. This field is only operable when V3 is selected in the SNMP Version field and the
Encryption field has been checked. This field will require the user to enter a password
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between 8 and 16 alphanumeric characters.

Encrypted Checking the corresponding box will enable encryption for SNMP V3 and is only operable in
SNMP V3 mode.

To implement changes made, click Apply. To return to the SNMP User Table, click the Show All SNMP User Table Entries link.

SNMP View Table

This window is used to assign views to community strings that define which MIB objects can be accessed by a remote SNMP
manager. To view the SNMP View Table window, open the SNMP Manager folder under Administration and click the SNMP
View Table entry. The following window should appear:

Add

Total Entries:? (Iote: It is allowed msert 30 entries into the table only.)

SNMP View Table

vl 1 !

Included Pal
restricted 1.361.2.1.1 Included }S:
restricted 13612111 Included X
restricted 1361631021 Included x
restricted 1.36.16.311.21 Inchided x|
restricted 1.3.6.1.6.315.1.1 Inchided X
ComrumtyWView |1 Inchided X
Communtyliew 136163 Excluded E
Communityifiew 1361631 Included X

Figure 6- 31. SNMP View Table window

To delete an existing SNMP View Table entry, click the % in the Delete column corresponding to the entry to delete. To create a
new entry, click the Add button and a separate window will appear.

SNMP View Table Configuration

View MName

Subiree OID

View Type Included  +
Apply

Show AU ZMME View Table Entries

Figure 6- 32. SNMP View Table Configuration window

The SNMP Group created with this table maps SNMP users (identified in the SNMP User Table) to the views created in the
previous window.

The following parameters can set:

Parameter Description

View Name Type an alphanumeric string of up to 32 characters. This is used to identify the new SNMP
view being created.

Subtree OID Type the Object Identifier (OID) Subtree for the view. The OID identifies an object tree (MIB

tvann) that il ha tnaliidad Av aviabiidAad feavma Aanannaa his anrm ONIMAD vvaarma~nAaw




tree) that will be included or excluded from access by an SNMP manager.

View Type

Select Included to include this object in the list of objects that an SNMP manager can
access. Select Excluded to exclude this object from the list of objects that an SNMP
manager can access.

To implement your new settings, click Apply. To return to the SNMP View Table, click the Show All SNMP View Table Entries

link.

SNMP Group Table

An SNMP Group created with this table maps SNMP users (identified in the SNMP User Table) to the views created in the
previous menu. To view the SNMP Group Table window, open the SNMP Manager folder in the Administration folder and
click the SNMP Group Table entry. The following window should appear:

Add
Total Entries:10 (INote: It 15 allowed insert 30 entries into the table only.)
S Ew3 MoAuthMoPriv

M SHMPw1 Mo AuthMoPriv X |
public SNMMPw2 NoduthoPriv X
intial SHMPv3 NohuthMoPriv X
private SHMPv1 NoduthloPriv X
private SHMEPw2 NoAuthtToPriv X
EeadGroup SHMEw] NoduthoPriv X
EeadGroup SHMPv2 NohuthMoPriv X
Write Group S EPw1 NoduthoPriv X
Write Group SNMPw2 NoduthNoPriv X

Figure 6- 33. SNMP Group Table window

To delete an existing SNMP Group Table entry, click the corresponding # under the Delete heading.

To display the current settings for an existing SNMP Group Table entry, click the View button located under the Display
heading, which will show the following window.

SNMP Group Table Display
Read View Name CotmmuntyView

Write View Name

Notify View Name Cotmmunty View

Security Model ShIEw1

Hodutht oPrr

Show All SNIMP Group Table Entries

Figure 6- 34. SNMP Group Table Display window

To add a new entry to the Switch's SNMP Group Table, click the Add button in the upper left-hand corner of the SNMP Group
Table window. This will open the SNMP Group Table Configuration window, as shown below.
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SNMP Group Table Configuration

Read View Mame

Write View MName

Motify View Mame
Security Model ShlbdF1 w

ehow AL SHMP Group Table Entries

Figure 6- 35. SNMP Group Table Configuration window

The following parameters can set:

Parameter

Description

Group Name

Type an alphanumeric string of up to 32 characters. This is used to identify the new SNMP
group of SNMP users.

Read View Name

This name is used to specify the SNMP group created can request SNMP messages.

Write View Name

Specify a SNMP group name for users that are allowed SNMP write privileges to the Switch's
SNMP agent.

Notify View Name

Specify a SNMP group name for users that can receive SNMP trap messages generated by
the Switch's SNMP agent.

Security Model

SNMPv1 - Specifies that SNMP version 1 will be used.

SNMPv2 - Specifies that SNMP version 2c will be used. The SNMPv2 supports both
centralized and distributed network management strategies. It includes improvements in the
Structure of Management Information (SMI) and adds some security features.

SNMPv3 - Specifies that the SNMP version 3 will be used. SNMPv3 provides secure access
to devices through a combination of authentication and encrypting packets over the network.

Security Level

The Security Level settings only apply to SNMPv3.

NoAuthNoPriv - Specifies that there will be no authorization and no encryption of packets sent
between the Switch and a remote SNMP manager.

AuthNoPriv - Specifies that authorization will be required, but there will be no encryption of
packets sent between the Switch and a remote SNMP manager.

AuthPriv - Specifies that authorization will be required, and that packets sent between the
Switch and a remote SNMP manger will be encrypted.

To implement your new settings, click Apply. To return to the SNMP Group Table, click the Show All SNMP Group Table

Entries link.

SNMP Community Table Configuration

Use this table to create an SNMP community string to define the relationship between the SNMP manager and an agent. The
community string acts like a password to permit access to the agent on the Switch. One or more of the following characteristics
can be associated with the community string:

e An Access List of IP addresses of SNMP managers that are permitted to use the community string to gain access to
the Switch's SNMP agent.

e  Any MIB view that defines the subset of all MIB objects will be accessible to the SNMP community.

. Read/write or read-only level permission for the MIB objects accessible to the SNMP community.
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To configure SNMP Community entries, open the SNMP Manager folder, (located in the Administration folder) and click the
SNMP Community Table link, which will open the following window:

SNMP Community Table Configuration

Fead_Onk

Total Entries:2 (Iote: It is allowed insert 10 entvies into the table only.)

SNMP Community Table

private C ottty View Read "Write >

public C ommuruanity View Fead Only X

Figure 6- 36. SNMP Community Table Configuration window

The following parameters can set:

Parameter Description

Community Name Type an alphanumeric string of up to 32 characters that is used to identify members of an

SNMP community. This string is used like a password to give remote SNMP managers
access to MIB objects in the Switch's SNMP agent.

View Name Type an alphanumeric string of up to 32 characters that is used to identify the group of MIB
objects that a remote SNMP manager is allowed to access on the Switch. The view name
must exist in the SNMP View Table.

Access Right Read Only - Specifies that SNMP community members using the community string created
can only read the contents of the MIBs on the Switch.

Read Write - Specifies that SNMP community members using the community string created
can read from, and write to the contents of the MIBs on the Switch.

To implement the new settings, click Apply. To delete an entry from the SNMP Community Table, click the *! under the Delete
heading, corresponding to the entry to delete.

SNMP Host Table

Use the SNMP Host Table window to set up SNMP
trap recipients. Open the SNMP Manager folder,
(located in the Administration folder) and click on
the SNMP Host Table Configuration link. ThiS |Total Eniries:0 (Note: It is allowed insert 10 entries into the tahle only,)
will open the SNMP Host Table window, as shown |HIIAEESEAH

to the right. To delete an existing SNMP Host Table S:;:.Lumdtmee.-"SNT\'[P\rS User

entry, click the corresponding X under the Delete

Add

heading. To display the current settings for an Figure 6- 37. SNMP Host Table window

existing SNMP Host Table entry, click the blue link

for the entry under the Host IP Address heading. SNMP Host Table Configuration

To add a new entry to the Switch's SNMP Host s

Table, click the Add button in the upper left-hand | ik e

corner of the window. This will open the SNMP | | it

Host Table Configuration window, as shown to the

right.

Show A SHMP Host Table Entries

Figure 6- 38. SNMP Host Table Configuration window
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The following parameters can set:

Parameter

Description

Host IP Address

Type the IP address of the remote management station that will serve as the SNMP host
for the Switch.

SNMP Version

V1 - To specifies that SNMP version 1 will be used.
V2 - To specify that SNMP version 2 will be used.

V3-NoAuth-NoPriv - To specify that the SNMP version 3 will be used, with a NoAuth-
NoPriv security level.

V3-Auth-NoPriv - To specify that the SNMP version 3 will be used, with an Auth-NoPriv
security level.

V3-Auth-Priv - To specify that the SNMP version 3 will be used, with an Auth-Priv security
level.

Community String/
SNMP V3 User Name

Type in the community string or SNMP V3 user name as appropriate.

To implement your new settings, click Apply. To return to the SNMP Host Table, click the Show All SNMP Host Table Entries

link.

SNMP Engine ID

The Engine ID is a unique identifier used for SNMP V3 implementations. This is an alphanumeric string used to identify the
SNMP engine on the Switch. To display the Switch's SNMP Engine ID, open the SNMP Manger folder, (located in the
Administration) folder and click on the SNMP Engine ID link. This will open the SNMP Engine ID window, as shown below.

SNMP Engine ID Configuration
A00000ak030050kha302t

Figure 6- 39. SNMP Engine ID Configuration window

To change the Engine ID, type the new Engine ID in the space provided and click the Apply button.
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PoE System

The DES-3028P and DES-3052P support Power over Ethernet (PoE) as defined by the IEEE 802.3af specification. Ports 1-24/1-
48 can supply 48 VDC power to Power Devices (PDs) over Category 5 or Category 3 UTP Ethernet cables. Both the DES-3028P
and DES-3052P follow the standard PSE (Power Source over Ethernet) pinout Alfernative A, whereby power is sent out over pins
1, 2, 3 and 6. Both the DES-3028P and DES-3052P work with all D-Link 802.3af capable devices.

The DES-3028P and DES-3052P include the following PoE features:
. Auto-discovery recognizes the connection of a PD (Power Device) and automatically sends power to it.

. The Auto-disable feature will occur under two conditions: first, if the total power consumption exceeds the system
power limit; and second, if the per port power consumption exceeds the per port power limit.

. Active circuit protection automatically disables the port if there is a short. Other ports will remain active.

PDs receive power according to the following classification: ~ PSE provides power according to the following classification:
Class Max power used by PD Class Max power used by PSE
0 0.44 to 12.95W 0 15.4W
1 0.44 to 3.84W 1 4.0W
2 3.84 to 6.49W 2 7.0W
3 6.49 to 12.95W 3 15.4W

To configure the PoE features on the DES-3028P and DES-3052P, click Administration > PoE Configuration. The PoE System
window is used to assign a power limit and power disconnect method for the whole PoE system. To configure the Power Limit
for the PoE system, enter a value between 37W and 185W (for the DES-3028P) and between 37W and 370W (for the DES-
3052P) in the Power Limit field. The default setting is 185W (DES-3028P) and 370W (DES-3052P). When the total consumed
power exceeds the power limit, the PoE controller (located in the PSE) disconnects the power to prevent overloading the power
supply.

To configure PoE for the Switch, click Administration > PoE Configuration, which will reveal the following window for the
user to configure:

PoE System Configuration

PoE System Configuration

Power Limit (37-185W) 185
Disconnect Method Dery Mext Port w

PoE System Information

185 0 185 Deny Mext Port

Power Limit

If power disconnection method 15 set to deny nest port, then the systemn can not

utihize out of its masmum power capacity. The masamum unused watt 15 197

Figure 6- 40. PoE System Configuration window



PoE Port Configuration

PoE Port Configuration

-

Port1 % Portl % | Enabled % Low % Wset Define [+] (15400

PoE Port Table

i Pm.\. rer o ultage

Enahled 0 153400/ T ser Defined) Off: Interim state during line detection
2 Enabled 0 Low O 1534000 g et Defined) 1] 1] Off: Interitn state during line detection
i Enabled 0 Low O 154000 ser Defined) ] 1] Off: Interim state during line detection
4 Enabled 0 Lowr a 15400 zet Defined) 1] a Off Interim state during line detection
B Enahled 0 Low 0O 153400/ T ser Defined) 0 0 Off: Interim state during line detection
G Enabled 0 Low O 154000 s et Defined) ] 1] Off, Interitn state during line detection
7 Enabled 0 Low O 154000 T ser Defined) ] 1] Off; Interim state during line detection
2 Enabled 0 Lowr a 15400 zet Defined) 1] a Off Interim state during line detection
9 Enahled 0 Low 0O 153400/ T ser Defined) 0 0 Off: Interim state during line detection
10 Enabled 0 Low O 153400 T s et Defined) 0 1] Off, Interitm state during line detection
11 Enabled 0 Low O 154000 g et Defined) ] 1] Off; Interitn state during line detection
12 Enabled 0 Lowr a 15400 T zet Defined) a a Off Interim state during line detection
13 Enahled 0 Low 0O 153400/ T ser Defined) 0 0 Off: No standard PD connected
14 Enabled 0 Low O 15340000 s et Defined) 0 0 Off, Interim state during line detection
15 Enabled 0 Low O 154000 et Defined) 1] 1] Off: Interitn state during line detection
16 Enabled 0 Low O 154000 U ser Defined) ] 1] Off. Interim state during line detection
17 Enabled 0 Lowr 1] 154000z et Drefined) 1] a OfF Interim state during line detection
18 Enabled 0 Low O 153400 T s et Defined) 0 1] Off, Interitm state during line detection
12 Enabled 0 Low O 154000 et Defined) ] 1] Off: Interitn state during line detection
20 Enabled 0 Low O 154000 U ser Defined) ] 1] Off. Interim state during line detection
21 Enahbled 0 Lowr a 15400 T zet Defined) 1] a Off Interim state during line detection
22 Enahled 0 Low 0O 15340000 s et Defined) 0 1] Off: Interim state during line detection
23 Enabled 0 Low O 154000 g et Defined) ] 1] Off: Interitn state during line detection
24 Enabled 0 Low O 154000 U ser Defined) ] 1] Off. Interim state during line detection

Figure 6- 41. PoE Port Configuration window

The previous window contains the following fields to configure for PoE:

Parameter Description

PoE System

Power Limit Sets the limit of power to be used from the Switch’s power source to PoE ports. The user may
configure a Power Limit between 37 and 185W (for the DES-3028P) and 37 and 370W (for the
DES-3052P). The default setting is 185W (DES-3028P) and 370W (DES-3052P).

Power Disconnect | The PoE controller uses either Deny next port or Deny low priority port to offset the power
Method limit being exceeded and keep the Switch’s power at a usable level. Use the drop down menu
to select a Power Disconnect Method. The default for the Power Disconnect Method is Deny
next port. Both Power Disconnection Methods are described below:

Deny next port - After the power limit has been exceeded, the next port attempting to power
up is denied, regardless of its priority.

Deny low priority port - After the power limit has been exceeded, the next port attempting to
power up causes the port with the lowest priority to shut down to allow the high-priority and
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critical priority ports to power up.

PoE Configuration

From... To... Select a range of ports from the pull-down menus to be enabled or disabled for PoE.

State Use the pull-down menu to enable or disable ports for PoE.

Priority Use the pull-down menu to select the priority of the PoE ports.

Power Limit Sets the power limit per PoE port. Once this threshold has been reached on the port, the PoE

will go into the Power Disconnect Method, as described above. The user may set a limit
between 1000 and 15400mW

Click Apply to implement changes made to the PoE settings. The port status of all PoE configured ports is displayed in the table
in the bottom half of the screen shown above.
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Single IP Settings

Simply put, D-Link Single IP Management is a concept that will stack switches together over Ethernet instead of using stacking
ports or modules. There are some advantages in implementing the "Single IP Management" feature:

1. SIM can simplify management of small workgroups or wiring closets while scaling the network to handle increased
bandwidth demand.

2. SIM can reduce the number of IP address needed in your network.

3. SIM can eliminate any specialized cables for stacking connectivity and remove the distance barriers that typically limit

your topology options when using other stacking technology.
Switches using D-Link Single IP Management (labeled here as SIM) must conform to the following rules:
. SIM is an optional feature on the Switch and can easily be enabled or disabled through the Command Line Interface
or Web Interface. SIM grouping has no effect on the normal operation of the Switch in the user's network.

. There are three classifications for SIM. The Commander Switch (CS), which is the master switch of the group,
Member Switch (MS), which is a switch that is recognized by the CS a member of a SIM group, and a Candidate
Switch (CaS), which is a Switch that has a physical link to the SIM group but has not been recognized by the CS as a
member of the SIM group.

e A SIM group can only have one Commander Switch (CS).

e All switches in a particular SIM group must be in the same IP subnet (broadcast domain). Members of a SIM group
cannot cross a router.

. A SIM group accepts up to 33 switches (numbered 0-32), including the Commander Switch (numbered 0).

There is no limit to the number of SIM groups in the same IP subnet (broadcast domain), however a single switch can only belong
to one group.

If multiple VLANSs are configured, the SIM group will only utilize the system VLAN on any switch.

SIM allows intermediate devices that do not support SIM. This enables the user to manage switches that are more than one hop
away from the CS.

The SIM group is a group of switches that are managed as a single entity. SIM switches may take on three different roles:

1. Commander Switch (CS) - This is a switch that has been manually configured as the controlling device for a group, and

takes on the following characteristics:
e It has an IP Address.
« Itis not a commander switch or member switch of another Single IP group.
o It is connected to the member switches through its management VLAN.

2. Member Switch (MS) - This is a switch that has joined a single IP group and is accessible from the CS, and it takes on
the following characteristics:

. It is not a CS or MS of another Single IP group.
. It is connected to the CS through the CS management VLAN.

3. Candidate Switch (CaS) - This is a switch that is ready to join a SIM group but is not yet a member of the SIM group.
The Candidate Switch may join the SIM group of a switch by manually configuring it to be a MS of a SIM group. A
switch configured as a CaS is not a member of a SIM group and will take on the following characteristics:

. It is not a CS or MS of another Single IP group.
. It is connected to the CS through the CS management VLAN

After configuring one switch to operate as the CS of a SIM group, additional switches may join the group through a direct
connection to the Commander switch. Only the Commander switch will allow entry to the candidate switch enabled for SIM. The
CS will then serve as the in band entry point for access to the MS. The CS's IP address will become the path to all MS's of the
group and the CS's Administrator's password, and/or authentication will control access to all MS's of the SIM group.

With SIM enabled, the applications in the CS will redirect the packet instead of executing the packets. The applications will
decode the packet from the administrator, modify some data, then send it to the MS. After execution, the CS may receive a
response packet from the MS, which it will encode and send it back to the administrator.

When a CS becomes a MS, it automatically becomes a member of the first SNMP community (include read/write and read only)
to which the CS belongs. However, if a MS has its own IP address, it can belong to SNMP communities to which other switches
in the group, including the CS, do not belong.
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The Upgrade to v1.6

To better improve SIM management, the DES-3028/28P/52/52P Switches have been upgraded to version 1.6 in this release.
Many improvements have been made, including:

1. The Commander Switch (CS) now has the capability to automatically rediscover member switches that have left the SIM
group, either through a reboot or web malfunction. This feature is accomplished through the use of Discover packets and Maintain
packets that previously set SIM members will emit after a reboot. Once a MS has had its MAC address and password saved to the
CS’s database, if a reboot occurs in the MS, the CS will keep this MS information in its database and when a MS has been
rediscovered, it will add the MS back into the SIM tree automatically. No configuration will be necessary to rediscover these
switches.

There are some instances where pre-saved MS switches cannot be rediscovered. For example, if the Switch is still powered down,
if it has become the member of another group, or if it has been configured to be a Commander Switch, the rediscovery process
cannot occur.

2. The topology map now includes new features for connections that are a (defaut0-27-00)
member of a port trunking group. It will display the speed and number of Ethernet
connections creating this port trunk group, as shown in the adjacent picture.

Port Speed : 2 x Gigabit-Full

(dlefault 358-29-00)
3. This version will support multiple switch upload and downloads for firmware, configuration files and log files, as follows:
e Firmware — The switch now supports multiple MS firmware downloads from a TFTP server.

e Configuration Files — This switch now supports multiple downloading and uploading of configuration files both to (for
configuration restoration) and from (for configuration backup) MS’s, using a TFTP server..

e Log — The switch now supports uploading multiple MS log files to a TFTP server.

4. The user may zoom in and zoom out when utilizing the topology window to get a better, more defined view of the
configurations.

SIM Settings

All switches are set as Candidate (CaS) switches as their factory default configuration and Single IP Management will be disabled.
To enable SIM for the Switch using the Web interface, go to the Single IP Settings folder, located in the Administration folder,
and click the SIM Settings link, revealing the following window.

SIM Settings

Figure 6- 42. SIM Settings window (disabled)
Change the SIM State to Enabled using the pull-down menu and click Apply. The window will then refresh to look like this:
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SIM Settings

Enahled
Candidate

Discovery Interval 30 (30,90 zec)
100 {100..255 sec)

Figure 6- 43. SIM Settings window (enabled)

If the Switch Administrator wishes to configure the Switch as a Commander Switch (CS), select Commander from the Role State
field and click Apply. The window will change once again to look like this:

SIM Settings
SIM State Enakled +

Commander

Discovery Interval 30 (3090 zec)
Hold Time 100 (100..255 sec)

Figure 6- 44. SIM Settings window (Commander enabled)

The following parameters can be set:

Parameters

Description

SIM State

Use the pull-down menu to either enable or disable the SIM state on the Switch. Disabled will
render all SIM functions on the Switch inoperable.

Role State

Use the pull-down menu to change the SIM role of the Switch. The two choices are:

. Candidate - A Candidate Switch (CaS) is not the member of a SIM group but is
connected to a Commander Switch. This is the default setting for the SIM role.

. Commander - Choosing this parameter will make the Switch a Commander Switch
(CS). The user may join other switches to this Switch, over Ethernet, to be part of its
SIM group. Choosing this option will also enable the Switch to be configured for
SIM.

Discovery
Interval

The user may set the discovery protocol interval, in seconds that the Switch will send out
discovery packets. Returning information to a Commander Switch will include information about
other switches connected to it. (Ex. MS, CaS). The user may set the Discovery Interval from 30
to 90 seconds.

Hold Time

This parameter may be set for the time, in seconds the Switch will hold information sent to it
from other switches, utilizing the Discovery Interval. The user may set the hold time from 700
to 255 seconds.

Click Apply to implement the settings changed.

After enabling the Switch to be a Commander Switch (CS), the Single IP Management folder will then contain four added links
to aid the user in configuring SIM through the web, including Topology, Firmware Upgrade and Configuration
Backup/Restore and Upload Log File.




Topology

The Topology window will be used to configure and manage the Switch within the SIM group and requires Java script to function
properly on your computer.

The Java Runtime Environment on your server should initiate and lead you to the topology window, as seen below.

File Group Device Wiew Help

_ 4
B efault 30-28-00) || Data |

i gf Device name | Local port | Speed | Remaote port | hac Address | Model name |
@ (default:30-28-00 7| (default:30-28-00) - - - 00-50-BA-30-258-00 DES-3028F L2 Switch

Figure 6- 45. Single IP Management window - Tree View

The Tree View window holds the following information under the Data tab:

Parameter Description

Device Name This field will display the Device Name of the switches in the SIM group configured by the user. If
no Device Name is configured by the name, it will be given the name default and tagged with the
last six digits of the MAC Address to identify it.

Local Port Displays the number of the physical port on the CS that the MS or CaS is connected to. The CS
will have no entry in this field.

Speed Displays the connection speed between the CS and the MS or CaS.

Remote Port Displays the number of the physical port on the MS or CaS that the CS is connected to. The CS

wnll hoavin A Antems in thin fiald
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will have no entry in this field.

MAC Address Displays the MAC address of the corresponding Switch.

Model Name Displays the full model name of the corresponding Switch.

To view the Topology Map, click the View menu in the toolbar and then Topology, which will produce the following window.
The Topology View will refresh itself periodically (20 seconds by default).

£ Topology: Cluster 1 . =10l

View

d

defau\t

(default 3-04-00)

/ ’m\

(uefaultEH -01-00; defau\laa 13-00) (defaulISE 29-00) (defau\HEl 24-04) (defaullUU 36-18) (uefauHEH -01-00 defaull 5-26-00) (uefaulIUU 00-00

(default:35-26-03)

|dava Applet Window

Figure 6- 46. Topology view

This window will display how the devices within the Single I[P Management Group are connected to other groups and devices.
Possible icons in this screen are as follows:

Icon Description

Group

Layer 2 commander switch

Layer 3 commander switch

Commander switch of other group

Layer 2 member switch.

Layer 3 member switch

Member switch of other group

Layer 2 candidate switch

Layer 3 candidate switch
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' Unknown device

Non-SIM devices

Tool Tips

In the Topology view window, the mouse plays an important role in configuration and in viewing device information. Setting the
mouse cursor over a specific device in the topology window (tool tip) will display the same information about a specific device as
the Tree view does. See the window below for an example.

Mame  (defanlt:30-28-00)
(default:30-; Model : DES-3022F L2 Switch
M&C  :00-50-BaA-30-28-00
Local Port : -

Bemote Port : -

Port Speed : -

Figure 6- 47. Device Information Utilizing the Tool Tip

Setting the mouse cursor over a line between two devices will display the connection speed between the two devices, as shown
below.

fdefaultjeb-23-32)

(defaultieh-23-22)

Port Speed : 100-Full

S 4

{default{20-10-01)

= -

Intrartet

{default46-09-00) (default:33-13-00) (default:10-24-04) (default:61-41-00) {default:35-26-9¢

Figure 6- 48. Port Speed Utilizing the Tool Tip
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Right-Click

Right-clicking on a device will allow the user to perform various functions, depending on the role of the Switch in the SIM group
and the icon associated with it.

Group Icon

(default
-1 Property

(default]as-26-a0)

(default3 EXpand
Property

Figure 6- 49. Right-Clicking a Group Icon

The following options may appear for the user to configure: £ Property

. Collapse - To collapse the group that will be represented by a single icon. Device Mame |kdefau|t3t|—28-t||:|)
. Expand - To expand the SIM group, in detail.

Module Mame : |DES-3028P L2 Switch
. Property - To pop up a window to display the group information.

Mac Address: | 00-0-BA-30-26-00

Remote Port Mo |-

Local Port Mo ;|-
Port Speed ;|-

Close

I‘Java Applet Window

Figure 6- 50. Property window

This window holds the following information:

Parameter Description

Device Name This field will display the Device Name of the switches in the SIM group configured by the user.
If no Device Name is configured by the name, it will be given the name default and tagged with
the last six digits of the MAC Address to identify it.

Module Name Displays the full module name of the switch that was right-clicked.

MAC Address Displays the MAC Address of the corresponding Switch.

Remote Port No. | Displays the number of the physical port on the MS or CaS that the CS is connected to. The CS
will have no entry in this field.

Local Port No. Displays the number of the physical port on the CS that the MS or CaS is connected to. The CS
will have no entry in this field.

Port Speed Displays the connection speed between the CS and the MS or CaS

Click Close to close the Property window.
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Commander Switch Icon

(default3s-26-a0) (default}3s-26-a0)
g% Expand
(defaultjzq Collapse (default{a
Property
Property

Figure 6- 51. Right-Clicking a Commander Icon
The following options may appear for the user to configure:
. Collapse - To collapse the group that will be represented by a single icon.
. Expand - To expand the SIM group, in detail.

e Property - To pop up a window to display the group information.

Member Switch Icon

_\_\_\_\_\_‘_‘——\_
ﬁ Expand \@‘ Collapse
(default42 B
Remove from group (default 43 Remave from group
Configure Configure =
Property Property

Figure 6- 52. Right-Clicking a Member icon
The following options may appear for the user to configure:
. Collapse - To collapse the group that will be represented by a single icon.
o  Expand - To expand the SIM group, in detail.
«  Remove from group - Remove a member from a group.
. Configure - Launch the web management to configure the Switch.

e  Property - To pop up a window to display the device information.

Candidate Switch Icon

iﬁ; Expand @ Collapse

(default: (default:4
Add to group Add to group

Property Property

Figure 6- 53. Right-Clicking a Candidate icon
The following options may appear for the user to configure:
. Collapse - To collapse the group that will be represented by a single icon.

. Expand - To expand the SIM group, in detail.
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e  Add to group - Add a candidate to a group. Clicking this option will reveal the following dialog for the user to enter
a password for authentication from the Candidate Switch before being added to the SIM group. Click OK to enter
the password or Cancel to exit the window.

Input password E x|

Password

OK Cancel

Java Applet window

Figure 6- 54. Input password window

. Property - To pop up a window to display the device information, as shown below.

Menu Bar

The Single IP Management window contains a menu bar for device configurations, as seen below.

File Group Device View Help

Figure 6- 55. Menu Bar of the Topology View

The five menus on the menu bar are as follows.

File

. Print Setup - Will view the image to be printed.

. Print Topology - Will print the topology map.

. Preference - Will set display properties, such as polling interval, and the views to open at SIM startup.
Group

e  Add to group - Add a candidate to a group. Clicking this option will reveal the following dialog for the user to enter

a password for authentication from the Candidate Switch before being added to the SIM group. Click OK to enter
the password or Cancel to exit the window.
Input password - |
Password
OK Cancel
Java spplet Window
Figure 6- 56. Input password window

. Remove from Group - Remove an MS from the group.
Device

. Configure - Will open the web manager for the specific device.
View

. Refresh - Update the views with the latest status.

. Topology - Display the Topology view.
Help

e About - Will display the SIM information, including the current SIM version.
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Copyright {c) 2004 D-Link corporation
Release Date : 2005/07/14
Ok
Java dpplet \Window

Figure 6- 57. About window

Firmware Upgrade

This screen is used to upgrade firmware from the Commander Switch to the Member Switch. To access the following window,
click Administration > Single IP Management Settings > Firmware Upgrade. Member Switches will be listed in the table and
will be specified by Port (port on the CS where the MS resides), MAC Address, Model Name and Version. To specify a certain
Switch for firmware download, click its corresponding check box under the Port heading. To update the firmware, enter the
Server IP Address where the firmware resides and enter the Path/Filename of the firmware. Click Download to initiate the file
transfer.

Firmware Upgrade

Server IP Address 0 |0 |0 |0

Path ' Filename

Figure 6- 58. Firmware Upgrade window

Configuration Backup/Restore

This screen is used to upgrade configuration files from the Commander Switch to the Member Switch using a TFTP server.
Member Switches will be listed in the table and will be specified by Port (port on the CS where the MS resides), MAC Address,
Model Name and Version. To specify a certain Switch for upgrading configuration files, click its corresponding radio button
under the Port heading. To update the configuration file, enter the Server IP Address where the file resides and enter the
Path/Filename of the configuration file. Click Download to initiate the file transfer from a TFTP server to the Switch. Click
Upload to backup the configuration file to a TFTP server. To access the following window, click Administration > Single IP
Management Settings > Configuration Backup/Restore.

Configuration File Backup/Restore

Server IP Address 0 o |0 |0

Path ' Filename

Lpload H Diownload

Figure 6- 59. Configuration File Backup/Restore window
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Upload Log

The following window is used to upload log files from SIM member switches to a specified PC. To view this window click
Administration > Single IP Management > Upload Log File. To upload a log file, enter the IP address of the SIM member
switch and then enter a path on your PC where you wish to save this file. Click Upload to initiate the file transfer.

Upload Log File

Server IP Address |0 |0 |0

Path ' Filename

Figure 6- 60. Upload Log File window

Forwarding & Filtering

Unicast Forwarding

Open the Forwarding Filtering folder in the Configuration menu and click on the Unicast Forwarding link. This will open the
following window:

Unicast Forwarding

MAC Address
00:00:00:00:00:00 Porl1

i

Add

Unicast Forwarding Table

MAC Adrers VD VLAN Name _pon

End of datal

Figure 6- 61. Unicast Forwarding window

To add or edit an entry, define the following parameters and then click Add/Modify:

Parameter Description

VID The VLAN ID number of the VLAN on which the above Unicast MAC address resides.

MAC Address The MAC address to which packets will be statically forwarded. This must be a unicast
MAC address.

Port Allows the selection of the port number on which the MAC address entered above resides.

Click Apply to implement the changes made. To delete an entry in the Static Unicast Forwarding Table, click the corresponding X
under the Delete heading.
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Multicast Forwarding

The following figure and table describe how to set up Multicast Forwarding on the Switch. Open the Forwarding Filtering
folder and click on the Multicast Forwarding link to see the entry window below:

Total Entries:0
Multicast Forwarding Settings

Add new Multicast Forwarding Settings

Multicast Forwarding

MAC Adire Ty

Figure 6- 62. Multicast Forwarding Settings window

The Static Multicast Forwarding Settings window displays all of the entries made into the Switch's static multicast forwarding
table. Click the Add button to open the Setup Static Multicast Forwarding Table window, as shown below:

Setup Static Multicast Forwarding Table

Multicast MAC Address
00:00:00:00:00:00

LS O RN T O N (2 O N O P R ER T
O]

o o o \ -, o o o o -, " o o
(*) (®) O] (*) O] (*) (*) )] (®) (®) () O] (*)

bt S

‘

N N

® (& |® (& (& | (& (& (& (& ([ |0 (o |
None ® ® ® ® O] ® ® ® ® O] @ ® ® ®

A

c o o o oo O o O O O O O O O

Apply

show Al MMulticast Forwarding Entries

Figure 6- 63. Setup Static Multicast Forwarding Table window

The following parameters can be set:

Parameter Description

VID The VLAN ID of the VLAN to which the corresponding MAC address belongs.

Multicast MAC The MAC address of the static source of multicast packets. This must be a multicast MAC
Address address.

Port Settings Allows the selection of ports that will be members of the static multicast group and ports

either that are forbidden from joining dynamically, or that can join the multicast group
dynamically, using GMRP. The options are:

None - No restrictions on the port dynamically joining the multicast group. When None is
chosen, the port will not be a member of the Static Multicast Group.

Egress - The port is a static member of the multicast group.

Click Apply to implement the changes made. To delete an entry in the Static Multicast Forwarding Table, click the corresponding
X under the Delete heading. Click the Show All Multicast Forwarding Entries link to return to the Static Multicast
Forwarding Settings window.
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Multicast Filtering Mode

The following figure and table describe how to set up multicast forwarding on the Switch. Open the Forwarding Filtering folder
and click on the Multicast Filtering Mode Setup link to see the entry window below:

The following parameters can be set:

Multicast Filtering Mode

Fort1l

Multicast Filtering Mode Table

Fortl Forward Unregistered Groups # Apply

Figure 6- 64. Multicast Filtering Mode window

Parameter Description

From/To These two drop-down menus allow you to select a range of ports to which the filter settings will
be applied.

Mode This drop-down menu allows you to select the action the Switch will take when it receives a

multicast packet that is to be forwarded to one of the ports in the range specified above.

Forward Unregistered Groups - This will instruct the Switch to forward a multicast
packet whose destination is an unregistered multicast group residing within the
range of ports specified above.
Filter Unregistered Groups - This will instruct the Switch to filter any multicast
packets whose destination is an unregistered multicast group residing within the
range of ports specified above.

Click Apply to implement changes made.

71




SMTP Service

SMTP or Simple Mail Transfer Protocol is a function of the Switch that will send switch events to mail recipients based on e-mail
addresses entered using the commands below. The Switch is to be configured as a client of SMTP while the server is a remote
device that will receive messages from the Switch, place the appropriate information into an e-mail and deliver it to recipients
configured on the Switch. This can benefit the Switch administrator by simplifying the management of small workgroups or
wiring closets, increasing the speed of handling emergency Switch events and enhancing security by recording questionable
events occurring on the Switch.

The Switch plays four important roles as a client in the functioning of SMTP:

The server and server virtual port must be correctly configured for this function to work properly. This is accomplished in
the SMTP Service Settings window by properly configuring the SMTP Server Address and SMTP Server Port fields.

Mail recipients must be configured on the Switch. This information is sent to the server which then processes the
information and then e-mails Switch information to these recipients. Up to 8 e-mail recipients can be configured on the
Switch using the SMTP Service Settings window by configuring the Mail Receiver Address field.

The administrator can configure the source mail address from which messages are delivered to configured recipients. This
can offer more information to the administrator about Switch functions and problems. The personal e-mail can be
configured using the SMTP Service Settings window and setting the Self Mail Address field.

The Switch can be configured to send out test mail to first ensure that the recipient will receive e-mails from the SMTP
server regarding the Switch. To configure this test mail, the SMTP function must first be enabled by configuring the
SMTP State in the SMTP Service Settings window and then by sending an email using the SMTP Service window. All
recipients configured for SMTP will receive a sample test message from the SMTP server, ensuring the reliability of this
function.

The Switch will send out e-mail to recipients when one or more of the following events occur:

When a cold start occurs on the Switch.

When a port enters a link down status.

When a port enters a link up status.

When SNMP authentication has been denied by the Switch.

When a switch configuration entry has been saved to the NVRAM by the Switch.

When an abnormality occurs on TFTP during a firmware download event. This includes in-process, invalid-file, violation,
file-not-found, complete and time-out messages from the TFTP server.

When a system reset occurs on the Switch.

Information within the e-mail from the SMTP server regarding switch events includes:

The source device name and IP address.

A timestamp denoting the identity of the SMTP server and the client that sent the message, as well as the time and date of
the message received from the Switch. Messages that have been relayed will have timestamps for each relay.

The event that occurred on the Switch, prompting the e-mail message to be sent.
When an event is processed by a user, such as save or firmware upgrade, the IP address, MAC address and User Name of
the user completing the task will be sent along with the system message of the event occurred.

When the same event occurs more than once, the second mail message and every repeating mail message following will
have the system’s error message placed in the subject line of the mail message.

The following details events occurring during the Delivery Process.

Urgent mail will have high priority and be immediately dispatched to recipients while normal mail will be placed in a
queue for future transmission.

The maximum number of untransmitted mail messages placed in the queue cannot exceed 30 messages. Any new
messages will be discarded if the queue is full.

If the initial message sent to a mail recipient is not delivered, it will be placed in the waiting queue until its place in the
queue has been reached, and then another attempt to transmit the message is made.

The maximum attempts for delivering mail to recipients is three. Mail message delivery attempts will be tried every five
minutes until the maximum number of attempts is reached. Once reached and the message has not been successfully
delivered, the message will be dropped and not received by the mail recipient.

If the Switch shuts down or reboots, mail messages in the waiting queue will be lost.
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SMTP Server Settings

The following window is used to configure the fields to set up the SMTP server for the switch, along with setting e-mail
addresses to which switch log files can be sent when a problem arises on the Switch. To open the following window, open the
Administration folder, then the SMTP Service folder and then click the SMTP Server Settings link.

Index

SMTP Service Settings

SMTP State Disahled
SMTP Server Address 0.0.0.0
SMTP Server Port(1-65535) 0

Self Mail Address

SMTP Mail Receiver

<
.
7
-
E
g

Mail Receiver Address Table

©Mail Receiver Address Delete

Figure 6- 65. SMTP Service Settings and Mail Receiver Address Table window

The following parameters can be set:

Parameter

Description

SMTP State

Use the pull-down menu to enable or disable the SMTP service on this device.

SMTP Server Address

Enter the IP address of the SMTP server on a remote device. This will be the device that
sends out the mail for you.

SMTP Server Port

Enter the virtual port number that the Switch will connect with on the SMTP server. The
common port number for SMTP is 25, yet a value between 1 and 65535 can be chosen.

Self Mail Address

Enter the e-mail address from which mail messages will be sent. This address will be the
“from” address on the e-mail message sent to a recipient. Only one self mail address can
be configured for this Switch. This string can be no more that 64 alphanumeric characters.

Mail Receiver Address

Enter a list of e-mail addresses so recipients can receive e-mail messages regarding
Switch functions. Up to 8 e-mail addresses can be added per Switch. Do delete these

addresses from the Switch, click it's corresponding % under the Delete heading in the
Mail Receiver Address Table.

Click Apply to implement changes made.

SMTP Service

The following window is used to send test messages to all mail recipients configured on the Switch, thus testing the configurations
set and the reliability of the SMTP server. To access the following window, open the Administration folder, then the SMTP
Service folder and click the SMTP Service link.

~

3




SMTP Service

Content:

Figure 6- 66. SMTP Service window

The following parameters can be set:

Parameter Description
Subject Enter the subject of the test e-mail.
Content Enter the content of the test e-mail.

Once your message is ready, click Send to send this mail to all recipients configured on the Switch for SMTP.
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Section 7

L2 Features

VLAN
Trunking
IGMP Snooping

Spanning Tree

VLANSs

A Virtual Local Area Network (VLAN) is a network topology configured according to a logical scheme rather than the physical
layout. VLANSs can be used to combine any collection of LAN segments into an autonomous user group that appears as a single
LAN. VLANS also logically segment the network into different broadcast domains so that packets are forwarded only between
ports within the VLAN. Typically, a VLAN corresponds to a particular subnet, although not necessarily.

VLANS can enhance performance by conserving bandwidth, and improve security by limiting traffic to specific domains.

A VLAN is a collection of end nodes grouped by logic instead of physical location. End nodes that frequently communicate with
each other are assigned to the same VLAN, regardless of where they are physically on the network. Logically, a VLAN can be
equated to a broadcast domain, because broadcast packets are forwarded to only members of the VLAN on which the broadcast
was initiated.

Notes about VLANS on the Switch

No matter what basis is used to uniquely identify end nodes and assign these nodes VLAN membership, packets cannot cross
VLANSs without a network device performing a routing function between the VLANS.

The Switch supports IEEE 802.1Q VLANSs. The port untagging function can be used to remove the 802.1Q tag from packet
headers to maintain compatibility with devices that are tag-unaware.

The Switch's default is to assign all ports to a single 802.1Q VLAN named "default."
The "default" VLAN has a VID = 1.
The member ports of Port-based VLANs may overlap, if desired.

IEEE 802.1Q VLANs

Some relevant terms:
o Tagging - The act of putting 802.1Q VLAN information into the header of a packet.
e Untagging - The act of stripping 802.1Q VLAN information out of the packet header.

o Ingress port - A port on a switch where packets are flowing into the Switch and VLAN decisions must be
made.

o Egress port - A port on a switch where packets are flowing out of the Switch, either to another switch or to an
end station, and tagging decisions must be made.

IEEE 802.1Q (tagged) VLANs are implemented on the Switch. 802.1Q VLANS require tagging, which enables them to span the
entire network (assuming all switches on the network are IEEE 802.1Q-compliant).

VLANS allow a network to be segmented in order to reduce the size of broadcast domains. All packets entering a VLAN will only
be forwarded to the stations (over IEEE 802.1Q enabled switches) that are members of that VLAN, and this includes broadcast,
multicast and unicast packets from unknown sources.

VLANS can also provide a level of security to your network. IEEE 802.1Q VLANSs will only deliver packets between stations that
are members of the VLAN.

Any port can be configured as either tagging or untagging. The untagging feature of IEEE 802.1Q VLANSs allows VLANSs to work
with legacy switches that don't recognize VLAN tags in packet headers. The tagging feature allows VLANs to span multiple
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802.1Q-compliant switches through a single physical connection and allows Spanning Tree to be enabled on all ports and work
normally.

The IEEE 802.1Q standard restricts the forwarding of untagged packets to the VLAN of which the receiving port is a member.
The main characteristics of IEEE 802.1Q are as follows:

e Assigns packets to VLANSs by filtering.

. Assumes the presence of a single global spanning tree.

e Uses an explicit tagging scheme with one-level tagging.

. 802.1Q VLAN Packet Forwarding

. Packet forwarding decisions are made based upon the following three types of rules:

. Ingress rules - rules relevant to the classification of received frames belonging to a VLAN.

. Forwarding rules between ports - decides whether to filter or forward the packet.

. Egress rules - determines if the packet must be sent tagged or untagged.

802 1Q) Packet Forwarding

L
P

Ingress Ingres Egrass
Rufes Fitraring Pdes
f Ferwarding f i
p| Process -
&
Filtering PV o YD
Databame L. MN Table
Pert State
Tagging or
Untagging

Figure 7- 1. IEEE 802.1Q Packet Forwarding

802.1Q VLAN Tags

The figure below shows the 802.1Q VLAN tag. There are four additional octets inserted after the source MAC address. Their
presence is indicated by a value of 0x8100 in the EtherType field. When a packet's EtherType field is equal to 0x8100, the packet
carries the IEEE 802.1Q/802.1p tag. The tag is contained in the following two octets and consists of 3 bits of user priority, 1 bit of
Canonical Format Identifier (CFI - used for encapsulating Token Ring packets so they can be carried across Ethernet backbones),
and 12 bits of VLAN ID (VID). The 3 bits of user priority are used by 802.1p. The VID is the VLAN identifier and is used by the
802.1Q standard. Because the VID is 12 bits long, 4094 unique VLANS can be identified.

The tag is inserted into the packet header making the entire packet longer by 4 octets. All of the information originally contained
in the packet is retained.
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IEEE 802.1Q Tag

1 2 3 4
Destination Address (6 octets) |
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|

|

|

Cyclic Redundancy Check {4 octets) |

Fuserpriority| cFT | VLANID (VID) (12 bita) b
3 bits 1 bit 12 bits

Figure 7- 2. IEEE 802.1Q Tag

The EtherType and VLAN ID are inserted after the MAC source address, but before the original EtherType/Length or Logical
Link Control. Because the packet is now a bit longer than it was originally, the Cyclic Redundancy Check (CRC) must be
recalculated.
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Figure 7- 3. Adding an IEEE 802.1Q Tag

Tagging and Untagging
Every port on an 802.1Q compliant switch can be configured as tagging or untagging.

Ports with tagging enabled will put the VID number, priority and other VLAN information into the header of all packets that flow
into and out of it. If a packet has previously been tagged, the port will not alter the packet, thus keeping the VLAN information
intact. The VLAN information in the tag can then be used by other 802.1Q compliant devices on the network to make packet-for-
warding decisions.

Ports with untagging enabled will strip the 802.1Q tag from all packets that flow into and out of those ports. If the packet doesn't
have an 802.1Q VLAN tag, the port will not alter the packet. Thus, all packets received by and forwarded by an untagging port
will have no 802.1Q VLAN information. (Remember that the PVID is only used internally within the Switch). Untagging is used
to send packets from an 802.1Q-compliant network device to a non-compliant network device.

Ingress Filtering

A port on a switch where packets are flowing into the Switch and VLAN decisions must be made is referred to as an ingress port.
If ingress filtering is enabled for a port, the Switch will examine the VLAN information in the packet header (if present) and
decide whether or not to forward the packet.

If the packet is tagged with VLAN information, the ingress port will first determine if the ingress port itself is a member of the
tagged VLAN. If it is not, the packet will be dropped. If the ingress port is a member of the 802.1Q VLAN, the Switch then
determines if the destination port is a member of the 802.1Q VLAN. If it is not, the packet is dropped. If the destination port is a
member of the 802.1Q VLAN, the packet is forwarded and the destination port transmits it to its attached network segment.
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If the packet is not tagged with VLAN information, the ingress port will tag the packet with its own PVID as a VID (if the port is
a tagging port). The switch then determines if the destination port is a member of the same VLAN (has the same VID) as the
ingress port. If it does not, the packet is dropped. If it has the same VID, the packet is forwarded and the destination port transmits
it on its attached network segment.

This process is referred to as ingress filtering and is used to conserve bandwidth within the Switch by dropping packets that are
not on the same VLAN as the ingress port at the point of reception. This eliminates the subsequent processing of packets that will
just be dropped by the destination port.

Default VLANSs

The Switch initially configures one VLAN, VID = 1, called "default." The factory default setting assigns all ports on the Switch to
the "default." As new VLANSs are configured in Port-based mode, their respective member ports are removed from the "default.”

Packets cannot cross VLANSs. If a member of one VLAN wants to connect to another VLAN, the link must be through an external
router.

= NOTE: If no VLANs are configured on the Switch, then all packets will be

forwarded to any destination port. Packets with unknown source
f addresses will be flooded to all ports. Broadcast and multicast packets will
o also be flooded to all ports.

i

An example is presented below:

VLAN Name VID Switch Ports

System (default) 1 5,6,7,8,21,22,23,24
Engineering 2 9,10, 11,12

Marketing 3 13, 14, 15, 16

Finance 4 17,18, 19, 20

Sales 5 1,2,3,4

Table 7- 1. VLAN Example - Assigned Ports

VLAN Segmentation

Take for example a packet that is transmitted by a machine on Port 1 that is a member of VLAN 2. If the destination lies on
another port (found through a normal forwarding table lookup), the Switch then looks to see if the other port (Port 10) is a member
of VLAN 2 (and can therefore receive VLAN 2 packets). If Port 10 is not a member of VLAN 2, then the packet will be dropped
by the Switch and will not reach its destination. If Port 10 is a member of VLAN 2, the packet will go through. This selective
forwarding feature based on VLAN criteria is how VLANs segment networks. The key point being that Port 1 will only transmit
on VLAN 2.

Network resources such as printers and servers however, can be shared across VLANS. This is achieved by setting up overlapping
VLANS. That is ports can belong to more than one VLAN group. For example, setting VLAN 1 members to ports 1, 2, 3, and 4
and VLAN 2 members to ports 1, 5, 6, and 7. Port 1 belongs to two VLAN groups. Ports 8, 9, and 10 are not configured to any
VLAN group. This means ports 8, 9, and 10 are in the same VLAN group.

VLAN and Trunk Groups

The members of a trunk group have the same VLAN setting. Any VLAN setting on the members of a trunk group will apply to
the other member ports.
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Static VLAN Entry

In the L2 Features folder, open the VLAN folder and click the Static VLAN Entry link to open the following window:

Total Entries:1

Static VLANs Entry Settings

Add Mew 802.1 Q) VLA Add i

Static VLANs Entry

T o T S Ty
1 default 1-28 Modify | X

Figure 7- 4. Static VLANs Entry Settings window
The 802.1Q Static VLANs window lists all previously configured VLANs by VLAN ID and VLAN Name. To delete an existing

802.1Q VLAN, click the corresponding X ! button under the Delete heading.

To create a new 802.1Q VLAN, click the Add button in the 802.1Q Static VLANs window. A new window will appear, as
shown below, to configure the port settings and to assign a unique name and number to the new VLAN. See the table below for a
description of the parameters in the new window.

802.1Q Static VLANs

» e

Disabled
O T O O B T

4
Pt Pt oy Pt Pt
\2) A2 \2) \2) \2)

~ ~
) 0y
L B

||

#
© [l
.

-
{#)
Lo

- e )
Lty hES A

b,
”

® (& (& (& | & @

Y

b | | e |

=
,

i
A

® | (» (o |(» (» (® | (8 (» | |® |
PortSotings 1516 N7 e 1o fo @1 2 s e s s @ m

E IH
1]
Z |
%]
3
=
Q
1
S

Tag [v]

o lo lo lo o |o [o lo lo lo [o o o [o
Tress £ ) @ |@ & |@ * | @ ® | @ * | @ ® | @ »

Forbidden o | |o |0 |o |0 |0 |0 |0 o |o |o [0 |e
Apply

[t
=
)
3
'
=
2
=
5
=
5
3

Figure 7- 5. 802.1Q Static VLANs window - Add

To return to the Current 802.1Q Static VLANs Entries window, click the Show All Static VLAN Entries link. To change an
existing 802.1Q VLAN entry, click the Modify button of the corresponding entry you wish to modify. A new window will appear
to configure the port settings and to assign a unique name and number to the new VLAN. See the table below for a description of
the parameters in the new window.
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Figure 7- 6. 802.1Q Static VLANs window - Modify
The following fields can then be set in either the Add or Modify 802.1Q Static VLANs windows:

Parameter Description

VID Allows the entry of a VLAN ID in the Add dialog box, or displays the VLAN ID of an existing
VLAN in the Modify dialog box. VLANs can be identified by either the VID or the VLAN name.

VLAN Name Allows the entry of a name for the new VLAN in the Add dialog box, or for editing the VLAN
name in the Modify dialog box.

Port Settings Allows an individual port to be specified as member of a VLAN.

Tag Specifies the port as either 802.1Q tagging or 802.1Q untagged. Checking the box will desig-
nate the port as Tagged.

None Allows an individual port to be specified as a non-VLAN member.

Egress Select this to specify the port as a static member of the VLAN. Egress member ports are ports

that will be transmitting traffic for the VLAN. These ports can be either tagged or untagged.

Click Apply to implement changes made. Click the Show All Static VLAN Entries link to return to the 802.1Q Static VLANSs
window.




GVRP Settings

In the L2 Features folder, open the VLAN folder and click GVRP Settings. The GVRP Settings window, shown left, allows
you to determine whether the Switch will share its VLAN configuration information with other GARP VLAN Registration
Protocol (GVRP) enabled switches. In addition, Ingress Checking can be used to limit traffic by filtering incoming packets whose
PVID does not match the PVID of the port. Results can be seen in the table under the configuration settings, as seen below.

The following fields can be set:

| Parameter Description \
. . Ti GVYRP gress Check P'\“'lD Apply
From/To These two fields allow you to specify the %E e,. m T --
. . . 0 0 Isahle: naple mi
range of ports that will be included in the i
Portbased VLAN that you are creating
using the 802.1Q Port Settings window.
. . i 1 Disabled Enabled All Frames
GVRP The Group VLAN Registration Protocol | |z 1 Dissbled  Ensbled All Frames
(GVRP) enables the port to dynamically | |3 : S e
become a member of a VLAN. GVRP is | |3 1 Disabled  Enabled AllFrames
Disabled by default. R S e o
B . . 8 1 Disabled Enabled AllFrames
Ingress This field can be toggled using the space | |s 1 Disablod  Enabled All Fremes
: 10 1 Disabled Enabled AllFrames
Check bar between Enabled and Disabled. | | : SeiEee s e
Enabled enables the port to compare the | | 1 Digabled  Enabled All Frames
. . . 13 il Disahled Enabled All Frames
VID tag of an incoming packet with the o ] S it i
PVID number assigned to the port. If the - - R A I
two are different, the port filters (drops) | | 1 Disabisd  Bnablsd All Frames
the packet. Disabled disables ingress fil- | |%# ) Dicsaler SRR £ tle ) AllEzane
. . . . 19 1 Disabled Enabled AllFrames
tering. Ingress Checklng is Disabled by 20 1 Disabled Enabled All Frames
21 il Disabled Enabled All Frames
defaU|t 22 i Disabled Enabled A1l Frames
. . 3 1 Disabled Enabled AllFrames
PVID The read-only field in the 802.1Q Port 24 1 Disabled Enabled All Frames
H 25 1 Disabled Enabled AllFrames
Table shows the cu_rrent PVID assignment | |2 : D e
for each port, which may be manually | |z 1 Disabled Enatled Al Frames
assigned to a VLAN when created in the | [® ! S e

802.1Q Port Settings table. The Switch's Figure 7- 7. GVRP Settings window
default is to assign all ports to the default ’

VLAN with a VID of 1. The PVID is used
by the port to tag outgoing, untagged
packets, and to make filtering decisions
about incoming packets. If the port is
specified to accept only tagged frames -
as tagging, and an untagged packet is
forwarded to the port for transmission, the
port will add an 802.1Q tag using the
PVID to write the VID in the tag. When the
packet arrives at its destination, the
receiving device will use the PVID to make
VLAN forwarding decisions. If the port
receives a packet, and Ingress filtering is
enabled, the port will compare the VID of
the incoming packet to its PVID. If the two
are unequal, the port will drop the packet.
If the two are equal, the port will receive

the packet.
Acceptable | This field denotes the type of frame that
Frame will be accepted by the port. The user may
Type choose between Tagged Only, which

means only VLAN tagged frames will be
accepted, and Admit_All, which mean
both tagged and untagged frames will be
accepted. Admit_All is enabled by default.

Click Apply to implement changes made.
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Trunking

Port trunk groups are used to combine a number of ports together to make a single high-bandwidth data pipeline.

The Switch supports up to six port trunk groups with 2 to 8 ports in each group. A potential bit rate of 800 Mbps can be achieved.

An Example of Link Aggregation

Ethernet Backbone
Uplink

100 Mbps 100 Mbps 100 Mbps
10/100 Mbps Connection 10/100 Mbps Connection 10/100 Mbps Connection

8% 45 5%

End Station Clients
Figure 7- 8. Example of Port Trunk Group

The Switch treats all ports in a trunk group as a single port. Data transmitted to a specific host (destination address) will always be
transmitted over the same port in a trunk group. This allows packets in a data stream to arrive in the same order they were sent.

NOTE: If any ports within the trunk group become disconnected, packets
intended for the disconnected port will be load shared among the other
, uplinked ports of the link aggregation group.

Link aggregation allows several ports to be grouped together and to act as a single link. This gives a bandwidth that is a multiple
of a single link's bandwidth.

Link aggregation is most commonly used to link a bandwidth intensive network device or devices, such as a server, to the
backbone of a network.

The Switch allows the creation of up to six link aggregation groups, each group consisting of 2 to 8 links (ports). All of the ports
in the group must be members of the same VLAN, and their STP status, static multicast, traffic control, traffic segmentation and
802.1p default priority configurations must be identical. Port locking, port mirroring and 802.1X must not be enabled on the trunk
group. Further, the aggregated links must all be of the same speed and should be configured as full-duplex.

The Master Port of the group is to be configured by the user, and all configuration options, including the VLAN configuration that
can be applied to the Master Port, are applied to the entire link aggregation group.

Load balancing is automatically applied to the ports in the aggregated group, and a link failure within the group causes the
network traffic to be directed to the remaining links in the group.

The Spanning Tree Protocol will treat a link aggregation group as a single link, on the switch level. On the port level, the STP will
use the port parameters of the Master Port in the calculation of port cost and in determining the state of the link aggregation group.
If two redundant link aggregation groups are configured on the Switch, STP will block one entire group, in the same way STP will
block a single port that has a redundant link.
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Link Aggregation

To configure port trunking, click L2 Features > Trunking > Link Aggregation to bring up the following window:

Link Aggregation
Add New Link Aggregation Group Add

Link Aggregation Group Entries
Group ID Type Mndify Delete

Figure 7- 9. Link Aggregation window

To configure port trunk groups, click the Add button to add a new trunk group and use the Port Trunking Configuration menu
(see example below) to set up trunk groups. To modify a port trunk group, click the hyperlinked group number corresponding to

the entry you wish to alter. To delete a port trunk group, click the corresponding X' under the Delete heading in the Link
Aggregation Group Entries table (at the bottom of the Link Aggregation window).

Link Aggregation Settings
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MNote: Itis only valid to set up at most 8 member ports of any one trunk group and a port can be a member of only one trunk group at a
fime.

show All Tink Agoresation Group Entries

Figure 7- 10. Link Aggregation Settings window — Add

LACP Port Settings

To configure Link Aggregation Control Protocol port trunking, click L2 Features > Trunking > LACP Port Settings to bring
up the Port Link Aggregation Group table:
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LACP Port Settings
Fortl Fortl Fassive

1 Pasaive
2 Passive
3 Passive
4 Passive
3 Pasaive
£ Passive
7 Passive
2] Passive
9 Pasaive
10 Passive
11 Passive
12 Passive
13 Pasaive
14 Passive
15 Passive
16 Passive
17 Pasaive
18 Passive
19 Passive
20 Passive
21 Pasaive
22 Passive
25 Passive
24 Passive
25 Pasaive
26 Passive
27 Passive
28 Passive

Figure 7- 11. LACP Port Settings window

To configure LACP port trunk settings, select a port range using the From and To drop-down menus, select either Passive or
Active Mode, and then click Apply to let your changes take effect.
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IGMP Snooping

Internet Group Management Protocol (IGMP) snooping allows the Switch to recognize IGMP queries and reports sent
between network stations or devices and an IGMP host. When enabled for IGMP snooping, the Switch can open or close a port to
a specific device based on IGMP messages passing through the Switch.

In order to use IGMP Snooping it must first be enabled for the entire Switch (see Advanced Settings). You may then fine-tune
the settings for each VLAN using the IGMP Snooping link in the L2 Features folder. When enabled for IGMP snooping, the
Switch can open or close a port to a specific Multicast group member based on IGMP messages sent from the device to the IGMP
host or vice versa. The Switch monitors IGMP messages and discontinues forwarding multicast packets when there are no longer
hosts requesting that they continue. Use the IGMP Snooping window to view IGMP Snooping status. To modify settings, click
the Modify button for the VLAN Name entry you want to change.

Use the IGMP Snooping window to view IGMP Snooping settings. To modify the settings, click the Modify button of the VLAN
ID to change.

Total Entries : 1

IGMP Snooping

default Dhsabled Ihsakled bodify

ﬁ

Figure 7- 12. IGMP Snooping window
Clicking the Modify button will open the IGMP Snooping Settings menu, shown below:

IGMP Snooping Settings

VLAN ID
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Max Response Time (1-25) 10
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Figure 7- 13. IGMP Snooping Settings window

The following parameters may be viewed or modified:

Parameter Description

VLAN ID This is the VLAN ID that, along with the VLAN Name, identifies the VLAN for which to modify
the IGMP Snooping Settings.

]
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VLAN Name

This is the VLAN Name that, along with the VLAN ID, identifies the VLAN for which to modify
the IGMP Snooping Settings.

Query Interval

This field is used to set the time (in seconds) between transmitting IGMP queries. Entries
between 7 and 65535 seconds are allowed. Default = 7125.

Max Response Time

This determines the maximum amount of time in seconds allowed before sending an IGMP
response report. This field allows an entry between 7 and 25 (seconds). Default = 10.

Robustness Value

Adjust this variable according to expected packet loss. If packet loss on the VLAN is
expected to be high, the Robustness Variable should be increased to accommodate
increased packet loss. This entry field allows an entry of 1 to 255. Default = 2.

Last Member Query
Interval

This field specifies the maximum amount of time between group-specific query messages,
including those sent in response to leave group messages. Default = 1.

Host Timeout

This is the maximum amount of time in seconds allowed for a host to continue membership
in a multicast group without the Switch receiving a host membership report. Default = 260.

Router Timeout

This is the maximum amount of time in seconds a route is kept in the forwarding table
without receiving a membership report. Default = 260.

Leave Timer

This specifies the maximum amount of time in seconds between the Switch receiving a
leave group message from a host, and the Switch issuing a group membership query. If no
response to the membership query is received before the Leave Timer expires, the
(multicast) forwarding entry for that host is deleted.

Querier State

Choose Enabled to enable transmitting IGMP Query packets or Disabled to disable. The
default is Disabled.

Querier Router

This read-only field describes the behavior of the router for sending query packets. Querier

Behavior will denote that the router is sending out IGMP query packets. Non-Querier will denote that
the router is not sending out IGMP query packets. This field will only read Querier when the
Querier State and the State fields have been Enabled.

State Select Enabled to implement IGMP Snooping. This field is Disabled by default.

Multicast Fast Leave

This parameter allows the user to enable the Fast Leave function. Enabled, this function will
allow members of a multicast group to leave the group immediately (without the
implementation of the Last Member Query Timer) when an IGMP Leave Report Packet is
received by the Switch. The default is Disabled.

Click Apply to implement the new settings. Click the Show All IGMP Snooping Entries link to return to the Current IGMP
Snooping Group Entries window.

=

NOTE: The Fast Leave function is intended for IGMPv2 users wishing to
leave a multicast group and is best implemented on VLANs that have only
one host connected to each port. When one host of a group of hosts uses
the Fast Leave function, it may cause the inadvertent fast leave of other
hosts of the group.
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Static Router Ports Settings

A static router port is a port that has a multicast router attached to it. Generally, this router would have a connection to a WAN or
to the Internet. Establishing a router port will allow multicast packets coming from the router to be propagated through the

network, as well as allowing multicast messages (IGMP) coming from the network to be propagated to the router.

A router port has the following behavior:

. All IGMP Report packets will be forwarded to the router port.

. IGMP queries (from the router port) will be flooded to all ports.

. All UDP multicast packets will be forwarded to the router port. Because routers do not send IGMP reports or
implement IGMP snooping, a multicast router connected to the router port of a Layer 3 switch would not be able to

receive UDP data streams unless the UDP multicast packets were all forwarded to the router port.

A router port will be dynamically configured when IGMP query packets, RIPv2 multicast, DVMRP multicast or PIM-DM

multicast packets are detected flowing into a port.

Open the IGMP Snooping folder and the click on the Static Router Ports Settings link to open the Static Router Port Settings

window, as shown below.

The Static Router Ports Settings page (shown above) displays all of the current entries to the Switch's static router port table. To

Total Entries:2

1 _
2

defanlt bdodify I
Drarren bdodify i

Figure 7- 14. Static Router Ports Settings window

modify an entry, click the Modify button. This will open the following window:

Static Router Ports Settings

1D 1

default
Member Poris
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Show AL Static Router Ports Entries

Figure 7- 15. Static Router Ports Settings - Edit window

The following parameters can be set:

‘ Parameter Description
VID (VLAN ID) This is the VLAN ID that, along with the VLAN Name, identifies the VLAN where the
multicast router is attached.
VLAN Name This is the name of the VLAN where the multicast router is attached.
Member Ports These are the ports on the Switch that will have a multicast router attached to them.

Click Apply to implement the new settings, Click the Show All Static Router Port Entries link to return to the Current Static

Router Port Entries window.
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Spanning Tree

This Switch supports three versions of the Spanning Tree Protocol; 802.1d STP, 802.1w Rapid STP and MSTP. 802.1d STP will
be familiar to most networking professionals. However, since 802.1w RSTP has been recently introduced to D-Link managed
Ethernet switches, a brief introduction to the technology is provided below followed by a description of how to set up 802.1d STP
and 802.1w RSTP.

802.1w Rapid Spanning Tree

The Switch implements two versions of the Spanning Tree Protocol, the Rapid Spanning Tree Protocol (RSTP) as defined by the
IEEE 802.1w specification and a version compatible with the IEEE 802.1d STP. RSTP can operate with legacy equipment
implementing IEEE 802.1d, however the advantages of using RSTP will be lost.

The IEEE 802.1w Rapid Spanning Tree Protocol (RSTP) evolved from the 802.1d STP standard. RSTP was developed in order to
overcome some limitations of STP that impede the function of some recent switching innovations, in particular, certain Layer 3
functions that are increasingly handled by Ethernet switches. The basic function and much of the terminology is the same as STP.
Most of the settings configured for STP are also used for RSTP. This section introduces some new Spanning Tree concepts and
illustrates the main differences between the two protocols.

Port Transition States

An essential difference between the three protocols is in the way ports transition to a forwarding state and in the way this
transition relates to the role of the port (forwarding or not forwarding) in the topology. RSTP combines the transition states
disabled, blocking and listening used in 802.1d and creates a single state Discarding. In either case, ports do not forward packets.
In the STP port transition states disabled, blocking or listening or in the RSTP port state discarding, there is no functional
difference, the port is not active in the network topology. Table 6-2 below compares how the two protocols differ regarding the
port state transition.

All three protocols calculate a stable topology in the same way. Every segment will have a single path to the root bridge. All
bridges listen for BPDU packets. However, BPDU packets are sent more frequently - with every Hello packet. BPDU packets are
sent even if a BPDU packet was not received. Therefore, each link between bridges is sensitive to the status of the link. Ultimately
this difference results in faster detection of failed links, and thus faster topology adjustment. A drawback of 802.1d is this absence
of immediate feedback from adjacent bridges.

802.1w RSTP 802.1d STP Forwarding Learning
Discarding Disabled No No
Discarding Blocking No No
Discarding Listening No No
Learning Learning No Yes
Forwarding Forwarding Yes Yes

Table 7- 2. Comparing Port States

RSTP is capable of a more rapid transition to a forwarding state - it no longer relies on timer configurations - RSTP compliant
bridges are sensitive to feedback from other RSTP compliant bridge links. Ports do not need to wait for the topology to stabilize
before transitioning to a forwarding state. In order to allow this rapid transition, the protocol introduces two new variables: the
edge port and the point-to-point (P2P) port.

Edge Port

The edge port is a configurable designation used for a port that is directly connected to a segment where a loop cannot be created.
An example would be a port connected directly to a single workstation. Ports that are designated as edge ports transition to a
forwarding state immediately without going through the listening and learning states. An edge port loses its status if it receives a
BPDU packet, immediately becoming a normal spanning tree port.

P2P Port

A P2P port is also capable of rapid transition. P2P ports may be used to connect to other bridges. Under RSTP, all ports operating
in full-duplex mode are considered to be P2P ports, unless manually overridden through configuration.
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802.1d and 802.1w Compatibility

RSTP can interoperate with legacy equipment and is capable of automatically adjusting BPDU packets to 802.1d format when
necessary. However, any segment using 802.1d STP will not benefit from the rapid transition and rapid topology change detection
of RSTP. The protocol also provides for a variable used for migration in the event that legacy equipment on a segment is updated
to use RSTP.

The Spanning Tree Protocol (STP) operates on two levels:
1. On the switch level, the settings are globally implemented.

2. On the port level, the settings are implemented on a per user-defined group of ports basis.

STP LoopBack Prevention

When connected to other switches, STP is an important configuration in consistency for delivering packets to ports and can
greatly improve the throughput of your switch. Yet, even this function can malfunction with the emergence of STP BPDU packets
that occasionally loopback to the Switch, such as BPDU packets looped back from an unmanaged switch connected to the
DES-3028P. To maintain the consistency of the throughput, the DES-3028P now implements the STP LoopBack prevention
function.

When the STP LoopBack Detection function is enabled, the Switch will be protected against a loop occurring between switches.
Once a BPDU packet returns to the Switch, this function will detect that there is an anomaly occurring and will place the receiving
port in an error-disabled state. Consequentially, a message will be placed in the Switch’s Syslog and will be defined there as
“BPDU Loop Back on Port #”.

Setting the LoopBack Timer

The LoopBack timer plays a key role in the next step the switch will take to resolve this problem. Choosing a non-zero value on
the timer will enable the Auto-Recovery Mechanism. When the timer expires, the Switch will again look for its returning BPDU
packet on the same port. If no returning packet is received, the Switch will recover the port as a Designated Port in the Discarding
State. If another returning BPDU packet is received, the port will remain in a blocked state, the timer will reset to the specified
value, restart, and the process will begin again.

For those who choose not to employ this function, the LoopBack Recovery time must be set to zero. In this case, when a BPDU
packet is returned to the Switch, the port will be placed in a blocking state and a message will be sent to the Syslog of the switch.
To recover the port, the administrator must disable the state of the problematic port and enable it again. This is the only method
available to recover the port when the LoopBack Recover Time is set to 0.

Regulations and Restrictions for the LoopBack Detection Function
e All versions of STP (STP and RSTP) can enable this feature.
e  May be configured globally (STP Global Bridge Settings).

e Neighbor switches of the Switch must have the capability to forward BPDU packets. Switches the fail to meet this
requirement will disable this function for the port in question on the Switch.

e The default setting for this function is disabled.
e The default setting for the LoopBack timer is 60 seconds.
o  This setting will only be operational if the interface is STP-enabled.

The LoopBack Detection feature can only prevent BPDU loops on designated ports. It can detect a loop condition occurring on
the user’s side connected to the edge port, but it cannot detect the LoopBack condition on the elected root port of STP on another
switch
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STP Bridge Global Settings

To open the following window, open Spanning Tree in the L2 features folder and click the STP Bridge Global Settings link.

STP Bridge Global Settings

Spanning Tree Protocol Disabled +

Bridge Hello Time (1-10 Sec)
Bridge Forward Delay (4-30 Sec) 15

STP Version RSTR v
TX Hold Count(1-10)
Forwarding BPDTU Enablad +
Loopback Detection Enablad +
LBD Recover Time(0:Disable)
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Figure 7- 16. STP Bridge Global Settings window

The following parameters can be set:

Parameter

Description

Spanning Tree Protocol

Use the pull-down menu to enable or disable STP globally on the Switch. The default is
Disabled.

Bridge Max Age (6 - 40
Sec)

The Max Age may be set to ensure that old information does not endlessly circulate
through redundant paths in the network, preventing the effective propagation of the new
information. Set by the Root Bridge, this value will aid in determining that the Switch has
spanning tree configuration values consistent with other devices on the bridged LAN. If
the value ages out and a BPDU has still not been received from the Root Bridge, the
Switch will start sending its own BPDU to all other switches for permission to become
the Root Bridge. If it turns out that your switch has the lowest Bridge Identifier, it will
become the Root Bridge. The user may choose a time between 6 and 40 seconds. The
default value is 20.

Bridge Hello Time (1 -10
Sec)

The Hello Time can be set from 71 to 70 seconds. This is the interval between two
transmissions of BPDU packets sent by the Root Bridge to tell all other switches that it is
indeed the Root Bridge.

Bridge Forward Delay (4
- 30 Sec)

The Forward Delay can be from 4 to 30 seconds. Any port on the Switch spends this
time in the listening state while moving from the blocking state to the forwarding state.

Max Hops (1-20)

Used to set the number of hops between devices in a spanning tree region before the
BPDU (bridge protocol data unit) packet sent by the Switch will be discarded. Each
switch on the hop count will reduce the hop count by one until the value reaches zero.
The Switch will then discard the BPDU packet and the information held for the port will
age out. The user may set a hop count from 7 to 20. The default is 20.

STP Version

Use the pull-down menu to choose the desired version of STP to be implemented on the

Cuusitalh Thava Ava hain Ahaiann.
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Switch. There are two choices:

STPCompatability - Select this parameter to set the Spanning Tree Protocol (STP)
globally on the switch.

RSTP - Select this parameter to set the Rapid Spanning Tree Protocol (RSTP) globally
on the Switch.

MSTP — Select this parameter to set the Multiple Spanning Tree Protocol (MSTP)
globally on the Switch

TX Hold Count (1-10)

Used to set the maximum number of Hello packets transmitted per interval. The count
can be specified from 7 to 70. The default is 3.

Forwarding BPDU

This field can be Enabled or Disabled. When Enabled, it allows the forwarding of STP
BPDU packets from other network devices. The default is Enabled.

Loopback Detection

This feature is used to temporarily block STP on the Switch when a BPDU packet has
been looped back to the switch. When the Switch detects its own BPDU packet coming
back, it signifies a loop on the network. STP will automatically be blocked and an alert
will be sent to the administrator. The LBD STP port will restart (change to discarding
state) when the Loopback Detection Recover Time times out. The user may enable or
disable this function using the pull-down menu.

LBD Recover Time
(0:Disable)

This field will set the time the STP port will wait before recovering the STP state set. 0
will denote that the LBD will never time out or restart until the administrator personally
changes it. The user may also set a time between 60 and 7000000 seconds. The default
is 60 seconds.

Click Apply to implement changes made.

=

NOTE: The Hello Time cannot be longer than the Max. Age. Otherwise, a

configuration error will occur. Observe the following formulas when setting
the above parameters:

Max. Age < 2 x (Forward Delay - 1 second)

Max. Age = 2 x (Hello Time + 1 second)
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STP Port Settings

STP can be set up on a port per port basis. To view the following window click L2 Features > Spanning Tree > STP Port
Settings:

Fort1 «|Potl % | Enabled + (0 Mo | False » | Auto % | Disabled + | Disabled
T T T T N S I T
1 Auto200000 Mo /Mo Auto f Ves Enahled Enabled
2 Auto200000 2 .-’2 Mo /Mo Auto f Ves Enahled Enabled Nn
3 Auto/200000 253 Mo /Mo Auto f Ves Enahled Enabled Ma
4 Auto/200000 202 Moo Auto fTes Enabled Enabled Mo
5 Auto200000 2172 Ho /Mo Auto f Tes Enabled Enabled Mo
6 Auto/200000 2172 Ho /Mo Auto f Tes Enabled Enabled Mo
7 Auto/200000 2172 Ho /Mo Auto f Tes Enabled Enabled Mo
8 Auto/200000 2172 Ho /Mo Auto [/ Tes Enabled Enabled Mo
9 Auto200000 2172 Ho /Mo Auto f Tes Enabled Enabled Mo
10 Auto/200000 2172 Ho /Mo Auto f Tes Enabled Enabled Mo
11 Auto/200000 2172 Ho /Mo Auto f Tes Enabled Enabled Mo
12 Auto200000 2172 Ho /Mo Auto f Tes Enabled Enabled Mo
13 Auto/200000 2172 Ho /Mo Auto f Tes Enabled Enabled Mo
14 Auto200000 203 Ho /Mo Auto f Tes Enabled Enabled Mo
15 Auto/200000 215 Mo /Mo Auto f Ves Enahled Enabled Ma
14 Auto200000 253 Mo /Mo Auto f Ves Enahled Enabled Ma
17 Auto/200000 273 Mo /Mo Auto f Ves Enahled Enabled Ma
12 Auto200000 2153 Mo /Mo Auto f Ves Enahled Enabled Ma
19 Auto200000 2153 Mo /Mo Auto f Ves Enahled Enabled Ma
20 Auto200000 2153 Mo /Mo Auto f Ves Enahled Enabled Ma
21 Auto/200000 253 Mo /Mo Auto f Ves Enahled Enabled Ma
a2 Auto200000 253 Mo /Mo Auto f Ves Enahled Enabled Ma
23 Auto200000 25 Mo /Mo Auto f Ves Enahled Enabled Ma
24 Auto/200000 202 Mo/ Mo Auto f Tes Enabled Enabled Mo
25 Auto/200000 2172 Ho /Mo Auto f Tes Enabled Enabled Mo
26 Auto/200000 2172 Ho /Mo Auto [/ Tes Enabled Enabled Mo
27 Auto200000 2172 Ho /Mo Auto f Tes Enabled Enabled Mo
28 Auto/200000 2172 Ho /Mo Auto f Tes Enabled Enabled Mo

Figure 7-17. STP Port Settings window

In addition to setting Spanning Tree parameters for use on the switch level, the Switch allows for the configuration of groups of
ports, each port-group of which will have its own spanning tree, and will require some of its own configuration settings. An STP
Group will use the switch-level parameters entered above, with the addition of Port Priority and Port Cost.

An STP Group spanning tree works in the same way as the switch-level spanning tree, but the root bridge concept is replaced with
a root port concept. A root port is a port of the group that is elected based on port priority and port cost, to be the connection to the
network for the group. Redundant links will be blocked, just as redundant links are blocked on the switch level.

The STP on the switch level blocks redundant links between switches (and similar network devices). The port level STP will
block redundant links within an STP Group.

It is advisable to define an STP Group to correspond to a VLAN group of ports.
The following fields can be set:

Parameter Description

From/To A consecutive group of ports may be configured starting with the selected port.

State Toggle from Disabled to Enabled to implement BPDU packet forwarding.

Cost (0 = Auto) External Cost - This defines a metric that indicates the relative cost of forwarding packets
to the specified port list. Port cost can be set automatically or as a metric value. The
default value is 0 (auto).




e 0 (auto) - Setting 0 for the external cost will automatically set the speed for
forwarding packets to the specified port(s) in the list for optimal efficiency.
Default port cost: 100Mbps port = 200000. Gigabit port = 20000.

. value 1-2000000 - Define a value between 1 and 2000000 to determine the
external cost. The lower the number, the greater the probability the port will be
chosen to forward packets.

Hello Time

This can be set from 7 to 70 seconds. This is the interval between two transmissions of
BPDU packets sent by the Root Bridge to tell all other switches that it is indeed the Root
Bridge.

Migrate

Setting this parameter as Yes will set the ports to send out BPDU packets to other
bridges, requesting information on their STP setting If the Switch is configured for RSTP,
the port will be capable to migrate from 802.1d STP to 802.1w RSTP. Migration should be
set as yes on ports connected to network stations or segments that are capable of being
upgraded to 802.1w RSTP on all or some portion of the segment.

Edge

Choosing the True parameter designates the port as an edge port. Edge ports cannot
create loops, however an edge port can lose edge port status if a topology change creates
a potential for a loop. An edge port normally should not receive BPDU packets. If a BPDU
packet is received, it automatically loses edge port status. Choosing the False parameter
indicates that the port does not have edge port status.

P2P

Choosing the True parameter indicates a point-to-point (P2P) shared link. P2P ports are
similar to edge ports, however they are restricted in that a P2P port must operate in full-
duplex. Like edge ports, P2P ports transition to a forwarding state rapidly thus benefiting
from RSTP. A p2p value of false indicates that the port cannot have p2p status. Auto
allows the port to have p2p status whenever possible and operate as if the p2p status
were true. If the port cannot maintain this status, (for example if the port is forced to half-
duplex operation) the p2p status changes to operate as if the p2p value were False. The
default setting for this parameter is True.

BPDU

This field can be Enabled or Disabled. When Enabled, it allows the forwarding of STP
BPDU packets from other network devices. The default is Enabled.

LBD

Use the pull-down menu to enable or disable the loop-back detection function on the
Switch for the ports configured above. For more information on this function, see the STP
LoopBack Prevention section.

Click Apply to implement changes made.

MST Configuration Identification

The following windows in the MST Configuration Identification section allow the user to configure a MSTI instance on the
Switch. These settings will uniquely identify a multiple spanning tree instance set on the Switch. The Switch initially possesses
one CIST or Common Internal Spanning Tree of which the user may modify the parameters for but cannot change the MSTI ID
for, and cannot be deleted. To view the MST Configuration Identification window, click L2 Features > Spanning Tree > MST
Configuration Identification:
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Add

CIsT

MST Configuration Identification

00:50BA:S0:28:00 0

MSTID

MST Configuration Identification Settings
Configuration Name |00:50:BA30:28:00
Revision Level(0-65535) [

1-4094

Apply

Figure 7- 18. MST Configuration ldentification window

The window above contains the following information:

Parameter

Description

Configuration Name

A previously configured name set on the Switch to uniquely identify the MSTI (Multiple
Spanning Tree Instance). If a configuration name is not set, this field will show the MAC
address to the device running MSTP. This field can be set in the STP Bridge Global Set-
tings window.

Revision Level

This value, along with the Configuration Name will identify the MSTP region configured on
the Switch. The user may choose a value between 0 and 65535 with a default setting of 0.

MSTIID This field shows the MSTI IDs currently set on the Switch. This field will always have the
CIST MSTI, which may be configured but not deleted. Clicking the hyperlinked name will
open a new window for configuring parameters associated with that particular MSTI.

VID List This field displays the VLAN IDs associated with the specific MSTI.

Clicking the Add button will reveal the following window to configure:

Instance ID Settings

MSTI ID

VID List (1-4094)

show WMET Confimiration Table

Figure 7- 19. Instance ID Settings window — Add

The user may configure the following parameters to create a MSTI in the Switch.

Parameter Description
MSTI ID Enter a number between 7 and 4 fo set a new MSTI on the Switch.
Type Create is selected to create a new MSTI. No other choices are available for this field when

creating a new MSTI.




VID List (1-4094)

This field is used to specify the VID range from configured VLANs set on the Switch.
Supported VIDs on the Switch range from ID number 1 to 4094.

Click Apply to implement changes made.

To configure the settings for the CIST, click on its hyperlinked name in the MST Configuration Identification window, which
will reveal the following window to configure:

Instance ID Settings
MSTIID 0

VID List (1-4094)

show WMET Confimuration Table

Add VD b

Figure 7- 20. Instance ID Settings window - CIST modify

The user may configure the following parameters to configure the CIST on the Switch.

Parameter Description
MSTIID The MSTI ID of the CIST is 0 and cannot be altered.
Type This field allows the user to choose a desired method for altering the MSTI settings. The user

has 2 choices.

e« Add VID - Select this parameter to add VIDs to the MSTI ID, in conjunction with the
VID List parameter.

e Remove VID - Select this parameter to remove VIDs from the MSTI ID, in con-
junction with the VID List parameter.

VID List (1-4094)

This field is used to specify the VID range from configured VLANs set on the Switch. Supported
VIDs on the Switch range from ID number 7 to 4094. This field is inoperable when configuring
the CIST.

Click Apply to implement changes made.

To configure the parameters for a previously set MSTI, click on its hyperlinked MSTI ID number, which will reveal the following
window for configuration.

Instance ID Settings

o [

show WMET Confimuration Table

Apply |

Figure 7- 21. Instance ID Settings window — modify

The user may configure the following parameters for a MSTI on the Switch.

Parameter

Description

MSTI ID

Displays the MSTI ID previously set by the user.
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Type This field allows the user to choose a desired method for altering the MSTI settings. The

user has four choices.

Add - Select this parameter to add VIDs to the MSTI ID, in conjunction with the
VID List parameter.

Remove - Select this parameter to remove VIDs from the MSTI ID, in con-
junction with the VID List parameter.

VID List (1-4094) This field is

used to specify the VID range from configured VLANs set on the Switch that the

user wishes to add to this MSTI ID. Supported VIDs on the Switch range from ID number 1
to 4094. This parameter can only be utilized if the Type chosen is Add or Remove.

Click Apply to implement changes made.

STP Instance Settings

The following window displays MSTIs currently set on the Switch. To view the following table, click L2 Features > Spanning

Tree > STP Instance Settings:

STP Instance Settings

CIST Enabled
METI( Enabled

32768 bndge prionty : 32768, sys 1D ext: () Mc'dlffs’
32765(bndge priorty : 22768, sys D ext: 1 todify !

Figure 7- 22. STP Instance Settings window

The following information is displayed:

Parameter Description

Instance Type Displays the instance type(s) currently configured on the Switch. Each instance type is classified

by a MSTI ID. CIST refers to the default MSTI configuration set on the Switch.

Instance Status Displays the current status of the corresponding MSTI ID

Instance Priority | Displays the priority of the corresponding MSTI ID. The lowest priority will be the root bridge.

Click Apply to implement changes made.

Click the Modify button to change the priority of the MSTI. This will open the Instance ID Settings window to configure.

Instance ID Settings
MSTIID I

Apply ]

show STP Instance Table
Figure 7- 23. Instance ID Settings - modify priority window
The following parameters can be viewed or set:
Parameter Description
MSTI ID Displays the MSTI ID of the instance being modified. An entry of 0 in this field denotes the
CIST (default MSTI).
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Type

The Type field in this window will be permanently set to Set Priority Only.

Priority (0-61440)

Enter the new priority in the Priority field. The user may set a priority value between 0-
61440.

Click Apply to implement the new priority setting.

MSTP Port Information

This window displays the current MSTP Port Information and can be used to update the port configuration for an MSTI ID. If a
loop occurs, the MSTP function will use the port priority to select an interface to put into the forwarding state. Set a higher
priority value for interfaces to be selected for forwarding first. In instances where the priority value is identical, the MSTP
function will implement the lowest MAC address into the forwarding state and other interfaces will be blocked. Remember that
lower priority values mean higher priorities for forwarding packets. To view the following window, click L2 Features >
Spanning Tree > MSTP Port Information:

DA

M1
0

Pat1 v

MSTP Port Information-Port 1

MSTI [Designated Bridge Internal Path Cost  [Priority [Status ~ |Role |

200000 128 Dizabled Dizabled

Figure 7- 24. MSTP Port Information window

To view the MSTI settings for a particular port, select the Port number, located in the top left hand corner of the window and click
Apply. To modify the settings for a particular MSTT Instance, click on its hyperlinked MSTI ID, which will reveal the following

window.

Priority

MSTI Settings-Port 1
Instance ID
Internal cost{0=Auto) 200000

show METE Port Information Table-Fort 1

0

128

Figure 7- 25. MSTI Settings window

The following parameters can be viewed or set:

Parameter

Description

Instance ID

Displays the MSTI ID of the instance being configured. An entry of 0 in this field denotes the
CIST (default MSTI).

Internal cost
(0=Auto)

This parameter is set to represent the relative cost of forwarding packets to specified ports
when an interface is selected within a STP instance. The default setting is 0 (auto). There are
two options:

e 0 (auto) - Selecting this parameter for the internalCost will set quickest route
automatically and optimally for an interface. The default value is derived from the
media speed of the interface.
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. value 1-2000000 - Selecting this parameter with a value in the range of 7 to
2000000 will set the quickest route when a loop occurs. A lower Internal cost
represents a quicker transmission.

Priority Enter a value between 0 and 240 to set the priority for the port interface. A higher priority will
designate the interface to forward packets first. A lower number denotes a higher priority.

Click Apply to implement changes made.
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Section 8

CoS

Port Bandwidth

802.1p Default Priority

802.1p User Priority

CoS Scheduling Mechanism
CoS Output Scheduling
Priority Settings

TOS Priority Settings

DSCRP Priority Settings

Port Mapping Priority Settings
MAC Priority

The Switch supports 802.1p priority queuing Quality of Service. The following section discusses the implementation of CoS
(Quality of Service) and benefits of using 802.1p priority queuing.

Understanding IEEE 802.1p Priority

Priority tagging is a function defined by the IEEE 802.1p standard designed to provide a means of managing traffic on a network
where many different types of data may be transmitted simultaneously. It is intended to alleviate problems associated with the
delivery of time critical data over congested networks. The quality of applications that are dependent on such time critical data,
such as video conferencing, can be severely and adversely affected by even very small delays in transmission.

Network devices that are in compliance with the IEEE 802.1p standard have the ability to recognize the priority level of data
packets. These devices can also assign a priority label or tag to packets. Compliant devices can also strip priority tags from
packets. This priority tag determines the packet's degree of expeditiousness and determines the queue to which it will be assigned.

Priority tags are given values from 0 to 7 with 0 being assigned to the lowest priority data and 7 assigned to the highest. The
highest priority tag 7 is generally only used for data associated with video or audio applications, which are sensitive to even slight
delays, or for data from specified end users whose data transmissions warrant special consideration.

The Switch allows you to further tailor how priority tagged data packets are handled on your network. Using queues to manage
priority tagged data allows you to specify its relative priority to suit the needs of your network. There may be circumstances where
it would be advantageous to group two or more differently tagged packets into the same queue. Generally, however, it is rec-
ommended that the highest priority queue, Queue 3, be reserved for data packets with a priority value of 7. Packets that have not
been given any priority value are placed in Queue 0 and thus given the lowest priority for delivery.

A weighted round robin system is employed on the Switch to determine the rate at which the queues are emptied of packets. The
ratio used for clearing the queues is 4:1. This means that the highest priority queue, Queue 3, will clear 4 packets for every 1
packet cleared from Queue 0.

Remember, the priority queue settings on the Switch are for all ports, and all devices connected to the Switch will be affected.
This priority queuing system will be especially beneficial if your network employs switches with the capability of assigning
priority tags.

Advantages of CoS

CoS is an implementation of the IEEE 802.1p standard that allows network administrators a method of reserving bandwidth for
important functions that require a large bandwidth or have a high priority, such as VolP (voice-over Internet Protocol), web
browsing applications, file server applications or video conferencing. Not only can a larger bandwidth be created, but other less
critical traffic can be limited, so excessive bandwidth can be saved. The Switch has separate hardware queues on every physical
port to which packets from various applications can be mapped to, and, in turn prioritized. View the following map to see how the
Switch implements basic 802.1P priority queuing.
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Implementation of CoS 802.1p Priority Tagging

CoS
Class 3
CoS
Class 2

CoS
Priority

Packets without CoS tags
will be forwarded to the
CoS class based on the

CoS 802.1p default priority

set per individual port.

Incoming packets tagged
with the CoS priorities 0-7 |
will be forwarded to the CoJ
Class as shown above.

42 6 10 W 1822 26

E T NGB waE &
8

Figure 8- 1. An Example of the Default CoS Mapping on the Switch

The picture above shows the default priority setting for the Switch. Class-3 has the highest priority of the four priority classes of
service on the Switch. In order to implement CoS, the user is required to instruct the Switch to examine the header of a packet to
see if it has the proper identifying tag. Then the user may forward these tagged packets to designated classes of service on the
Switch where they will be emptied, based on priority.

For example, lets say a user wishes to have a video conference between two remotely set computers. The administrator can add
priority tags to the video packets being sent out, utilizing the Access Profile commands. Then, on the receiving end, the
administrator instructs the Switch to examine packets for this tag, acquires the tagged packets and maps them to a class queue on
the Switch. Then in turn, the administrator will set a priority for this queue so that will be emptied before any other packet is
forwarded. This results in the end user receiving all packets sent as quickly as possible, thus prioritizing the queue and allowing
for an uninterrupted stream of packets, which optimizes the use of bandwidth available for the video conference.

Understanding CoS

The Switch has four priority classes of service. These priority classes of service are labeled as 3, the high class to 0, the lowest
class. The eight priority tags, specified in IEEE 802.1p are mapped to the Switch's priority classes of service as follows:

e Priority 0 is assigned to the Switch's Q1 class.
e  Priority 1 is assigned to the Switch's QO class.
e  Priority 2 is assigned to the Switch's QO class.
e Priority 3 is assigned to the Switch's Q1 class.
e  Priority 4 is assigned to the Switch's Q2 class.
e Priority 5 is assigned to the Switch's Q2 class.
e  Priority 6 is assigned to the Switch's Q3 class.
. Priority 7 is assigned to the Switch's Q3 class.
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For strict priority-based scheduling, any packets residing in the higher priority classes of service are transmitted first. Multiple
strict priority classes of service are emptied based on their priority tags. Only when these classes are empty, are packets of lower
priority transmitted.

For weighted round-robin queuing, the number of packets sent from each priority queue depends upon the assigned weight. For a
configuration of eight CoS queues, A~H with their respective weight value: 8~1, the packets are sent in the following sequence:
Al, Bl1, Cl1, D1, El, F1, G1, H1, A2, B2, C2, D2, E2, F2, G2, A3, B3, C3, D3, E3, F3, A4, B4, C4, D4, E4, A5, B3, C5, D5, A6,
B6, C6, A7,B7, A8, Al, B1, C1, D1, El, F1, G1, H1.

For weighted round-robin queuing, if each CoS queue has the same weight value, then each CoS queue has an equal opportunity
to send packets just like round-robin queuing.

For weighted round-robin queuing, if the weight for a CoS is set to 0, then it will continue processing the packets from this CoS
until there are no more packets for this CoS. The other CoS queues that have been given a nonzero value, and depending upon the
weight, will follow a common weighted round-robin scheme.

Remember that the Switch has four configurable priority queues (and four Classes of Service) for each port on the Switch.
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Port Bandwidth

The bandwidth control settings are used to place a ceiling on the transmitting and receiving data rates for any selected port. In the
L2 Features folder, click CoS > Port Bandwidth, to view the window shown below.

Fortl  » | Port1 % | Both % | |Disahled | |64 Apply

Port Bandwidth Table

Port

1 Mo Lirmit Mo Lt
i e Lt Mo Lt
3 Mo Limit Mo Lt
4 Mo Litnit Mo Lt
3 e Lt Mo Lt
) Mo Litnit Mo Lt
7 e Lt Mo Lt
8 Mo Limit Mo Lt
9 Mo Limnit Mo Lt
10 Mo Limit Mo Lt
11 Mo Litnit Mo Lt
12 e Lt Mo Lt
1z Mo Litnit Mo Lt
14 e Lt Mo Lt
15 Mo Limit Mo Lt
16 Mo Litnit Mo Lt
17 Mo Limit Mo Lt
15 Mo Litnit Mo Litmt
18 e Lt Mo Lt
20 Mo Limit Mo Lt
21 e Lt Mo Lt
22 Mo Limit Mo Lt
23 Mo Litnit Mo Lt
24 Mo Lt Mo Lt
25 Mo Litnit Mo Lt
26 e Linit Mo Lt
27 Mo Limit Mo Lt
28 e Lt Mo Lt

Note: To perform precise bandwidth control, it 15 required to enable the flow
control to rmitigate the retranswmssion of TCP traffic.

Figure 8- 2. Port Bandwidth window

The following parameters can be set or are displayed:

Parameter Description
From/To A consecutive group of ports may be configured starting with the selected port.
Type This drop-down menu allows you to select between RX (receive,) TX (transmit,) and Both.

This setting will determine whether the bandwidth ceiling is applied to receiving, transmitting,
or both receiving and transmitting packets.

No Limit This drop-down menu allows you to specify that the selected port will have no bandwidth
limit. Enabled disables the limit.

Rate This field allows you to enter the data rate, in Kbit/s, that will be the limit for the selected
port. The user may choose a rate between 64 and 1024000 Kbit/s.
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Click Apply to set the bandwidth control for the selected ports. Results of configured Bandwidth Settings will be displayed in
the Port Bandwidth Table.

802.1p Default Priority

The Switch allows the assignment of a default 802.1p priority to each port on the Switch. In the CoS folder, click 802.1p Default
Priority, to view the window shown below.

B802.1p Default Priority

=

[-]
i
I

[-]

priory
Potl + Potl v 0w pply

B802.1p Default Priority Table
or

\CIDOH\JO\LJ\J&L_AJI\J»—AI

—
I
o O O o O O O O O O O O o o O O O O o o o o O O o o o o

Figure 8- 3. 802.1p Default Priority window

This window allows you to assign a default 802.1p priority to any given port on the Switch. The priority tags are numbered from
0, the lowest priority, to 7, the highest priority. To implement a new default priority choose a port range by using the From and
To pull-down menus and then insert a priority value, from 0 to 7 in the Priority field. Click Apply to implement your settings.
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802.1p User Priority

When using 802.1p priority mechanism, the packet is examined for the presence of a valid 802.1p priority tag. If the tag is present,
the packet is assigned to a programmable egress queue based on the value of the tagged priority. The tagged priority can be
designated to any of the available queues.

The Switch allows the assignment of a class of service to each of the 802.1p priorities. In the CoS folder, click 802.1p User
Priority to view the window shown below.

B02.1p User Priority

Clags-1 »
Class-0 «
Class-0 +
Class-1 »

Clagg-2 +

IEHEEEE
L
B | W R =] O

5 Class-2 +

7
g
Lh

Class-3 +

3E
i
-1 | @

Class-3 »

Figure 8- 4. 802.1p User Priority window

Once you have assigned a priority to the port groups on the Switch, you can then assign this Class to each of the four levels of
802.1p priorities. Click Apply to set your changes.

CoS Scheduling Mechanism

This drop-down menu allows you to select between a Weight Fair and a Strict mechanism for emptying the priority classes. In
the CoS folder, click CoS Scheduling Mechanism, to view the window shown below.

CoS Scheduling Mechanism
Scheduling Mechanism Strict v

CoS Scheduling Mechanism Table

Class ID Mechanism
Class-0 Weight Fair
Class-1 Weight Fair
Class-2 Weight Fair
Class-3 Stoct

Note: The stnict mode 15 only supported at the highest queue and the other lower queues
will still worle at WEE mode.

Figure 8- 5. CoS Scheduling Mechanism and CoS Scheduling Mechanism Table window

NOTICE: The default CoS scheduling arrangement is a strict priority schedule for the

(' highest class (Class-3) which means the Switch will consider the highest class of
service to have strict scheduling only, while the other queues empty in a round-robin
method.

1

=)
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The Scheduling Mechanism has the following parameters.

Parameter Description

Strict Denoting a Strict scheduling will set the highest queue to be emptied first while the other
queues will follow the weighted round-robin scheduling scheme.

Weight Fair Use the weighted round-robin (WRR) algorithm to handle packets in an even distribution in
priority classes of service.

Click Apply to let your changes take effect.

CoS Output Scheduling

CoS can be customized by changing the output scheduling used for the hardware classes of service in the Switch. As with any
changes to CoS implementation, careful consideration should be given to how network traffic in lower priority classes of service
is affected. Changes in scheduling may result in unacceptable levels of packet loss or significant transmission delay. If you choose
to customize this setting, it is important to monitor network performance, especially during peak demand, as bottlenecks can
quickly develop if the CoS settings are not suitable. In the CoS folder, click CoS Output Scheduling, to view the window shown
below.

CoS Output Scheduling
Class ID
Class-0

Class-1
Class-2
Class-3

E.LMI

Apply

Figure 8- 6. CoS Output Scheduling window
Click Apply to implement changes made.
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Priority Settings

The Priority Setting window will allow users to configure the CoS priority settings on a port per port basis. When CoS tagged
packets arrive on the switch, they are mapped to the settings configured here. For example, if a port has been assigned a MAC
priority, the packet that has the CoS priority assigned to a MAC address will be sent to the CoS queue configured for that MAC
address. Once the configuration has been completed, users may see the results in the Priority Settings Table seen here. After
configuring the port priorities, users may adjust the individual CoS settings on the other windows located in the CoS folder of the
Switch.

In the CoS folder, click Priority Settings, to view the window shown below:

FPort1 » Part1 Mone b4
1 off 202 1p off
2 off =202 1p off
3 off B202 1p off
4 off 8202 1p off
5 off 802.1p off
) off 802.1p off
7 off 202 1p off
4 off 202 1p off
9 off =202 1p off
10 off 802 1p off
11 off 802 1p off
12 off 802 1p off
13 off 802 1p off
14 off 802 1p off
15 off 802 1p off
16 off 802 1p off
17 off 802 1p off
18 off 802 1p off
19 off 802 1p off
20 off 802 1p off
21 off 802 1p off
22 off 802 1p off
23 off 802 1p off
24 off 802 1p off
25 off 802 1p off
26 off 802 1p off
27 off 802 1p off
28 off 802 1p off

Figure 8- 7. Priority Settings window

Configure the following Priority Setting parameters:
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Parameter

Description

From/To Users may select a port or group of ports to assign ToS priority settings, based on the following
Main Select field.
Main Select Select the general priority settings for the ports previously stated using the pull-down menu.

Priority option include:

None — Choosing this option will clear the selected ports form having CoS priority
settings.

Port Mapping — Choosing this option will assign ports to map CoS priorities to individual
ports.

802.1p - Choosing this option will assign ports to map CoS priorities to 802.1p priorities.
This is the default setting for all ports.

MAC-Base - Choosing this option will assign ports to map CoS priorities to MAC
addresses.

TOS - Choosing this option will assign ports to map CoS priorities to ToS priorities.
DSCP - Choosing this option will assign ports to map CoS priorities to DSCP priorities.

Click Apply to implement changes made.

TOS Priority Settings

When using the TOS/DSCP priority mechanism, the packet is classified based on the TOS/DSCP field in the IP header. If the tag
is present, the packet is assigned to a programmable egress queue based on the value of the tagged priority. The tagged priority
can be designated to any of the available queues. When TOS is set to enable, DSCP cannot be used, and when DSCP is set to

enable, TOS cannot be used.

TOS Priority Settings can be specified on this window. Use the drop-down menus to select a value for TOS and Class ID.

In the CoS folder, click TOS Priority Settings, to view the window shown below:

TOS Priority Settings

=
=
< B

The Port Priority Table

uc]
o
[+ ]

----|

=1 Shnoh B o —

0 v

Class

Figure 8- 8. TOS Priority Settings window

Click Apply to implement changes made.
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DSCP Priority Settings

When using the DSCP/TOS priority mechanism, the packet is classified based on the DSCP/TOS field in the IP header. If the tag
is present, the packet is assigned to a programmable egress queue based on the value of the tagged priority. The tagged priority
can be designated to any of the available queues. When a packet is received containing this DSCP tag, it will be mapped to the
CoS queue configured here. These settings will only take effect if at least one of the priority settings per port is configured for
DSCP.When DSCP is set to enable, TOS cannot be used, and when TOS is set to enable, DSCP cannot be used.

DSCP Priority Settings can be specified on this window. Enter a DSCP value and select a Class ID between 0 and 3.
In the CoS folder, click DSCP Priority Settings, to view the window shown below:

DSCP Priority Settings

T

DSCP Priority Table
DSCP

0
0
0
0
0
0
0
0
0
0
0
0
0
0
0
0
0
17 0
0
0
0
0
0
0
0
0
0
0
0
0
0
0
0
0
0

\."ﬂhm-lnw{\)-|

Figure 8- 9. DSCP Priority Settings window
Click Apply to implement changes made.
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Port Mapping Priority Settings

When using the port-based priority mechanism, the port-based priority (high or low) assigned to each ingress port determines the
egress queue assigned to frames arriving via the given ingress port. The frames will be assigned to either the highest queue or the
lowest queue.

Please note the following limitation exists: port-based CoS only supports mapping to Queue 3.

Port mapping Priority Settings can be specified on this window. Select a port range using the From and To drop-down menus and
select a Class.

In the CoS folder, click Port Mapping Priority Settings, to view the window shown below:

Port Mapping Priority Settings
Class Apply

c
[=]
i
I
o
—_
<

Port1  » Por1

‘
=
[+ ]

Port Mapping Priority Table
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Figure 8- 10. Port Mapping Priority Settings window
Click Apply to implement changes made.
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MAC Priority

When using the MAC Priority mechanism, the packet is classified based on the MAC address field priority in the MAC priority
table entries.

To configure a destination MAC address for a CoS queue, users must adhere to the following steps:

1. Users must first enter a static destination MAC address into the Forwarding Database (FDB) of the switch. To
accomplish this, go to the Unicast Forwarding table in the Forwarding Filtering folder under the Configuration menu
and click on the Unicast Forwarding link, which will display a window for users to enter this information.

2. Once a destination MAC has been added to the FDB, users must then configure the appropriate queue to be mapped to
this destination MAC address, using the following window.

3. Once the previous parameters are set, users should go to the Priority Settings window located in this folder and set the
egress ports on the switch to MAC Priority. These ports must only be set for MAC Priority and not for any other priority
choice. Please be advised that the default priority setting is for 802.1p and users must change the priority to MAC
Priority for this function to work properly. Be sure that the device with this destination MAC address is connected to the
port for which this priority is configured.

In the CoS folder, click MAC Priority, to view the window shown below:

MAC Priority

MAC Adire o> oy

00:00:00:00:00:00 3|~ Apply

MAC Priority Table

MAC Address Class ID

Figure 8- 11. MAC Priority window

Enter the destination MAC Address that you have previously entered into the Unicast Forwarding window, and select a Class
ID where packets containing this destination MAC address will be sent. Click Apply to implement changes made.
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Section 9

ACL

Time Range
Access Profile Table
CPU Interface Filtering

Time Range

The DES-3028/28P/52/52P Switches allow you to configure a time period durring each Access Profile will be active. Use the
window below to name the time range and then specify when the Access Profile that will be configured below will be active.

Houwrs HMMSS) [Eeteer TR End Time 00 ¥|[00 v (00 v
MonDTue (] Wed [] Thu [ Fn [ Sat [] Sun [

Apply |

Total Entries: 0
Time Range Information

Figure 9- 1. Time Range window

Press the Apply button to make the time range current.

Access Profile Table

Access profiles allow you to establish criteria to determine whether or not the Switch will forward packets based on the
information contained in each packet's header.

Creating an access profile is divided into two basic parts. The first is to specify which part or parts of a frame the Switch will
examine, such as the MAC source address or the IP destination address. The second part is entering the criteria the Switch will use
to determine what to do with the frame.

To display the currently configured Access Profiles on the Switch, open the Configuration folder and click on the Access Profile
Table link. This will open the Access Profile Table window, as shown below.

Add

! iy Modity | e
2 Ethernet __E_d_ﬂﬂ_i_fy_’_l x
3 Packet Content Mask _h_ﬂ_'?ﬂ”_}f_l Pl

Figure 9- 2. Access Profile Table window

To add an entry to the Access Profile Table, click the Add Profile button. This will open the Access Profile Configuration
window, as shown below. There are three Access Profile Configuration windows; one for Ethernet (or MAC address-based)
profile configuration, one for IP address-based profile configuration and one for the Packet Content Mask. You can switch
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between the three Access Profile Configuration windows by using the Type drop-down menu. The window shown below is the
Access Profile Configuration window for Ethernet.

a rule created in one profile and a rule created in a different profile. Please read the CLI Reference

ﬁ%& Note: The Profile ID is used for relative priority for an Access Profile should a conflict arise between
o g
{

Manual chapter discussing Access Control List (ACL) Commands.

Type

Access Profile Ethernet Configuration

Profile ID(]1-256)

VLAN
source MAC

Destination MAC

802.1p

Eihernet Type

Show A1 Access Profile Tahle Entries

Ethernet

N NN

Figure 9- 3. Access Profile Configuration window (Ethernet)

The following parameters can be set, for the Ethernet type:

Parameter

Description

Profile ID (1-256)

Type in a unique identifier number for this profile set. The number is used to set the relative
priority for the profile. Priority is set relative to other profiles where the lowest profile ID has
the highest priority. If a conflict occurs among configured access rules, the profile ID
establishes relative priority of the rules. The value can be set from 1 to 256 however there is
a limit to the total number of profiles that can be created.

Type Select profile based on Ethernet (MAC Address), IP address or packet content mask. This
will change the menu according to the requirements for the type of profile.
«  Select Ethernet to instruct the Switch to examine the layer 2 part of each packet
header.
o Select IP to instruct the Switch to examine the IP address in each frame's
header.
o  Select Packet Content Mask to specify a mask to hide the content of the packet
header.
VLAN Selecting this option instructs the Switch to examine the VLAN identifier of each packet
header and use this as the full or partial criterion for forwarding.
Source MAC Enter a MAC address mask for the source MAC address.

Destination MAC

Enter a MAC address mask for the destination MAC address.

802.1p Selecting this option instructs the Switch to examine the 802.1p priority value of each packet
header and use this as the, or part of the criterion for forwarding.
Ethernet Type Selecting this option instructs the Switch to examine the Ethernet type value in each frame's

header.

The window shown below is the Access Profile Configuration window for IP.
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Access Profile IP Configuration

Profile ID(1-256)

=
Source IP Mask ]
Destination IP Mask ]
DSCP ]
0 o
ste pott tmask
dest pott mask
TCF flag mask hit
urg ack psh
st S¥H fin
st pott mask
UpF
dest pott mask

Show A1 Acceas Profile Table Entries

—_

Figure 9- 4. Access Profile Configuration window (IP)

The following parameters can be set, for IP:

Parameter

Description

Profile ID (1-256)

Type in a unique identifier number for this profile set. The number is used to set the relative
priority for the profile. Priority is set relative to other profiles where the lowest profile ID has the
highest priority. If a conflict occurs among configured access rules, the profile ID establishes
relative priority of the rules. The value can be set from 7 to 256 however there is a limit to the
total number of profiles that can be created.

Type Select profile based on Ethernet (MAC Address), IP address or packet content mask. This will
change the menu according to the requirements for the type of profile.
. Select Ethernet to instruct the Switch to examine the layer 2 part of each packet
header.
«  Select IP to instruct the Switch to examine the IP address in each frame's header.
o  Select Packet Content Mask to specify a mask to hide the content of the packet
header.
VLAN Selecting this option instructs the Switch to examine the VLAN part of each packet header and

use this as the, or part of the criterion for forwarding.

Source IP Mask

Enter an IP address mask for the source |IP address.

Destination IP Mask

Enter an IP address mask for the destination |P address.

DSCP

Selecting this option instructs the Switch to examine the DiffServ Code part of each packet
header and use this as the, or part of the criterion for forwarding.
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Protocol

Selecting this option instructs the Switch to examine the protocol type value in each frame's
header. You must then specify what protocol(s) to include according to the following
guidelines:

Select ICMP to instruct the Switch to examine the Internet Control Messages Protocol (ICMP)
field in each frame's header.

Select IGMP to instruct the Switch to examine the Internet Group Management Protocol
(IGMP) field in each frame's header.

Select TCP to use the TCP port number contained in an incoming packet as the forwarding
criterion. Selecting TCP requires that you specify a source port mask and/or a destination port
mask. The user may also identify which flag bits to deny. Flag bits are parts of a packet that
determine what to do with the packet. The user may deny packets by denying certain flag bits
within the packets, by checking the boxes corresponding to the flag bits of the TCP field. The
user may choose between urg (urgent), ack (acknowledgement), psh (push), rst (reset), syn
(synchronize), fin (finish).

e src port mask - Specify a TCP port mask for the source port in hex form (hex 0x0-

0xffff), which you wish to deny.

o dest port mask - Specify a TCP port mask for the destination port in hex form (hex
0x0-0xffff) which you wish to deny.

Select UDP to use the UDP port number contained in an incoming packet as the forwarding
criterion. Selecting UDP requires that you specify a source port mask and/or a destination port
mask.

. src port mask - Specify a TCP port mask for the source port in hex form (hex 0x0-
Oxffff).

e  dest port mask - Specify a TCP port mask for the destination port in hex form (hex
0x0-0xffff).

protocol id mask - Enter a value defining the protocol ID in the packet header to mask. Specify
in hex form (hex 0x0-0xf).

The window shown below is the Access Profile Configuration window for Packet Content Mask.

Access Profile Packet Content Configuration

Profile ID(1-256)  |iI

Offset 16-31

Offset 48-63

Showr & coess Profile Tahle Entries

[] Mlask
[] MMask
[1 Mask
[] MMask
[] Mask

Figure 9- 5. Access Profile Configuration window (Packet Content Mask)
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This screen will aid the user in Switch to mask packet headers beginning with the offset value specified. The following fields are
used to configure the Packet Content Mask:

Parameter

Description

Profile ID (1-256)

Type in a unique identifier number for this profile set. This value can be set from 1 to 256.

Type

Select profile based on Ethernet (MAC Address), IP address or Packet Content Mask. This will
change the menu according to the requirements for the type of profile.

Select Ethernet to instruct the Switch to examine the layer 2 part of each packet
header.

Select IP to instruct the Switch to examine the IP address in each frame's header.

Select Packet Content Mask to specify a mask to hide the content of the packet
header.

Offset

This field will instruct the Switch to mask the packet header beginning with the offset value

specified:

value (0-15) - Enter a value in hex form to mask the packet from the beginning of
the packet to the 16th byte.

value (16-31) — Enter a value in hex form to mask the packet from byte 16 to byte
31.

value (32-47) — Enter a value in hex form to mask the packet from byte 32 to byte
47.

value (48-63) — Enter a value in hex form to mask the packet from byte 48 to byte
63.

value (64-79) — Enter a value in hex form to mask the packet from byte 64 to byte
79.

Click Apply to implement changes made.

To establish the rule for a previously created Access Profile:

In the Configuration folder, click the Access Profile Table link opening the Access Profile Table window. Under the heading
Access Rule, clicking Modify, will open the following window.

Add

Access Rule Tahle

T R S TR T R o

ohow A1 Access Profile Entries

Figure 9- 6. Access Rule Table window

The user may search for the settings of a particular Access ID by entering that ID into the Access ID field above and clicking
Find. The user may display all Access ID entries by clicking the View All Entry button.

To create a new rule set for an access profile click the Add button. A new window is displayed. To remove a previously created
rule, click the corresponding ! button.
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Figure 9- 7. Access Rule Configuration window (IP)

Configure the following Access Rule Configuration settings:

Parameter Description
Profile ID This is the identifier number for this profile set.
Mode Select Permit to specify that the Switch, according to any additional rule, forward the packets

that match the access profile added (see below).

Select Deny to specify that packets that match the access profile are not forwarded by the
Switch and will be filtered.

Access ID (1-256)

Type in a unique identifier number for this access. This value can be set from 1 to 256.

Auto Assign — Checking this field will instruct the Switch to automatically assign an Access
ID for the rule being created.

Type

Selected profile based on Ethernet (MAC Address), IP address or Packet Content Mask.

. Ethernet instructs the Switch to examine the layer 2 part of each packet header.
. IP instructs the Switch to examine the IP address in each frame's header.
N Packet Content Mask instructs the Switch to examine the packet header

Priority (0-7)

This parameter is specified if you want to re-write the 802.1p default priority previously set in
the Switch, which is used to determine the CoS queue to which packets are forwarded to.
Once this field is specified, packets accepted by the Switch that match this priority are
forwarded to the CoS queue specified previously by the user.

For more information on priority queues, CoS queues and mapping for 802.1p, see the QoS
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section of this manual.

VLAN Name

Allows the entry of a name for a previously configured VLAN.

Source IP

Enter an IP Address mask for the source IP address.

Destination IP

Enter an IP Address mask for the destination IP address.

DSCP (0-63) This field allows the user to enter a DSCP value in the space provided, which will instruct the
Switch to examine the DiffServ Code part of each packet header and use this as the, or part
of the criterion for forwarding. The user may choose a value between 0 and 63.

Protocol This field allows the user to modify the protocol used to configure the Access Rule Table;
depending on which protocol the user has chosen, or configured in the Access Profile Table.

Port Number Enter the switch port number(s) to which you wish this rule to apply.

To view the settings of a previously correctly configured rule, click ¥ in the Access Rule Table to view the following window:

Access Rule Display

Show A1 A ccess BEule Entries

Figure 9- 8. Access Rule Display window (IP)

To configure the Access Rule for Ethernet, open the Access Profile Table and click Modify for an Ethernet entry. This will open
the following window:

Add

Access Rule Table

2

elete
Fetmit Packet Content 1 ".I"iewl pg

Show Al A cceas Profile Entries

Figure 9- 9. Access Rule Table window (Ethernet)

The user may search for the settings of a particular Access ID by entering that ID into the Access ID field above and clicking
Find. The user may display all Access ID entries by clicking the Show All Access Profile Entries link.
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To remove a previously created rule, select it and click the *! button. To add a new Access Rule, click the Add button:

paen |

o s oy
() Permat () Deny

ce 56)

1p Priotity U ¥ FxRate(¥o Limit:0)

Auto Assign ]

kbps

Access Rule Ethernet Configuration

'y
F

Show A1 Access Fule Entries

Figure 9- 10. Access Rule Configuration window (Ethernet)

To set the Access Rule for Ethernet, adjust the following parameters and click Apply.

Parameters Description
Profile ID This is the identifier number for this profile set.
Mode Select Permit to specify that the Switch, according to any additional rule, forwards the

packets that match the access profile added (see below).

Select Deny to specify that packets that match the access profile are not forwarded by the
Switch and will be filtered.

Access ID (1-256)

Type in a unique identifier number for this access. This value can be set from 1 - 256.

Auto Assign — Checking this field will instruct the Switch to automatically assign an Access
ID for the rule being created.

Type

Selected profile based on Ethernet (MAC Address), IP address or Packet Content Mask.
. Ethernet instructs the Switch to examine the layer 2 part of each packet header.
. IP instructs the Switch to examine the IP address in each frame's header.

o  Packet Content Mask instructs the Switch to examine the packet header

Priority (0-7)

This parameter is specified if you want to re-write the 802.1p default priority previously set in
the Switch, which is used to determine the CoS queue to which packets are forwarded to.
Once this field is specified, packets accepted by the Switch that match this priority are
forwarded to the CoS queue specified previously by the user.

For more information on priority queues, CoS queues and mapping for 802.1p, see the QoS
section of this manual.

VLAN Name

Allows the entry of a name for a previously configured VLAN.
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Source MAC Enter a MAC Address for the source MAC address.

Destination MAC Enter a MAC Address mask for the destination MAC address.

802.1p (0-7) Enter a value from 0 to 7 to specify that the access profile will apply only to packets with this
802.1p priority value.

Ethernet Type Specifies that the access profile will apply only to packets with this hexadecimal 802.1Q
Ethernet type value (hex 0x0-0xffff) in the packet header. The Ethernet type value may be
set in the form: hex 0x0-0xffff, which means the user may choose any combination of letters
and numbers ranging from a-f and from 0-9999.

Port Number Enter the switch port number(s) to which you wish this rule to apply.

To view the settings of a previously correctly configured rule, click ¥4 in the Access Rule Table to view the following window:

Access Rule Display

1

1
Actions Permdt (Priotity=0, Bx Rate: Ho_Limdt)
Type Ethettiet
VLANMName =0z S
Source RMAC 00-00-00-00-00-00
Destination MAC @ S
s021lp |-

EthernetType =00 EEES

Show A1 Access Fule Entries

Figure 9- 11. Access Rule Display window (Ethernet)

To configure the Access Rule for Packet Content Mask, open the Access Profile Table and click Modify for a Packet Content
Mask entry. This will display the Access Rule Table.

Add

Access Rule Table

T R TR TR o
1 1

elete
Petmit Ethemet "Iul"iewl g

Show A Access Profile Entries

Figure 9- 12. Access Rule Table window (Packet Content Mask)

The user may search for the settings of a particular Access ID by entering that ID into the Access ID field above and clicking
Find. The user may display all Access ID entries by clicking the View All Entry button.
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To remove a previously created rule, select it and click the i button. Access rules are indexed using the Access ID number. To
locate a specific Access Rule in the table, enter the Access ID and click Find. To display all rules in the table, click the View All
Entries button.

To add a new Access Rule, click the Add button above the Access Rule Table window to view the Access Rule Packet Content
Configuration window.

Access Rule Packet Content Configuration

TR

(+) Permit () Dieny
Actions
1p Priotity 0 % RxRate(No Limit:0) khps

Access ID(1-256) Auto Assign [
Type Packet Content

Content Item2 [] offzet Value
Content Itemd [] offzet Value

Comtent ItemS [ ] Offset Value
Portlist

Show A1 4 ccess Bule Entries

Figure 9- 13. Access Rule Packet Content Configuration window

To set the Access Rule for the Packet Content Mask, adjust the following parameters and click Apply.

Parameter Description
Profile ID This is the identifier number for this profile set.
Mode Select Permit to specify that the Switch, according to any additional rule, forwards the packets

that match the access profile added (see below).

Select Deny to specify that packets that match the access profile are not forwarded by the
Switch and will be filtered.

Access ID Type in a unique identifier number between 7 and 256 for this access or use Auto Assign.

Type Selected profile based on Ethernet (MAC Address), IP address or Packet Content Mask.

. Ethernet instructs the Switch to examine the layer 2 part of each packet header.
. IP instructs the Switch to examine the IP address in each frame's header.
. Packet Content Mask instructs the Switch to examine the packet header.

Priority (0-7) This parameter is specified if you want to re-write the 802.1p default priority previously set in the
Switch, which is used to determine the CoS queue to which packets are forwarded to. Once this
field is specified, packets accepted by the Switch that match this priority are forwarded to the
CoS queue specified previously by the user.

For more information on priority queues, CoS queues and mapping for 802.1p, see the QoS
section of this manual.
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Offset This field will instruct the Switch to mask the packet header beginning with the offset value
specified:
e You can specify an offset of between 0 and 76 bytes.
Port Number Enter the switch port number(s) to which you wish this rule to apply.

To view the settings of a previously correctly configured rule, click ¥ in the Access Rule Table to view the following window:

Profile ID

Type

Content Ieml
Content [tem2
Content lem3
Content Iemd
Content liemS

Portlist

Time Range

Access Rule Display

ohow A1 Access Eule Entries

2

1

Petmit (Prictity=0, Bx Rate: Mo Limit)
Packet Content

Offzet ;0 Value : Ox00000000

Figure 9- 14. Access Rule Display window (Packet Content)
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CPU Interface Filtering

Due to a chipset limitation and the need for extra switch security, the DES-30xx switch series incorporates CPU Interface
filtering. This added feature increases the running security of the Switch by enabling the user to create a list of access rules for
packets destined for the Switch’s CPU interface. Employed similarly to the Access Profile feature previously mentioned, CPU
interface filtering examines Ethernet, IP and Packet Content Mask packet headers destined for the CPU and will either forward
them or filter them, based on the user’s implementation. As an added feature for the CPU Filtering, the Switch allows the CPU
filtering mechanism to be enabled or disabled globally, permitting the user to create various lists of rules without immediately
enabling them.

Creating an access profile for the CPU is divided into two basic parts. The first is to specify which part or parts of a frame the
Switch will examine, such as the MAC source address or the IP destination address. The second part is entering the criteria the
Switch will use to determine what to do with the frame. The entire process is described below.

CPU Interface Filtering State

In the following window, the user may globally enable or disable the CPU Interface Filtering mechanism by using the pull-down
menu to change the running state. To access this window, click ACL > CPU Interface Filtering > CPU Interface Filtering
State. Choose Enabled to enable CPU packets to be scrutinized by the Switch and Disabled to disallow this scrutiny.

CPU Interface Filtering State

Figure 9- 15. CPU Interface Filtering State window

CPU Interface Filtering Profile Table

Click ACL > CPU Interface Filtering > CPU Interface Filtering Table to display the CPU Access Profile Table entries created
on the Switch. To view the configurations for an entry, click the hyperlinked Profile ID number.

Al

CPU Interface Filtering Table

Etherniet Fodify I }(.
2 IP todify i g

3 Packet Content hdodify I }(:

Figure 9- 16. CPU Interface Filtering Table window

To add an entry to the CPU Interface Filtering Profile Table window, click the Add button. This will open the CPU Interface
Filtering Profile Configuration window, as shown below. There are three CPU Access Profile Configuration windows; one for
Ethernet (or MAC address-based) profile configuration, one for IP address-based profile configuration and one for the Packet
Content Mask. Users can switch between the three CPU Access Profile Configuration windows by using the Type drop-down
menu. The window shown below is for Ethernet CPU Interface Filtering Configuration.
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CPU Interface Filtering Configuration

Profile ID{1-3) 1

ohow AN CPT Interface Filtering Table Entries

Figure 9- 17. CPU Interface Filtering Configuration window — Ethernet

Parameter Description
Profile ID (1-3) Type in a unique identifier number for this profile set. This value can be set from 1 fo 3.
Type Select profile based on Ethernet (MAC Address), IP address or Packet Content Mask. This will

change the window according to the requirements for the type of profile.
. Select Ethernet to instruct the Switch to examine the layer 2 part of each packet
header.
«  Select IP to instruct the Switch to examine the IP address in each frame's header.

o  Select Packet Content Mask to specify a mask to hide the content of the packet
header.

VLAN Selecting this option instructs the Switch to examine the VLAN identifier of each packet header
and use this as the full or partial criterion for forwarding.

Source MAC Enter a MAC address mask for the source MAC address.

Destination MAC | Enter a MAC address mask for the destination MAC address.

802.1p Selecting this option instructs the Switch to examine 802.1p priority value packets.
Ethernet type Selecting this option instructs the Switch to examine the Ethernet type value in each frame's
header.

Click Apply to set this entry in the Switch’s memory.
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The following is the CPU Interface Filtering Configuration window for IP.

ohow AN CPT Interface Filtering Table Entries

CPU Interface Filtering Configuration
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Figure 9- 18. CPU Interface Filtering Configuration window - IP

The following parameters can be modified:

Parameter

Description

Profile ID (1-3)

Type in a unique identifier number for this profile set. This value can be set from 1 - 3.

Type Select profile based on Ethernet (MAC Address), IP address or Packet Content Mask. This
will change the menu according to the requirements for the type of profile.
. Select Ethernet to instruct the Switch to examine the layer 2 part of each packet
header.
« Select IP to instruct the Switch to examine the IP address in each frame's
header.
«  Select Packet Content Mask to specify a mask to hide the content of the packet
header.
VLAN

Selecting this option instructs the Switch to examine the VLAN part of each packet header
and use this as the criterion, or part of the criterion for forwarding.

Source IP Mask

Enter an IP address mask for the source IP address.

Destination IP Mask

Enter an IP address mask for the destination |P address.

DSCP

Selecting this option instructs the Switch to examine the DiffServ Code part of each packet
header and use this as the, or part of the criterion for forwarding.

Protocol

Selecting this option instructs the Switch to examine the protocol type value in each frame's

header. You must then specify what protocol(s) to include according to the following
guidelines:
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Select ICMP to instruct the Switch to examine the Internet Control Message Protocol (ICMP)
field in each frame's header.

« Select Type to further specify that the access profile will apply an ICMP type
value, or specify Code to further specify that the access profile will apply an
ICMP code value.

Select IGMP to instruct the Switch to examine the Internet Group Management Protocol
(IGMP) field in each frame's header.

« Select Type to further specify that the access profile will apply an IGMP type
value.

Select TCP to use the TCP port number contained in an incoming packet as the forwarding
criterion. Selecting TCP requires that you specify a source port mask and/or a destination
port mask. The user may also identify which flag bits to filter. Flag bits are parts of a packet
that determine what to do with the packet. The user may filter packets by filtering certain flag
bits within the packets, by checking the boxes corresponding to the flag bits of the TCP field.
The user may choose between urg (urgent), ack (acknowledgement), psh (push), rst (reset),
syn (synchronize), fin (finish).
e src port mask - Specify a TCP port mask for the source port in hex form (hex
0x0-0xffff), which you wish to filter.
. dest port mask - Specify a TCP port mask for the destination port in hex form
(hex 0x0-0xffff) which you wish to filter.
Select UDP to use the UDP port number contained in an incoming packet as the forwarding

criterion. Selecting UDP requires that you specify a source port mask and/or a destination
port mask.

. src port mask - Specify a UDP port mask for the source port in hex form (hex
0x0-0xffff).

. dest port mask - Specify a UDP port mask for the destination port in hex form
(hex 0x0-0xffff).

protocol id - Enter a value defining the protocol ID in the packet header to mask. Specify the
protocol ID mask in hex form (hex 0x0-0xff).

Click Apply to set this entry in the Switch’s memory.
The following is the CPU Interface Filtering Configuration window for the Packet Content Mask.

CPU Interface Filtering Configuration

Profile ID{1-3) 1

Offset 0-15 ]

Offset 16-31 ]

Offset 48-63 ]

Offset 64-79 ]

ahow A0 CP Interface Filtering Table Entries

Figure 9- 19. CPU Interface Filtering Configuration window - Packet Content
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This window will aid the user in configuring the Switch to mask packet headers beginning with the offset value specified. The
following fields are used to configure the Packet Content Mask:

Parameter Description
Profile ID (1-3) Type in a unique identifier number for this profile set. This value can be set from 1 fo 3.
Type Select profile based on Ethernet (MAC Address), IP address or Packet Content Mask. This

will change the window according to the requirements for the type of profile.

«  Select Ethernet to instruct the Switch to examine the layer 2 part of each packet

header.
« Select IP to instruct the Switch to examine the IP address in each frame's
header.
«  Select Packet Content Mask to specify a mask to hide the content of the packet
header.
Offset This field will instruct the Switch to mask the packet header beginning with the offset value

specified:
o  value (0-15) — Enter a value in hex form to mask the packet from the beginning
of the packet to the 15th byte.

e  value (16-31) — Enter a value in hex form to mask the packet from byte 16 to
byte 31.

. value (32-47) — Enter a value in hex form to mask the packet from byte 32 to
byte 47.

o  value (48-63) — Enter a value in hex form to mask the packet from byte 48 to
byte 63.

e  value (64-79) — Enter a value in hex form to mask the packet from byte 64 to
byte 79.

Click Apply to implement changes made.
To establish the rule for a previously created CPU Access Profile:
In the ACL folder, click CPU Interface Filtering to open the CPU Interface Filtering Profile Table window.

Add Profile I

Total Rule Entries:0

1
2
4

Ethiernet Maclity | |

IP Modify | ﬂ

Packet Content kAodify | ".r'iewl
Figure 9- 20. CPU Interface Filtering Profile Table window - Add

.4

X

In this window, the user may add a rule to a previously created CPU access profile by clicking the corresponding Modify button
of the entry to configure Ethernet, IP or Packet Content Mask.
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Figure 9- 21. CPU Interface Filtering Rule Table window

Click the Add Profile button to continue on to the CPU Interface Filtering Rule Table window. A new and unique window, for
Ethernet, IP and Packet Content will open as shown in the examples below.

To change a rule for a previously created CPU Access Profile Rule:

The CPU Interface Filtering Rule Configuration window allows the user to create a rule for a previously created CPU Access

Profile.

CPU Interface Filtering Rule Configuration

Access ID(1-5)

Name
Source MAC Q0-00-00-00-00-00
Destination MAC 00-00-00-00-00-00
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Figure 9- 22. CPU Interface Filtering Rule Configuration window — Ethernet

To set the CPU Access Rule for Ethernet, adjust the following parameters and click Apply.

Parameters Description

Profile ID This is the identifier number for this profile set.

Mode Select Permit to specify that the packets that match the access profile are forwarded by the
Switch, according to any additional rule added (see below).
Select Deny to specify that packets that do not match the access profile are not forwarded by the
Switch and will be filtered.

Access ID Type in a unique identifier number for this access and priority. This value can be set from 7 to 5.
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Type Selected profile based on Ethernet (MAC Address), IP address or Packet Content.

. Ethernet instructs the Switch to examine the layer 2 part of each packet header.
« IPinstructs the Switch to examine the IP address in each frame's header.
. Packet Content Mask instructs the Switch to examine the packet header.

VLAN Name Allows the entry of a name for a previously configured VLAN.

Source MAC Enter a MAC Address for the source MAC address.

Destination Enter a MAC Address mask for the destination MAC address.

MAC

802.1P (0-7) Enter a value from 0-7 to specify that the access profile will apply only to packets with this 802.1p
priority value.

Ethernet Type Specifies that the access profile will apply only to packets with this hexadecimal 802.1Q Ethernet
type value (hex 0x0-0xffff) in the packet header. The Ethernet type value may be set in the form:
hex O0x0-Oxffff, which means the user may choose any combination of letters and numbers
ranging from a-f and from 0-9.

Port The CPU Access Rule may be configured on a per-port basis by entering the port number of the

Switch.

Time Range

Click the check box and enter the name of the Time Range settings that has been previously
configured in the Time Range window. This will set specific times when this CPU access rule will
be implemented on the Switch.

To view the settings of a previously configured rule, click ﬂ in the Access Rule Table to view the following window:

CPU Interface Filtering Entry Display
FProfile ID 1

Type

Source Mac

Destination Mac
02.1p

Ethernet Type

chow All CPTT Interface Filtenng Table Entries

Ethernet

Figure 9- 23. CPU Interface Filtering Entry Display window — Ethernet

The following window is the CPU Interface Filtering Rule Table for IP.
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Figure 9- 24. CPU Interface Filtering Rule Table window — IP

To create a new rule set for an access profile click the Add button. A new window is displayed. To remove a previously created

rule, click the corresponding # button. The following window is used for the CPU IP Rule configuration.

CPU Interface Filtering Rule Configuration

@ Permit O Deny

—_

Access ID(1-5)

3
B

HHHEEEEE
ANk 5
A

q 4]

0.0.0.0
0.0.0.0

Time Range

show AN CFTT Interface Filtenng Fule Entries

3
=
S

Figure 9- 25. CPU Interface Filtering Rule Configuration window — IP

Configure the following Access Rule Configuration settings for IP:

Parameter Description
Profile ID This is the identifier number for this profile set.
Mode Select Permit to specify that the packets that match the access profile are forwarded by the

Switch, according to any additional rule added (see below).

Switch and will be filtered.

Select Deny to specify that packets that do not match the access profile are not forwarded by the

Access ID Type in a unique identifier number for this access and priority. This value can be set from 7 to 5.

Type Selected profile based on Ethernet (MAC Address), IP address or Packet Content.

. Ethernet instructs the Switch to examine the layer 2 part of each packet header.
. IP instructs the Switch to examine the IP address in each frame's header.
. Packet Content Mask instructs the Switch to examine the packet header.
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VLAN Name

Allows the entry of a name for a previously configured VLAN.

Source IP

Enter an IP Address mask for the source IP address.

Destination IP

Enter an IP Address mask for the destination IP address.

Dscp (0-63) This field allows the user to enter a DSCP value in the space provided, which will instruct the
Switch to examine the DiffServ Code part of each packet header and use this as the, or part of
the criterion for forwarding. The user may choose a value between 0 and 63.

Port The CPU Access Rule may be configured on a per-port basis by entering the port number of the

Switch.

Time Range

Click the check box and enter the name of the Time Range settings that has been previously
configured in the Time Range window. This will set specific times when this CPU access rule will
be implemented on the Switch.

To view the settings of a previously correctly configured rule, click EI in the Access Rule Table to view the following window:

CPU Interface Filtering Entry Display

Profile ID

Type
Vlan

source IP WMask
Destination IP Mask
Dscp

Protocol

Ehow AL CFPTT Interface Filtering Table Entries

Figure 9- 26. CPU Interface Filtering Entry Display window - IP

The following window is the CPU Interface Filtering Rule Table for Packet Content.

Add Rule i

CPU Interface Filtering Rule Table

Permit  Paclet Content View X

chow AN CPTT Intetface Fitenns Entries

Figure 9- 27. CPU Interface FiItering Rule Table window — Packet Content
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CPU Interface Filtering Rule Configuration

e |

]
Offset 16-31 .
[]
Offset 48-63 =
]

chow AL CPU Interface Filtering Bule Entries

Apply

Figure 9- 28. CPU Interface Filtering Rule Configuration window - Packet Content Mask

To set the Access Rule for Ethernet, adjust the following parameters and click Apply.

Parameters Description
Profile ID This is the identifier number for this profile set.
Mode Select Permit to specify that the packets that match the access profile are forwarded by the
Switch, according to any additional rule added (see below).
Select Deny to specify that packets that do not match the access profile are not forwarded by
the Switch and will be filtered.
Access ID Type in a unique identifier number for this access. This value can be set from 1 fo 5.
Type Selected profile based on Ethernet (MAC Address), IP address or Packet Content.
. Ethernet instructs the Switch to examine the layer 2 part of each packet header.
. IP instructs the Switch to examine the IP address in each frame's header.
N Packet Content Mask instructs the Switch to examine the packet header.
Offset This field will instruct the Switch to mask the packet header beginning with the offset value

specified:
. value (0-15) - Enter a value in hex form to mask the packet from the beginning of
the packet to the 15th byte.

. value (16-31) - Enter a value in hex form to mask the packet from byte 16 to byte
31.

. value (32-47) - Enter a value in hex form to mask the packet from byte 32 to byte
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47.
o value (48-63) - Enter a value in hex form to mask the packet from byte 48 to byte

63.
. value (64-79) - Enter a value in hex form to mask the packet from byte 64 to byte
79.
Port The CPU Access Rule may be configured on a per-port basis by entering the port number of the
Switch.
Time Range Click the check box and enter the name of the Time Range settings that has been previously

configured in the Time Range window. This will set specific times when this CPU access rule
will be implemented on the Switch.

To view the settings of a previously correctly configured rule, click EI in the Access Rule Table to view the following window:

Offset 0-15
Offset1s-31 2 2220202020222 |[SESESSEER
Offset 32-47

Offset48-63 22222222 |NESEES

CPU Interface Filtering Rule Display
Profile ID
Access ID

-

1

1

Perrnit

Packet Content

0z00000000 0200000000 0x00000000 000000000

Offset64-79 EEEEEEEEE

Port
ot

show Al CPTT Interface Filtering Fule Entries

Figure 9- 29. CPU Interface Filtering Rule Display window — Packet Content
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Section 10

Security

Traffic Control

Port Security

Port Lock Entries

SSL

SSH

802.1X

Trusted Host

Access Authentication Control

Traffic Segmentation

Traffic Control

On a computer network, packets such as Multicast packets and Broadcast packets continually flood the network as normal
procedure. At times, this traffic may increase do to a malicious endstation on the network or a malfunctioning device, such as a
faulty network card. Thus, switch throughput problems will arise and consequently affect the overall performance of the switch
network. To help rectify this packet storm, the Switch will monitor and control the situation.

The packet storm is monitored to determine if too many packets are flooding the network, based on the threshold level provided
by the user. Once a packet storm has been detected, the Switch will drop packets coming into the Switch until the storm has
subsided. This method can be utilized by selecting the Drop option of the Action field in the window below.

The Switch will also scan and monitor packets coming into the Switch by monitoring the Switch’s chip counter. This method is
only viable for Broadcast and Multicast storms because the chip only has counters for these two types of packets. Once a storm
has been detected (that is, once the packet threshold set below has been exceeded), the Switch will shutdown the port to all
incoming traffic with the exception of STP BPDU packets, for a time period specified using the CountDown field.

Traffic Control Recover

a1 v Pl «

Traffic Trap Configuration

Traffic Trap MNone v Apply

Z

Traffic Control Settings

o Jto[ocosenst e [prr Jevina i [oomtDom et it
5 5

Port1 | Port1 | Disabled v | Disabled || Disabled v 128 Drop v Apply

Traffic Control Table

Port Broadcast  [Multicast DLF Threshald Acion S  |fnterval [Forover
Kbitisec) Dovn
54 o

1 Disabled Disabled Disabled Drop 5
2 Disabled Disabled Disabled 64 Drop 0 5
3 Disabled Disabled Disabled 64 Drop ] 5
4 Disabled Disabled Disabled 64 Drop 0 5
5 Disabled Disabled Disabled 64 Drop 0 5
& Disabled Disabled Disabled 64 Drop 0 5
7 Disabled Disabled Disabled 64 Drop ] 5
8 Disabled Disabled Disabled 64 Drop ] 5
El Disabled Disabled Disabled 64 Drop 0 5
10 Disabled Disabled Disabled 64 Drop 0 5
11  Disabled Disabled Disabled 64 Drop 0 5
12 Disabled Disabled Disabled 64 Drop ] 5
13 Disabled Disabled Disabled 64 Drop 0 5
14 Disabled Disabled Disabled 64 Drop 0 5
15  Disabled Disabled Disabled 64 Drop 0 5
16  Disabled Disabled Disabled 64 Drop ] 5
17 Disabled Disabled Disabled 64 Drop ] 5
18  Disabled Disabled Disabled 64 Drop 0 5
19 Disabled Disabled Disabled 64 Drop 0 5
20  Disabled Disabled Disabled 64 Drop 0 5
21 Disabled Disabled Disabled 64 Drop ] 5
22 Disabled Disabled Disabled 64 Drop 0 5

Figure 10- 1. Traffic Control Settings window
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If this field times out and the packet storm continues, the port will be placed in a Shutdown Forever mode which will produce a
warning message to be sent to the Trap Receiver. Once in Shutdown Forever mode, the only method of recovering this port is to
manually recoup it using the Port Configuration window in the Administration folder and selecting the disabled port and
returning it to an Enabled status. To utilize this method of Storm Control, choose the Shutdown option of the Action field in the
window below. To view this window to configure Traffic Control, click Security > Traffic Control.

The user may set the following parameters:

Parameter Description
Traffic Control Recover
From... To Select the ports to be recovered.
Traffic Trap Configuration
Traffic Trap Enable sending of Storm Trap messages when the type of action taken by the Traffic Control
function in handling a Traffic Storm is one of the following:
. None — Will send no Storm trap warning messages regardless of action taken by the
Traffic Control mechanism.
e  Storm Occurred — Will send Storm Trap warning messages upon the occurrence of
a Traffic Storm only.
. Storm Cleared — Will send Storm Trap messages when a Traffic Storm has been
cleared by the Switch only.
e Both — Will send Storm Trap messages when a Traffic Storm has been both
detected and cleared by the Switch.
This function cannot be implemented in the Hardware mode. (When Drop is chosen in the
Action field.
Traffic Control Settings
From...To Select the ports of this Switch to configure for Storm Control.
Broadcast Enables or disable Broadcast Storm Control.
Multicast Enables or disables Multicast Storm Control.
DLF Enables or disables Destination Lookup Failure (DLF) storm control. (Not available for Software
based Traffic Control {Shutdown}).
Threshold Specifies the maximum number of packets per second that will trigger the Traffic Control function
to commence.
Action Select the method of traffic Control from the pull down menu. The choices are:

Drop — Utilizes the hardware Traffic Control mechanism, which means the Switch’s hardware will
determine the Packet Storm based on the Threshold value stated and drop packets until the issue
is resolved.

Shut Down — Utilizes the Switch’s software Traffic Control mechanism to determine the Packet
Storm occurring. Once detected, the port will deny all incoming traffic to the port except STP
BPDU packets, which are essential in keeping the Spanning Tree operational on the Switch. If the
Countdown timer has expired and yet the Packet Storm continues, the port will be placed in
Shutdown Forever mode and is no longer operational until the user manually resets the port using
the Storm Control Recover setting at the top of this window. Choosing this option obligates the
user to configure the Interval setting as well, which will provide packet count samplings from the
Switch’s chip to determine if a Packet Storm is occurring.

Count Down

The Count Down timer is set to determine the amount of time, in minutes, that the Switch will wait
before shutting down the port that is experiencing a traffic storm. This parameter is only useful for
ports configured as Shutdown in their Action field and therefore will not operate for Hardware
based Traffic Control implementations. The possible time settings for this field are 0, 5-30
minutes. 0 denotes that the port will never shutdown.

Interval

The Interval will set the time between Multicast and Broadcast packet counts sent from the
Switch’s chip to the Traffic Control function. These packet counts are the determining factor in
deciding when incoming packets exceed the Threshold value. The Interval may be set between 5
and 30 seconds with the default setting of 5 seconds.
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Click Apply to implement the settings made.

NOTE: Traffic Control cannot be implemented on ports that are set for
i Link Aggregation (Port Trunking).
-

Discarding in Spanning Tree windows and implementations though these

é%’ NOTE: Ports that are in the Shutdown forever mode will be seen as
L ports will still be forwarding BPDUs to the Switch’s CPU.

%
NOTE: Ports that are in Shutdown Forever mode will be seen as link down
in all windows and screens until the user recovers these ports.

.
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Port Security

A given ports’ (or a range of ports') dynamic

Port Security

MAC address learming co be locked such that | D
the current source MAC addresses entered m--
into the MAC address forwarding table can |[Port1 ~[[Part1 | Disabled v DeleteOnTimeout
not be changed once the port lock is enabled.

port. Dizahled DeleteOnTimeout
Digabled DeleteOnTimeout
Disahled DeleteOnTime ot
Digabled DeleteOnTimeout
Disahled DeleteOnTime ot
Dizabled DeleteOnTimeout
Disabled DeleteOnTimeout
Dizabled DeleteOnTimeout
Disabled DeleteOnTimeout

Port Security is a security feature that prevents
unauthorized computers (with source MAC
addresses) unknown to the Switch prior to
locking the port (or ports) from connecting to
the Switch's locked ports and gaining access to
the network. To view the following window,
open the Security folder and click Port

\Doou-lmu.&.mm.—-l

1

1

1

1

1

1

1

1

1
. 10 Dizabled 1 DeleteOnTimeout
Security. 11 Dissbled 1 DieletsOnTimeout
12 Disahled 1 DeleteOnTime ot
13 Digabled 1 DeleteOnTimeout
14 Dizahled 1 DeleteOnTimeout
15 Dizabled 1 DeleteOnTimeout
14 Disabled 1 DeleteOnTimeout
17 Dizabled 1 DeleteOnTimeout
12 Disabled 1 DeleteOnTimeout
10 Dizabled 1 DeleteOnTimeout
0 Digabled 1 DeleteOnTimeout
21 Disahled 1 DeleteOnTime ot
22 Digabled i DeleteOnTimeout
23 Disahled 1 DeleteOnTime ot
24 Dizabled 1 DeleteOnTimeout
25 Disabled 1 DeleteOnTimeout
26 Dizabled 1 DeleteOnTimeout
27 Disabled 1 DeleteOnTimeout
22 Dizabled 1 DeleteOnTimeout

Figure 10- 2. Port Security window

The following parameters can be set:

Parameter Description
From/To A consecutive group of ports may be configured starting with the selected port.
Admin State This pull-down menu allows users to enable or disable Port Security (locked MAC address

table for the selected ports).

Max. Learning The number of MAC addresses that will be in the MAC address-forwarding table for the
Addr. (0-16) selected switch and group of ports.

Lock Address This pull-down menu allows you to select how the MAC address table locking will be
Mode implemented on the Switch, for the selected group of ports. The options are:

o Permanent — The locked addresses will not age out after the aging timer expires.

. DeleteOnTimeout — The locked addresses will age out after the aging timer
expires.

e DeleteOnReset — The locked addresses will not age out until the Switch has been
reset.

Click Apply to implement changes made.
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Port Lock Entries

The Port Lock Entries Table window is used to remove an entry from the port security entries learned by the Switch and entered
into the forwarding database. To view the following window, click Security > Port Lock Entries:

Port Lock Entries

VID [VLAN Name [MAC Attrers —[port _[ype [palete

Figure 10- 3. Port Lock Entries window

This function is only operable if the Mode in the Port Security window is selected as Permanent or DeleteOnReset, or in other
words, only addresses that are permanently learned by the Switch can be deleted. Once the entry has been defined by entering the
correct information into the window above, click the # under the Delete heading of the corresponding MAC address to be
deleted. Only entries marked Secured Permanent can be deleted. Click the Next button to view the next page of entries listed in
this table. This window displays the following information:

Parameter Description
VID The VLAN ID of the entry in the forwarding database table that has been permanently learned by
the Switch.

VLAN Name The VLAN Name of the entry in the forwarding database table that has been permanently learned
by the Switch.

MAC Address | The MAC address of the entry in the forwarding database table that has been permanently learned
by the Switch.

Port The ID number of the port that has permanently learned the MAC address.

Type The type of MAC address in the forwarding database table. Only entries marked
Secured_Permanent can be deleted.

Delete Click the X! in this field to delete the corresponding MAC address that was permanently learned by
the Switch.
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SSL

Secure Sockets Layer or SSL is a security feature that will provide a secure communication path between a host and client through
the use of authentication, digital signatures and encryption. These security functions are implemented through the use of a
ciphersuite, which is a security string that determines the exact cryptographic parameters, specific encryption algorithms and key
sizes to be used for an authentication session and consists of three levels:

1. Key Exchange: The first part of the ciphersuite string specifies the public key algorithm to be used. This switch utilizes
the Rivest Shamir Adleman (RSA) public key algorithm and the Digital Signature Algorithm (DSA), specified here as the
DHE DSS Diffie-Hellman (DHE) public key algorithm. This is the first authentication process between client and host as
they “exchange keys” in looking for a match and therefore authentication to be accepted to negotiate encryptions on the
following level.

2. Encryption: The second part of the ciphersuite that includes the encryption used for encrypting the messages sent
between client and host. The Switch supports two types of cryptology algorithms:

e Stream Ciphers — There are two types of stream ciphers on the Switch, RC4 with 40-bit keys and RC4 with 12§-
bit keys. These keys are used to encrypt messages and need to be consistent between client and host for optimal
use.

e CBC Block Ciphers — CBC refers to Cipher Block Chaining, which means that a portion of the previously
encrypted block of encrypted text is used in the encryption of the current block. The Switch supports the 3DES
EDE encryption code defined by the Data Encryption Standard (DES) to create the encrypted text.

3. Hash Algorithm: This part of the ciphersuite allows the user to choose a message digest function which will determine a
Message Authentication Code. This Message Authentication Code will be encrypted with a sent message to provide
integrity and prevent against replay attacks. The Switch supports two hash algorithms, MDJ5 (Message Digest 5) and SHA
(Secure Hash Algorithm).

These three parameters are uniquely assembled in four choices on the Switch to create a three-layered encryption code for secure
communication between the server and the host. The user may implement any one or combination of the ciphersuites available,
yet different ciphersuites will affect the security level and the performance of the secured connection. The information included in
the ciphersuites is not included with the Switch and requires downloading from a third source in a file form called a certificate.
This function of the Switch cannot be executed without the presence and implementation of the certificate file and can be
downloaded to the Switch by utilizing a TFTP server. The Switch supports SSLv3 and TLSv1. Other versions of SSL may not be
compatible with this Switch and may cause problems upon authentication and transfer of messages from client to host.

Download Certificate

This window is used to download a certificate file for the SSL function on the Switch from a TFTP server. The certificate file is a
data record used for authenticating devices on the network. It contains information on the owner, keys for authentication and
digital signatures. Both the server and the client must have consistent certificate files for optimal use of the SSL function. The
Switch only supports certificate files with .der file extensions. The Switch is shipped with a certificate pre-loaded though the user
may need to download more, depending on user circumstances.

Ciphersuite

This window will allow the user to enable SSL on the Switch and implement any one or combination of listed ciphersuites on the
Switch. A ciphersuite is a security string that determines the exact cryptographic parameters, specific encryption algorithms and
key sizes to be used for an authentication session. The Switch possesses four possible ciphersuites for the SSL function, which are
all enabled by default. To utilize a particular ciphersuite, disable the unwanted ciphersuites, leaving the desired one for
authentication.

When the SSL function has been enabled, the web will become disabled. To manage the Switch through the web based
management while utilizing the SSL function, the web browser must support SSL encryption and the header of the URL must
begin with https://. (Ex. https://10.90.90.90) Any other method will result in an error and no access can be authorized for the web-
based management.

To view the windows for Download Certificate and Ciphersuite, click Security > SSL:
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SL
Certificaie Type
Sexver IP

Certificate File Name

Eey File Name

Current Certificate:Loaded with BESA Certificatel

Configuration

S5L Status Disakled
Cache Timeout(60-86400 sec) GO0

Ciphersuite

RSAwithRC4 128 MDS Enabled * | gxoo004
RSA with 3DES EDE CEC SHA Enabled | 0xo004
DHE D55 with 2DES EDE CEC SHA Enabled * gxo013
RSA EPORT with RC4 40 MDS Enabled * | px0003

Figure 10- 4. Download Certificate and Ciphersuite window

To download certificates, set the following parameters and click Apply.

Parameter Description

Certificate Type Enter the type of certificate to be downloaded. This type refers to the server responsible for
issuing certificates. This field has been limited to Local for this firmware release.

Server IP Enter the IP address of the TFTP server where the certificate files are located.

Certificate File Name | Enter the path and the filename of the certificate file to download. This file must have a .der
extension. (Ex. c:/cert.der)

Key File Name Enter the path and the filename of the key file to download. This file must have a .der
extension (Ex. c:/pkey.der)

To set up the SSL function on the Switch, configure the following parameters and click Apply.

Parameter Description
Configuration

SSL Status Use the pull-down menu to enable or disable the SSL status on the switch. The default is
Disabled.

Cache Timeout (60- This field will set the time between a new key exchange between a client and a host using

86400 sec) the SSL function. A new SSL session is established every time the client and host go
through a key exchange. Specifying a longer timeout will allow the SSL session to reuse the
master key on future connections with that particular host, therefore speeding up the
negotiation process. The default setting is 600 seconds.
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Ciphersuite

RSA with RC4 128
MD5

This ciphersuite combines the RSA key exchange, stream cipher RC4 encryption with 128-
bit keys and the MD5 Hash Algorithm. Use the pull-down menu to enable or disable this
ciphersuite. This field is Enabled by default.

RSA with 3DES EDE
CBC SHA

This ciphersuite combines the RSA key exchange, CBC Block Cipher 3DES_EDE
encryption and the SHA Hash Algorithm. Use the pull-down menu to enable or disable this
ciphersuite. This field is Enabled by default.

DHS DSS with 3DES

This ciphersuite combines the DSA Diffie Hellman key exchange, CBC Block Cipher

EDE CBC SHA 3DES_EDE encryption and SHA Hash Algorithm. Use the pull-down menu to enable or
disable this ciphersuite. This field is Enabled by default.
RSA EXPORT with This ciphersuite combines the RSA Export key exchange and stream cipher RC4 encryption
RC4 40 MD5 with 40-bit keys. Use the pull-down menu to enable or disable this ciphersuite. This field is
Enabled by default.
.-.f' o NOTE: For more information on SSL and its functions, see the DES-
i - 3028/28P/52/52P CLI Manual, located on the documentation CD of this product.
-
[, NOTE: Enabling the SSL command will disable the web-based switch management.
="r1r : To log on to the Switch again, the header of the URL must begin with https://.
i ’ Entering anything else into the address field of the web browser will result in an error
w and no authentication will be granted.
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SSH

SSH is an abbreviation of Secure Shell, which is a program allowing secure remote login and secure network services over an
insecure network. It allows a secure login to remote host computers, a safe method of executing commands on a remote end node,
and will provide secure encrypted and authenticated communication between two non-trusted hosts. SSH, with its array of
unmatched security features is an essential tool in today’s networking environment. It is a powerful guardian against numerous
existing security hazards that now threaten network communications.

The steps required to use the SSH protocol for secure communication between a remote PC (the SSH client) and the Switch (the
SSH server) are as follows:

1. Create a user account with admin-level access using the User Accounts window in the Security Management folder.
This is identical to creating any other admin-level User Account on the Switch, including specifying a password. This
password is used to logon to the Switch, once a secure communication path has been established using the SSH protocol.

2. Configure the User Account to use a specified authorization method to identify users that are allowed to establish SSH
connections with the Switch using the SSH User Authentication window. There are three choices as to the method SSH
will use to authorize the user, which are Host Based, Password and Public Key.

3. Configure the encryption algorithm that SSH will use to encrypt and decrypt messages sent between the SSH client and
the SSH server, using the SSH Algorithm window.

4. Finally, enable SSH on the Switch using the SSH Configuration window.

After completing the preceding steps, a SSH Client on a remote PC can be configured to manage the Switch using a secure, in
band connection.

SSH Server Configuration

The following window is used to configure and view settings for the SSH server and can be opened by clicking Security > SSH >
SSH Server Configuration:

SSH Server Configuration

S5H Server Status

o |

Connection TimeOut
hoira B
Lisonod Fors Number L8

SSH Server Status Im
Ilax Session(1-8) ]B_‘
Connection Time Out(120-600) [te0
Auth. Fail(2-20) [2

Session Rekeying Mewver =

Apply ]

Figure 10- 5. SSH Server Configuration window

To configure the SSH server on the Switch, modify the following parameters and click Apply:
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Parameter

Description

SSH Server Status

Use the pull-down menu to enable or disable SSH on the Switch. The default is Disabled.

Max Session (1-8)

Enter a value between 7 and 8 to set the number of users that may simultaneously access the
Switch. The default setting is 8.

Time Out (120-600)

Allows the user to set the connection timeout. The use may set a time between 120 and 600
seconds. The default setting is 7120 seconds.

Auth. Fail (2-20)

Allows the Administrator to set the maximum number of attempts that a user may try to log on
to the SSH Server utilizing the SSH authentication. After the maximum number of attempts
has been exceeded, the Switch will be disconnected and the user must reconnect to the
Switch to attempt another login. The number of maximum attempts may be set between 2 and
20. The default setting is 2.

Session Rekeying

Using the pull-down menu uses this field to set the time period that the Switch will change the
security shell encryptions. The available options are Never, 10 min, 30 min, and 60 min. The

default setting is Never.

SSH Authentication Mode and Algorithm Settings

The SSH Algorithm window allows the
configuration of the desired types of SSH
algorithms used for authentication
encryption. There are four categories of
algorithms listed and specific algorithms of
each may be enabled or disabled by using
their corresponding pull-down menus. All
algorithms are enabled by default. To open
the following window, click Security >
SSH > SSH Authentication Mode and
Algorithm Settings:

S8H Authentication Mode and Algorithm Settings

Enahled =
Enahled =

Encryption Algorithm

3DES-CBC Enabled =
EBlow-fish-CBC Enabled =
AES]128-CBC Enabled =
AES]192-CBC Enabled =
AFES256-CBC Enabled =

Castl28-CBC Enabled -

Twwofish128 Enabled -

iRl

URELEER

Twofish256 Enahled -
HMAC-SHAL [Enabled =]
HMAC-MDS5 [Enabled =]
HMAC-RSA Enahled =

i

Enahled =

HMAC-DSA

Apply ]

Figure 10- 6. Encryption Algorithm window
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The following algorithms may be set:

Parameter Description
SSH Authentication Mode and Algorithm Settings

Password This parameter may be enabled if the administrator wishes to use a locally configured
password for authentication on the Switch. The default is Enabled.

Public Key This parameter may be enabled if the administrator wishes to use a public key configuration
set on a SSH server, for authentication on the Switch. The default is Enabled.

Host-based This parameter may be enabled if the administrator wishes to use a host computer for
authentication. This parameter is intended for Linux users requiring SSH authentication
techniques and the host computer is running the Linux operating system with a SSH
program previously installed. The default is Enabled.

Encryption Algorithm

3DES-CBC Use the pull-down to enable or disable the Triple Data Encryption Standard encryption
algorithm with Cipher Block Chaining. The default is Enabled.

Blow-fish CBC Use the pull-down to enable or disable the Blowfish encryption algorithm with Cipher Block
Chaining. The default is Enabled.

AES128-CBC Use the pull-down to enable or disable the Advanced Encryption Standard AES128
encryption algorithm with Cipher Block Chaining. The default is Enabled.

AES192-CBC Use the pull-down to enable or disable the Advanced Encryption Standard AES192
encryption algorithm with Cipher Block Chaining. The default is Enabled.

AES256-CBC Use the pull-down to enable or disable the Advanced Encryption Standard AES-256
encryption algorithm with Cipher Block Chaining. The default is Enabled.

ARC4 Use the pull-down to enable or disable the Arcfour encryption algorithm with Cipher Block

Chaining. The default is Enabled.

Cast128-CBC

Use the pull-down to enable or disable the Cast128 encryption algorithm with Cipher Block
Chaining. The default is Enabled.

Twofish128 Use the pull-down to enable or disable the twofish128 encryption algorithm. The default is
Enabled.

Twofish192 Use the pull-down to enable or disable the twofish192 encryption algorithm. The default is
Enabled.

Twofish256 Use the pull-down to enable or disable the twofish256 encryption algorithm. The default is
Enabled.

Data Integrity Algorithm

HMAC-SHA1 Use the pull-down to enable or disable the HMAC (Hash for Message Authentication Code)
mechanism utilizing the Secure Hash algorithm. The default is Enabled.

HMAC-MD5 Use the pull-down to enable or disable the HMAC (Hash for Message Authentication Code)
mechanism utilizing the MD5 Message Digest encryption algorithm. The default is Enabled.

Public Key Algorithm

HMAC-RSA Use the pull-down to enable or disable the HMAC (Hash for Message Authentication Code)
mechanism utilizing the RSA encryption algorithm. The default is Enabled.

HMAC-DSA Use the pull-down to enable or disable the HMAC (Hash for Message Authentication Code)

mechanism utilizing the Digital Signature Algorithm encryption. The default is Enabled.

Click Apply to implement changes made.
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SSH User Authentication

The following windows are (Note Mazximum of 8 entries.)
used to configure parameters

for users attempting to access
access the following window, :
click Security > SSH > SSH | admmn Password
User Authentication Mode.

In the example window to the right, the
“admin” has been | NHIWKET] ctenow
previously set using the User Accounts
window in the Administration folder. A
User Account MUST be set in order to set | |30 LIS el
the parameters for the SSH wuser. To
configure the parameters for a SSH user,

click on the hyperlinked User Name in the Aaply

Authentication Mode —— '
window, which will reveal the following | =hew All User Authentication Entries

User Account

SSH User

window to configure.

SSH User Authentication Mode

UsEr Password

Figure 10- 7. SSH User Authentication Mode window

Anth. Mode Fasswaord

Host TP

Figure 10- 8. SSH User window

The user may set the following parameters:

Parameter

Description

User Name

Enter a User Name of no more than 15 characters to identify the SSH user. This User Name
must be a previously configured user account on the Switch.

Auth. Mode

The administrator may choose one of the following to set the authorization for users attempting
to access the Switch.

Host Based — This parameter should be chosen to use a remote SSH server for authentication
purposes. Choosing this parameter requires the user to input the following information to identify
the SSH user.

e  Host Name — Enter an alphanumeric string of no more than 31 characters to identify
the remote SSH user.
e  Host IP — Enter the corresponding IP address of the SSH user.
Password — This parameter should be chosen to use an administrator-defined password for

authentication. Upon entry of this parameter, the Switch will prompt the administrator for a
password, and then to re-type the password for confirmation.

Public Key — This parameter should be chosen to use the publickey on a SSH server for
authentication.

Host Name

Enter an alphanumeric string of no more than 32 characters to identify the remote SSH user.
This parameter is only used in conjunction with the Host Based choice in the Auth. Mode field.

Host IP

Enter the corresponding IP address of the SSH user. This parameter is only used in conjunction
with the Host Based choice in the Auth. Mode field.

Click Apply to implement changes made.
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NOTE: To set the SSH User Authentication parameters on the Switch, a User Account
must be previously configured. For more information on configuring local User Accounts on
the Switch, see the User Accounts section of this manual located in the Administration
section.
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802.1X
802.1x Port-Based and MAC-Based Access Control

The IEEE 802.1x standard is a security measure for authorizing and authenticating users to gain access to various wired or
wireless devices on a specified Local Area Network by using a Client and Server based access control model. This is
accomplished by using a RADIUS server to authenticate users trying to access a network by relaying Extensible Authentication
Protocol over LAN (EAPOL) packets between the Client and the Server. The following figure represents a basic EAPOL packet:

Ethernet Frame
Destination Tvoe 3
(0180C2-000003) Saucy (85.36) Data CRC
s~ o W
-7 ]
=T ]
- = \I
i } '1
e [
a4 '
. r i '.I
Protocol YWersion Packet body
1 Packet Type length Packet Bady
EAPOL packet

Figure 10- 9. The EAPOL Packet

Utilizing this method, unauthorized devices are restricted from connecting to a LAN through a port to which the user is connected.
EAPOL packets are the only traffic that can be transmitted through the specific port until authorization is granted. The 802.1x
Access Control method holds three roles, each of which are vital to creating and upkeeping a stable and working Access Control
security method.

“ Authentication
“Client™ “ Authenticator” Server”
NIC Card Metwork Port AAA Server
Ethernet8023. [ ™ Access Point, o Any EAP Server,
Wyireless PC Card, etc. Ethernet Switch, etc. Mostly RADIUS
EAP Crwer LAN Encapsulated EAFP
EAP OverWireless Messages, typically
an RADIUS

(8023 or B02.11)
Figure 10- 10. The three roles of 802.1x

The following section will explain the three roles of Client, Authenticator and Authentication Server in greater detail.
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Authentication Server

The Authentication Server is a remote device that is connected to the same network as the Client and Authenticator, must be
running a RADIUS Server program and must be configured properly on the Authenticator (Switch). Clients connected to a port on
the Switch must be authenticated by the Authentication Server (RADIUS) before attaining any services offered by the Switch on
the LAN. The role of the Authentication Server is to certify the identity of the Client attempting to access the network by
exchanging secure information between the RADIUS server and the Client through EAPOL packets and, in turn, informs the
Switch whether or not the Client is granted access to the LAN and/or switches services.

Authentication Server
[ -__-.)l -

Bk -\r| T FS

7 lpogs ;:.f]"_ﬁ.[_ _Hqultﬁm Switch

| ] |

—i
= I I .t

Client Cliert Cliert Client

Figure 10- 11. The Authentication Server

Authenticator

The Authenticator (the Switch) is an intermediary between the Authentication Server and the Client. The Authenticator servers
two purposes when utilizing 802.1x. The first purpose is to request certification information from the Client through EAPOL
packets, which is the only information allowed to pass through the Authenticator before access is granted to the Client. The
second purpose of the Authenticator is to verify the information gathered from the Client with the Authentication Server, and to
then relay that information back to the Client.

Three steps must be implemented on the Switch to properly configure the Authenticator.
1. The 802.1x State must be EFnabled. (DES-30xx Web Management Tool)

2. The 802.1x settings must be implemented by port (Security / 802.1x / Configure 802.1X Authenticator Parameter)
3. A RADIUS server must be configured on the Switch. (Security / 802.1x / Authentic RADIUS Server)

S AR
%E c Switch

{Authenticator)

RADIUS Server

Workstation (Authentication Server)

{Client)

Figure 10- 12. The Authenticator
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Client

The Client is simply the endstation that wishes to gain access to the LAN or switch services. All endstations must be running
software that is compliant with the 802.1x protocol. For users running Windows XP, that software is included within the operating
system. All other users are required to attain 802.1x client software from an outside source. The Client will request access to the
LAN and or Switch through EAPOL packets and, in turn will respond to requests from the Switch.

~ E
Workstation
(Client)

Switch
{Authenticator)

RADIUS Server

{Authentication Server)

Figure 10- 13. The Client

Authentication Process

Utilizing the three roles stated above, the 802.1x protocol provides a stable and secure way of authorizing and authenticating users
attempting to access the network. Only EAPOL traffic is allowed to pass through the specified port before a successful
authentication is made. This port is “locked” until the point when a Client with the correct username and password (and MAC
address if 802.1x is enabled by MAC address) is granted access and therefore successfully “unlocks” the port. Once unlocked,
normal traffic is allowed to pass through the port. The following figure displays a more detailed explanation of how the
authentication process is completed between the three roles stated above.

802.1X Authentication process

. RADIUS Server
) Switch
Waorkstation . {Authentication Server)
{Client) (Authenticator)
4
w8 -
EAPOL-Start
= -
EAP-Request/ Identity
-t
EAP-Response/ Identity RADIUS Access-Request
- -
EAP-Request/OTP RADIUS Access-Challenge
-} -t
EAP-Response/0TP RADIUS Access-Request
o= Ll
EAP-Success RADIUS Access-Accept
i -t
Port Authorized
EAPOL-Logoff RADIUS Account-5top
o= Ll
RADIUS Ack
-t
Port Unauthorized * OTP (One-Time-Password)

Figure 10- 14. The 802.1x Authentication Process

The D-Link implementation of 802.1x allows network administrators to choose between two types of Access Control used on the
Switch, which are:

1. Port-Based Access Control — This method requires only one user to be authenticated per port by a remote RADIUS server
to allow the remaining users on the same port access to the network.

2. MAC-Based Access Control — Using this method, the Switch will automatically learn up to sixteen MAC addresses by
port and set them in a list. Each MAC address must be authenticated by the Switch using a remote RADIUS server before
being allowed access to the Network.

Understanding 802.1x Port-based and MAC-based Network Access Control

The original intent behind the development of 802.1x was to leverage the characteristics of point-to-point in LANs. As any single
LAN segment in such infrastructures has no more than two devices attached to it, one of which is a Bridge Port. The Bridge Port
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detects events that indicate the attachment of an active device at the remote end of the link, or an active device becoming inactive.
These events can be used to control the authorization state of the Port and initiate the process of authenticating the attached device
if the Port is unauthorized. This is the Port-Based Network Access Control.

Port-Based Network Access Control

X
—1
RADIUS

Server

Ethernet Switch

OREEE DEHE OooOoOo oEseEo

Lalll 1

802.1X 802.1X 802.1X 802.1X 802.1X 802.1X 802.1X 802.1X 802.1X
Client Client Client Client Client Client Client Client Client

= Network access controlled port

B Network access uncontrolled port

Figure 10- 15. Example of Typical Port-Based Configuration

Once the connected device has successfully been authenticated, the Port then becomes Authorized, and all subsequent traffic on
the Port is not subject to access control restriction until an event occurs that causes the Port to become Unauthorized. Hence, if the
Port is actually connected to a shared media LAN segment with more than one attached device, successfully authenticating one of
the attached devices effectively provides access to the LAN for all devices on the shared segment. Clearly, the security offered in

this situation is open to attack.

148



MAC-Based Network Access Control

i

RADIUS
Server

Ethernet Switch

D@D D000 OD0O0OO0O@E @mEEsEo

T inh ok

802.1X  802.1X  802.1X 802.1X  802.1X  802.1X 802.1X  802.1X  802.1X 802.1X  802.IX  802.1X
Client ~ Client  Client Client ~ Client  Client Client ~ Client  Client Client  Client  Client

= Network access controlled port

= Network access uncontrolled port

Figure 10- 16. Example of Typical MAC-Based Configuration

In order to successfully make use of 802.1x in a shared media LAN segment, it would be necessary to create “logical” Ports, one
for each attached device that required access to the LAN. The Switch would regard the single physical Port connecting it to the
shared media segment as consisting of a number of distinct logical Ports, each logical Port being independently controlled from
the point of view of EAPOL exchanges and authorization state. The Switch learns each attached devices’ individual MAC
addresses, and effectively creates a logical Port that the attached device can then use to communicate with the LAN via the
Switch.
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Guest VLANSs

On 802.1x security enabled networks, there is a need for non 802.1x
supported devices to gain limited access to the network, due to lack
of the proper 802.1x software or incompatible devices, such as
computers running Windows 98 or lower operating systems, or the
need for guests to gain access to the network without full
authorization. To supplement these circumstances, this switch now
implements Guest 802.1x VLANs. These VLANs should have
limited access rights and features separate from other VLANSs on
the network.

To implement Guest 802.1x VLANSs, the user must first create a
VLAN on the network with limited rights and then enable it as an
802.1x guest VLAN. Then the administrator must configure the
guest accounts accessing the Switch to be placed in a Guest VLAN
when trying to access the Switch. Upon initial entry to the Switch,
the client wishing services on the Switch will need to be
authenticated by a remote RADIUS Server on the Switch to be
placed in a fully operational VLAN. If authenticated and the
authenticator posseses the VLAN placement information, that client
will be accepted into the fully operational target VLAN and normal
switch functions will be open to the client. If the authenticator does
not have target VLAN placement information, the swtich will create
a VLAN and the client will be placed in this VLAN. Yet, if the
client is denied authentication by the authenticator, it will be placed
in the Guest VLAN where it has limited rights and access. The
adjacent figure should give the user a better understanding of the
Guest VLAN process.

Limitations Using the Guest VLAN

-~ =, - =)

/
{
\\\_

ENABLE GUEST
VLAN

Authentication

802.1x Accepted

Authentication
Process

VLAN
Identification
Process by
Authenticator
Authentication
Denied -

B

// W

Identified VLAN  Unidentified VLAN
W
\

Client Placed in \\\ | ClientPlacedin
Guest VLAN ! | VLAN specified by
/J % Authenticator /
7 T w4

Client Placed in

Guest VLAN

Figure 10- 17. Guest VLAN Authentication Process

1.  Guest VLANS are only supported for port-based VLANs. MAC-based VLANs cannot undergo this procedure.

Ports supporting Guest VLANSs cannot be GVRP enabled and vice versa.

A port cannot be a member of a Guest VLAN and a static VLAN simultaneously.

2
3
4. Once a client has been accepted into the target VLAN, it can no longer access the Guest VLAN.
5

If a port is a member of multiple VLANS, it cannot become a member of the Guest VLAN.

150



Configure 802.1x Guest VLAN

In the Security menu, open the 802.1x folder and click Configure 802.1x Guest VLAN, which will display the following
window for the user to configure. Remember, to set a Guest 802.1x VLAN, the user must first configure a normal VLAN which
can be enabled here for Guest VLAN status.

Configure 802.1X Guest VLAN

accounting Delete [ ]
Enahled +
From:  Fortl % To | Portl

Guest VLAN Name: accounting
Guest VLAN Ports: 14-16

Figure 10- 18. Configure 802.1x Guest VLAN window
The following fields may be modified to enable the guest 802.1x VLAN:

Parameter Description
VLAN Name Enter the pre-configured VLAN name to create as a Guest 802.1x VLAN.
Operation The user has two choices in configuring the Guest 802.1X VLAN, which are:

Enabled — Selecting this option will enable ports listed in the Port List below, as part of the Guest
VLAN. Be sure that these ports are configured for this VLAN or users will be prompted with an
error message.

Disabled - Selecting this option will disable ports listed in the Port List below, as part of the
Guest VLAN. Be sure that these ports are configured for this VLAN or users will be prompted
with an error message.

Port List Set the port list of ports to be enabled for the Guest 802.1x VLAN using the pull-down menus.

Click Apply to implement the guest 802.1x VLAN settings entered. Only one VLAN may be assigned as the 802.1X Guest
VLAN.
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802.1x Authenticator Settings

To configure the 802.1X Authenticator Settings, click Security > 802.1X > 802.1X Authenticator Settings:

802.1X Authenticator Settings

A g1 T Quiet Supp- Server- ReAuth ReAuth
1 both 30 a0 30 30 2 o

auto 3600
2 hoth auto 30 ] 30 30 2 3a00 fio
3 hoth auto 30 ] 30 30 2 3400 fio
4 hoth auto 30 ] 30 30 2 3400 10
) hoth auto 30 ] 30 30 2 3A00 f10
i} hoth auto 30 ] 30 30 2 3A00 f10
7 hoth auto 30 ] 30 30 2 3a00 fio
g hoth auto 30 ] 30 30 2 3a00 fio
9 hoth auto 30 ] 30 30 2 3a00 fio
10 hoth auto 30 ] 30 30 2 3a00 fio
il hoth auto 30 1] 30 30 2 3400 fio
12 hoth auto 30 Ll 30 30 2 3600 f10
13 hoth auto 30 ] 30 30 2 3600 f10
14 hoth auto 30 ] 30 30 2 3A00 f10
15 hoth auto 30 i 30 30 2 3a00 fi0
la hoth auto 30 ] 30 30 2 3a00 fio
17 hoth auto 30 a0 30 30 2 3a00 fio
18 hoth auto 30 ] 30 30 2 3a00 fio
19 hoth auto 30 ] 30 30 2 3400 fio
20 hboth auto 30 il 30 30 2 2600 f10
2l hoth auto 30 ] 30 30 2 3600 f10
2 both auto 30 ] 30 30 2 3A00 f10
23 hoth auto 30 il 30 30 2 3a00 fio
24 hoth auto 30 ] 30 30 2 3a00 fio
25 hoth auto 30 a0 30 30 2 3a00 fio
26 hoth auto 30 ] 30 30 2 3a00 fio
27 hoth auto 30 a0 30 30 2 3400 10
25 hoth auto 30 ] 30 30 2 3600 f10

Figure 10- 19. 802.1x Authenticator Settings window

To configure the settings by port, click on its corresponding Ports link, which will display the following table to configure:
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Figure 10- 20. 802.1X Authenticator Settings window (Modify)

This window allows users to set the following features:

Parameter Description

From/To] Enter the port or ports to be set.

AdmDir Sets the administrative-controlled direction to either /In or Both.

If In is selected, control is only exerted over incoming traffic through the port you selected in
the first field.

If Both are selected, control is exerted over both incoming and outgoing traffic through the
controlled port selected in the first field.

PortControl This allows you to control the port authorization state.

Select forceAuthorized to disable 802.1X and cause the port to transition to the authorized
state without any authentication exchange required. This means the port transmits and
receives normal traffic without 802.1X-based authentication of the client.

If forceUnauthorized is selected, the port will remain in the unauthorized state, ignoring all
attempts by the client to authenticate. The Switch cannot provide authentication services to
the client through the interface.

If Auto is selected, it will enable 802.1X and cause the port to begin in the unauthorized
state, allowing only EAPOL frames to be sent and received through the port. The
authentication process begins when the link state of the port transitions from down to up, or
when an EAPOL-start frame is received. The Switch then requests the identity of the client
and begins relaying authentication messages between the client and the authentication
server.

The default setting is Auto.

TxPeriod This sets the TxPeriod of time for the authenticator PAE state machine. This value
determines the period of an EAP Request/ldentity packet transmitted to the client. The
default setting is 30 seconds.

QuietPeriod This allows you to set the number of seconds that the Switch remains in the quiet state

following a failed authentication exchange with the client. The default setting is 60 seconds.
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SuppTimeout

This value determines timeout conditions in the exchanges between the Authenticator and
the client. The default setting is 30 seconds.

ServerTimeout

This value determines timeout conditions in the exchanges between the Authenticator and
the authentication server. The default setting is 30 seconds.

MaxReq The maximum number of times that the Switch will retransmit an EAP Request to the client
before it times out of the authentication sessions. The default setting is 2.

ReAuthPeriod A constant that defines a nonzero number of seconds between periodic reauthentication of
the client. The default setting is 3600 seconds.

ReAuth Determines whether regular reauthentication will take place on this port. The default setting

is Disabled.

Click Apply to implement configuration changes.
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Local Users

In the Security folder, open the 802.1x folder and click 802.1X User to open the 802.1x User window. This window will allow
the user to set different local users on the Switch.

Local Users Configuration

User Name Confirm Password

Total Entries:0

Local Users Tahle

)
I
M

Figure 10- 21. Local Users Configuration window

Enter a User Name, Password and confirmation of that password. Properly configured local users will be displayed in the Local
Users Table at the bottom of the same window.

Initializing Ports for Port Based 802.1x

Existing 802.1x port and MAC settings are displayed and can be configured using the window below.

Click Security > 802.1x > Initialize Port(s) to open the following window:

Initialize Port

Fortl Fortl Apply

Initialize Port Table

ForceAuth SUCCESS both Authorized
Forcefuth SUCCESS both Authorized
Forceduth SUCCESS both Authonized
Forceduth Success both Anthonzed
ForceAuth SUCCESS both Authorized
Forcefuth SUCCESS both Authorized

o Avny
[ Apply |

1
2
3
4
O
&

Figure 10- 22. Initialize Port window

This window allows initialization of a port or group of ports. The Initialize Port Table in the bottom half of the window displays
the current status of the port(s).

This window displays the following information:

Parameter Description

From and To Select ports to be initialized.

Auth PAE State The Authenticator PAE State will display one of the following: Initialize, Disconnected,

nnnnn din~n Asibhhnntinatinma Aiibhhnnbinatand Abhavkima LIAIAN CavanAidlh Cavanl linaiidlh AanA ANI/A
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Connecting, Authenticating, Authenticated, Aborting, Held, ForceAuth, ForceUnauth, and N/A.

Backend State The Backend Authentication State will display one of the following: Request, Response,
Success, Fail, Timeout, Idle, Initialize, and N/A.

Oper Dir The status of the administrative-controlled direction, either In or Both.

Port Status A read-only field indicating a port on the Switch.

Initializing Ports for MAC Based 802.1x

To initialize ports for the MAC side of 802.1x, the user must first enable 802.1x by MAC address in the DES-30xx Web
Management Tool window. Click Security > 802.1x > Initialize Port(s) to open the following window:

Initialize Port(s)

I Port1l w

Fortl =
MMac Address ]

Figure 10- 23. Initialize Ports (MAC based 802.1x)

To initialize ports, choose the range of ports in the From and To field. Then the user must specify the MAC address to be
initialized by entering it into the MAC Address field and checking the corresponding check box. To begin the initialization, click

Apply.

S NOTE: The user must first globally enable 802.1X in the DES-30xx Web
eFj;' Management Tool window before initializing ports. Information in the
L ; Initialize Ports Table cannot be viewed before enabling 802.1X.
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Reauthenticate Port(s) for Port Based 802.1x

This window allows reauthentication of a port or group of ports by using the pull-down menus From and To and clicking Apply.
The Reauthenticate Port Table displays the current status of the reauthenticated port(s) once Apply has been clicked.

Click Security > 802.1x > Reauthenticate Port(s) to open the Reauthenticate Port(s) window:

Reauthenticate Port

Fortl w Fortl w Apply

=
II

Reauthenticate Port Table

ort EackendState PurtStatus

BackendState PortStatus

1 ForceAuth Success both Luthorized
2 Forceluth Duccess both Anthonzed
3 Forceluth Success both Anthonzed
4 ForceAuth SUCCESS both Authorized
5 ForceAuth Success both Luthorized
& Forceluth Duccess both Anthonzed
7 Forceluth Success both Anthonzed
& ForceAuth SUCCESS both Authorized
9 Forcefuth Success both Luthorized
10 Forceluth Duccess both Anthonzed

Figure 10- 24. Reauthenticate Port and Reauthenticate Port Table window

This window displays the following information:

Parameter Description
Port The port number of the reauthenticated port.
Auth State The Authenticator State will display one of the following: Initialize, Disconnected, Connecting,

Authenticating, Authenticated, Aborting, Held, ForceAuth, ForceUnauth, and N/A.

BackendState The Backend State will display one of the following: Request, Response, Success, Fail, Timeout,
Idle, Initialize, and N/A.

OperDir The status of the administrative-controlled direction, either In or Both.
) NOTE: The user must first globally enable 802.1X in the DES-30xx Web
'i:;' Management Tool window before initializing ports. Information in the
L ; Initialize Ports Table cannot be viewed before enabling 802.1X.
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Reauthenticate Port(s) for MAC-based 802.1x

To reauthenticate ports for the MAC side of 802.1x, the user must first enable 802.1x by MAC address in the DES-30xx Web
Management Tool window. Click Security > 802.1x > Reauthenticate Port(s) to open the following window:

Reauthenticate Port(s)
Fonl
Fotl
Mac Address

]

=]

Figure 10- 25. Reauthenticate Ports window — MAC based 802.1x

To reauthenticate ports, first choose the switch in the switch stack by using the Unit pull-down menu, then the range of ports in
the From and To field. Then the user must specify the MAC address to be reauthenticated by entering it into the MAC Address
field and checking the corresponding check box. To begin the reauthentication, click Apply.

RADIUS Server

The RADIUS feature of the Switch allows you to facilitate centralized user administration as well as providing protection against
a sniffing, active hacker. The Web Manager offers three windows.

Click Security > 802.1x > RADIUS Server to open the RADIUS Server window shown below:

RADIUS Server

First hd
0.0.0.0
Authentic Port 1812
Accounting Port 1813

:
=

E
el

@0
ﬁﬂ
2| B
Ii
A
e

Valid v

Current RADIUS Server(s) Settings Table

RADIUS Server |Auth UDP Port Status

Figure 10- 26. RADIUS Server window

This window displays the following information:

Parameter Description

Succession Choose the desired RADIUS server to configure: First, Second or Third.

RADIUS Server Set the RADIUS server IP.

1

9]

8




Authentic Port Set the RADIUS authentic server(s) UDP port. The default portis 1872.

Accounting Port | Set the RADIUS account server(s) UDP port. The default port is 7813.

Key Set the key the same as that of the RADIUS server.
Confirm Key Confirm the shared key is the same as that of the RADIUS server.
Status This allows users to set the RADIUS Server as Valid (Enabled) or Invalid (Disabled).

Trusted Host

Go to the Security folder and click on the Trusted Host link; the following window will appear.

Trusted Host
IP1 Access to Switch 0.0.00
IP2 Access to Switch 0000
IP3 Access to Switch 0.0.00
IP4 Access to Switch 0.0.00
- 0.0.0.0
Switch 0.0.0.0
IP7 Access to Switch 0.0.0.0
IP8 Access to Switch 0.0.00

2| >
2E
S

Note: Create a hst of IP Addresszes that can access the swatch, Your local host TP
Address must be one of the TP Addresses to avold disconnection.

Figure 10- 27. Trusted Host window

Use Security IP Management to permit remote stations to manage the Switch. If you choose to define one or more designated
management stations, only the chosen stations, as defined by IP address, will be allowed management privilege through the web
manager or Telnet session. To define a management station IP setting, type in the IP address and click the Apply button.
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Access Authentication Control

The TACACS/XTACACS/TACACS+/RADIUS commands allow users to secure access to the Switch using the
TACACS/XTACACS/TACACS+/RADIUS protocols. When a user logs in to the Switch or tries to access the administrator level
privilege, he or she is prompted for a password. If TACACS/XTACACS/TACACS+/RADIUS authentication is enabled on the
Switch, it will contact a TACACS/XTACACS/TACACS+/RADIUS server to verify the user. If the user is verified, he or she is
granted access to the Switch.

There are currently three versions of the TACACS security protocol, each a separate entity. The Switch's software supports the
following versions of TACACS:

. TACACS (Terminal Access Controller Access Control System) - Provides password checking and authentication,
and notification of user actions for security purposes utilizing via one or more centralized TACACS servers, utilizing
the UDP protocol for packet transmission.

. Extended TACACS (XTACACS) - An extension of the TACACS protocol with the ability to provide more types
of authentication requests and more types of response codes than TACACS. This protocol also uses UDP to transmit
packets.

. TACACS+ (Terminal Access Controller Access Control System plus) - Provides detailed access control for
authentication for network devices. TACACS+ is facilitated through Authentication commands via one or more
centralized servers. The TACACS+ protocol encrypts all traffic between the Switch and the TACACS+ daemon,
using the TCP protocol to ensure reliable delivery

In order for the TACACS/XTACACS/TACACS+/RADIUS  security function to  work properly, a
TACACS/XTACACS/TACACS+/RADIUS server must be configured on a device other than the Switch, called an Authentication
Server Host and it must include usernames and passwords for authentication. When the user is prompted by the Switch to enter
usernames and passwords for authentication, the Switch contacts the TACACS/XTACACS/TACACS+/RADIUS server to verify,
and the server will respond with one of three messages:

. The server verifies the username and password, and the user is granted normal user privileges on the Switch.
. The server will not accept the username and password and the user is denied access to the Switch.

. The server doesn't respond to the verification query. At this point, the Switch receives the timeout from the server
and then moves to the next method of verification configured in the method list.

The Switch has four built-in Authentication Server Groups, one for each of the TACACS, XTACACS, TACACS+ and RADIUS
protocols. These built-in Authentication Server Groups are used to authenticate users trying to access the Switch. The users will
set Authentication Server Hosts in a preferable order in the built-in Authentication Server Groups and when a user tries to gain
access to the Switch, the Switch will ask the first Authentication Server Hosts for authentication. If no authentication is made, the
second server host in the list will be queried, and so on. The built-in Authentication Server Groups can only have hosts that are
running the specified protocol. For example, the TACACS Authentication Server Groups can only have TACACS Authentication
Server Hosts.

The administrator for the Switch may set up six different authentication techniques per user-defined method list
(TACACS/XTACACS/TACACS+/RADIUS/local/none) for authentication. These techniques will be listed in an order preferable,
and defined by the user for normal user authentication on the Switch, and may contain up to eight authentication techniques.
When a user attempts to access the Switch, the Switch will select the first technique listed for authentication. If the first technique
goes through its Authentication Server Hosts and no authentication is returned, the Switch will then go to the next technique listed
in the server group for authentication, until the authentication has been verified or denied, or the list is exhausted.

Please note that users granted access to the Switch will be granted normal user privileges on the Switch. To gain access to
administrator level privileges, the user must access the Enable Admin window and then enter a password, which was previously
configured by the administrator of the Switch.

S NOTE: TACACS, XTACACS and TACACS+ are separate entities and are not
compatible. The Switch and the server must be configured exactly the same, using the
same protocol. (For example, if the Switch is set up for TACACS authentication, so must
be the host server.)

R P
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Authentication Policy and Parameter Settings

This command will enable an administrator-defined authentication policy for users trying to access the Switch. When enabled, the
device will check the Login Method List and choose a technique for user authentication upon login.

To access the following window, click Security > Access Authentication Control > Authentication Policy and Parameter
Settings:

Authentication Policy and Parameter Settings

Authentication Policy Disabled v
Response Timeout (0-255) 30
User Attempts (1-255) 3

Figure 10- 28. Authentication Policy and Parameters Settings window

The following parameters can be set:

Parameters Description

Authentication Policy Use the pull-down menu to enable or disable the Authentication Policy on the Switch.

Response Timeout (0- This field will set the time the Switch will wait for a response of authentication from the

255) user. The user may set a time between 0 and 255 seconds. The default setting is 30
seconds.

User Attempts (1-255) This command will configure the maximum number of times the Switch will accept

authentication attempts. Users failing to be authenticated after the set amount of
attempts will be denied access to the Switch and will be locked out of further
authentication attempts. Command line interface users will have to wait 60 seconds
before another authentication attempt. Telnet and web users will be disconnected from
the Switch. The user may set the number of attempts from 7 to 255. The default setting
is 3.

Click Apply to implement changes made.

Application Authentication Settings

This window is used to configure switch configuration applications (console, Telnet, SSH, web) for login at the user level and at
the administration level (Enable Admin) utilizing a previously configured method list. To view the following window, click
Security > Access Authentication Control > Application Authentication Settings:

Application Authentication Settings

Application Login Method List [Enable Method List

cefault default

Telnet default « default
SH default « default «
HTTP default « default +

Figure 10- 29. Application Authentication Settings window

The following parameters can be set:
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Parameter Description

Application Lists the configuration applications on the Switch. The user may configure the Login Method
List and Enable Method List for authentication for users utilizing the Console (Command
Line Interface) application, the Telnet application, SSH and the WEB (HTTP) application.

Login Method List Using the pull-down menu, configure an application for normal login on the user level,
utilizing a previously configured method list. The user may use the default Method List or
other Method List configured by the user. See the Login Method Lists window, in this
section, for more information.

Enable Method List Using the pull-down menu, configure an application for normal login on the user level,
utilizing a previously configured method list. The user may use the default Method List or
other Method List configured by the user. See the Enable Method Lists window, in this
section, for more information

Click Apply to implement changes made.

Authentication Server Group

This window will allow users to set up Authentication Server Groups on the Switch. A server group is a technique used to group
TACACS/XTACACS/TACACS+/RADIUS server hosts into user-defined categories for authentication using method lists. The
user may define the type of server group by protocol or by previously defined server group. The Switch has three built-in
Authentication Server Groups that cannot be removed but can be modified. Up to eight authentications server hosts may be added
to any particular group.

To view the following window, click Security > Access Authentication Control > Authentication Server Group:

Add

(MoteIfammum of B entries)

Authentication Server Group

radins x|
tacacs Rl
tacacs+ s .
stacacs X

Figure 10- 30. Authentication Server Group window

This window displays the Authentication Server Groups on the Switch. The Switch has four built-in Authentication Server Groups
that cannot be removed but can be modified. To modify a particular group, click its hyperlinked Group Name, which will then
display the following window.
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Add a Server Host to Server Group ( radius)

0.0.0.0
FADILS

[ Add to Group ]

(Mote Mdazmum of & entnies.)
Server Group ( radius)

I Adre

chow Al Server Group Entries

Figure 10- 31. Add a Server Host to Server Group (radius) window

To add an Authentication Server Host to the list, enter its IP address in the IP Address field, choose the protocol associated with
the IP address of the Authentication Server Host and click Add to Group to add this Authentication Server Host to the group.

To add a user-defined group to the list, click the Add button in the Authentication Server Group window, which will display the
following window.

Authentication Server Group Table Add Settings

Group Name

Apply

chow All Server Group Table Entries

Figure 10- 32. Authentication Server Group Table Add Settings

Simply enter a group name of no more than 15 alphanumeric characters to define the user group to add. After clicking Apply, the
new user-defined group will be displayed in the Authentication Server Group window. Here, it can be configured as the user
desires.

i NOTE: The user must configure Authentication Server Hosts using the Authentication Server
3;5: & Hosts window before adding hosts to the list. Authentication Server Hosts must be configured
{ for their specific protocol on a remote centralized server before this function can work properly.

o) NOTE: The four built in server groups can only have server hosts running the same TACACS
£ & daemon. TACACS/XTACACS/TACACS+ protocols are separate entities and are not
{

[ compatible with each other.

Authentication Server Host

This window will set user-defined Authentication Server Hosts for the TACACS/XTACACS/TACACS+/RADIUS security
protocols on the Switch. When a user attempts to access the Switch with Authentication Policy enabled, the Switch will send
authentication packets to a remote TACACS/XTACACS/TACACS+/RADIUS server host on a remote host. The
TACACS/XTACACS/TACACS+/RADIUS server host will then verify or deny the request and return the appropriate message to
the Switch. More than one authentication protocol can be run on the same physical server host but, remember that
TACACS/XTACACS/TACACS+/RADIUS are separate entities and are not compatible with each other. The maximum supported
number of server hosts is 16.

To view the following window, click Security > Access Authentication Control > Authentication Server Host:
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Figure 10- 33. Authentication Server Host Settings window

To add an Authentication Server Host, click the Add button, revealing the following window:

Authentication Server Host Setting - Add

s 3
Port(1-65535) 49
Timeout(1-255) 2
Retransmit(1-255) 2

Key

Show Al Authentication Server Host Entries

Figure 10- 34. Authentication Server Host Settings — Add window

To edit an Authentication Server Host, click the IP address hyperlink, revealing the following window:

Authentication Server Host Setting - Edit

IP Address 10009
Protocol
Port(1-65535)
Timeout(1-255) A
Retransmit(1-255)

||
[l

2

show Al Authentication Server Host Entries

Figure 10- 35. Authentication Server Host Setting — Edit window

Configure the following parameters to add an Authentication Server Host:

Parameter Description
IP Address The IP address of the remote server host to add.
Protocol The protocol used by the server host. The user may choose one of the following:

. TACACS - Enter this parameter if the server host utilizes the TACACS protocol.
«  XTACACS - Enter this parameter if the server host utilizes the XTACACS
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protocol.

. TACACSH+ - Enter this parameter if the server host utilizes the TACACS+
protocol.

. RADIUS - Enter this parameter if the server host utilizes the RADIUS protocol.

Port (1-65535) Enter a number between 7 and 65535 to define the virtual port number of the authentication
protocol on a server host. The default port number is 49 for TACACS/XTACACS/TACACS+
servers and 7813 for RADIUS servers but the user may set a unique port number for higher
security.

Timeout (1-255) Enter the time in seconds the Switch will wait for the server host to reply to an authentication
request. The default value is 5 seconds.

Retransmit (1-255) Enter the value in the retransmit field to change how many times the device will resend an
authentication request when the TACACS server does not respond.

Key Authentication key to be shared with a configured TACACS+ or RADIUS servers only.
Specify an alphanumeric string up to 254 characters.

Click Apply to add the server host.

host but, remember that TACACS/XTACACS/TACACS+ are separate entities and are

;E%: NOTE: More than one authentication protocol can be run on the same physical server
X
not compatible with each other

=
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Login Method Lists

This command will configure a user-defined or default Login Method List of authentication techniques for users logging on to the
Switch. The sequence of techniques implemented in this command will affect the authentication result. For example, if a user
enters a sequence of techniques, for example TACACS — XTACACS - local, the Switch will send an authentication request to the
first TACACS host in the server group. If no response comes from the server host, the Switch will send an authentication request
to the second TACACS host in the server group and so on, until the list is exhausted. At that point, the Switch will restart the same
sequence with the following protocol listed, XTACACS. If no authentication takes place using the XTACACS list, the local
account database set in the Switch is used to authenticate the user. When the local method is used, the privilege level will be
dependant on the local account privilege configured on the Switch.

Successful login using any of these techniques will give the user a "User" privilege only. To upgrade his or her status to the
administrator level, the user must use the Enable Admin window, in which the user must enter a previously configured password,

set by the administrator. (See the Enable Admin part of this section for more detailed information concerning the Enable Admin
command.)

To view the following window click Security > Access Authentication Control > Login Method Lists:

Add

(Meate MWammum of 8 entries. )
Login Method Lists

Igg‘:f:’d List  nfethod]  [Method2  |[Method3  [Method 4

default local >

Figure 10- 36. Login Method Lists Settings window

The Switch contains one Method List that is set and cannot be removed, yet can be modified. To delete a Login Method List
defined by the user, click the # under the Delete heading corresponding to the entry desired to be deleted. To modify a Login
Method List, click on its hyperlinked Method List Name. To configure a new Method List, click the Add button.

Both actions will result in the same window to configure:

Login Method List - Edit
Method List Name default

Method 1 local v Eeyword
Method 2

Method 3
Method 4

chow All Authentication Login Method List Entries

Figure 10- 37. Login Method List - Edit window (default)
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in Method List - Add

‘

chow All Authentication Login Method List Entries

Figure 10- 38. Login Method List — Add window
To define a Login Method List, set the following parameters and click Apply:

Parameter Description
Method List Name Enter a method list name defined by the user of up to 15 characters.
Method 1, 2, 3, 4 The user may add one, or a combination of up to four of the following authentication

methods to this method list:
. tacacs - Adding this parameter will require the user to be authenticated using
the TACACS protocol from a remote TACACS server.

o  xtacacs - Adding this parameter will require the user to be authenticated using
the XTACACS protocol from a remote XTACACS server.

. tacacs+ - Adding this parameter will require the user to be authenticated using
the TACACS+ protocol from a remote TACACS+ server.

e  radius - Adding this parameter will require the user to be authenticated using the
RADIUS protocol from a remote RADIUS server.

o server_group - Adding this parameter will require the user to be authenticated
using a user-defined server group previously configured on the Switch.

. local - Adding this parameter will require the user to be authenticated using the
local user account database on the Switch.

. none - Adding this parameter will require an authentication to access the Switch.

Enable Method Lists

The Enable Method List Settings window is used to set up Method Lists to promote users with user level privileges to
Administrator (Admin) level privileges using authentication methods on the Switch. Once a user acquires normal user level
privileges on the Switch, he or she must be authenticated by a method on the Switch to gain administrator privileges on the
Switch, which is defined by the Administrator. A maximum of eight Enable Method Lists can be implemented on the Switch, one
of which is a default Enable Method List. This default Enable Method List cannot be deleted but can be configured.

The sequence of methods implemented in this command will affect the authentication result. For example, if a user enters a
sequence of methods like TACACS - XTACACS - Local Enable, the Switch will send an authentication request to the first
TACACS host in the server group. If no verification is found, the Switch will send an authentication request to the second
TACACS host in the server group and so on, until the list is exhausted. At that point, the Switch will restart the same sequence
with the following protocol listed, XTACACS. If no authentication takes place using the XTACACS list, the Local Enable
password set in the Switch is used to authenticate the user.

Successful authentication using any of these methods will give the user an "Admin" privilege.

4? o NOTE: To set the Local Enable Password, see the next section, entitled
M ¥ Local Enable Password.
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To view the following table, click Security > Access Authentication Control > Enable Method Lists:

Add

L7
=
?
5

&,
o

Enable Method Lists

I;Eig:’d List Method1  |[Method 2 Method 3 Method 4

default local enable >

Figure 10- 39. Enable Method List Settings window

To delete an Enable Method List defined by the user, click the % under the Delete heading corresponding to the entry desired to

be deleted. To modify an Enable Method List, click on its hyperlinked Method List Name. To configure a Method List, click the
Add button.

Both actions will result in the same window to configure:

Enable Method List - Edit

default

Method 1 local_enable ¥ | Eeyword
Method 2

Method 3

Method 4

chow Al Authentication Enable List Entries

Figure 10- 40. Enable Method List - Edit window

Enable Method List - Add

Method List Name

Method 1 local_enable v
Method 2

Method 3

Method 4

chow A1 Authentication Enable List Entries

Figure 10- 41. Enable Method List - Add window
To define an Enable Login Method List, set the following parameters and click Apply:

Parameter Description
Method List Name Enter a method list name defined by the user of up to 15 characters.
Method 1, 2, 3, 4 The user may add one, or a combination of up to four of the following authentication

methods to this method list:

e local_enable - Adding this parameter will require the user to be authenticated
using the local enable password database on the Switch. The user in the next
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section entitled Local Enable Password must set the local enable password.
none - Adding this parameter will require an authentication to access the Switch.

radius - Adding this parameter will require the user to be authenticated using the
RADIUS protocol from a remote RADIUS server.

tacacs - Adding this parameter will require the user to be authenticated using
the TACACS protocol from a remote TACACS server.

xtacacs - Adding this parameter will require the user to be authenticated using
the XTACACS protocol from a remote XTACACS server.

tacacs+ - Adding this parameter will require the user to be authenticated using
the TACACS protocol from a remote TACACS server.

server_group - Adding a previously configured server group will require the user
to be authenticated using a user-defined server group previously configured on
the Switch.
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Configure Local Enable Password

This window will configure the locally enabled password for the Enable Admin command. When a user chooses the
"local_enable" method to promote user level privileges to administrator privileges, he or she will be prompted to enter the
password configured here that is locally set on the Switch.

To view the following window, click Security > Access Authentication Control > Configure Local Enable Password:

Configure Local Enable Password

Old Local Enable Password
New Local Enable Password
Confirm Local Enable Password

Figure 10- 42. Configure Local Enable Password window

To set the Local Enable Password, set the following parameters and click Apply.

Parameter Description

Old Local Enabled If a password was previously configured for this entry, enter it here in order to change it to
a new password

New Local Enabled Enter the new password that you wish to set on the Switch to authenticate users
attempting to access Administrator Level privileges on the Switch. The user may set a
password of up to 15 characters.

Confirm Local Enabled | Confirm the new password entered above. Entering a different password here from the
one set in the New Local Enabled field will result in a fail message.

Enable Admin

The Enable Admin window is for users who have
logged on to the Switch on the normal user level, and Enable Admin

wish to be promoted to the administrator level. After Click "“Enable Admin" hutton will let user input the new password to
logging on to the Switch, users will have only user level upgrade this web management to " Admin" level.

privileges. To gain access to administrator level
privileges, the user will open this window and will have | If the password is incorrect, weh management will stay at the login page
to enter an authentication password. Possible | andwaitfor user to login again.

authentication methods for this function include

TACACS/XTACACS/TACACS+/RADIUS, user Enahle Admin |
defined server groups, local enable (local account on

the Switch), or no authentication (none). Because Figure 10- 43. Enable Admin window
XTACACS and TACACS do not support the enable -

function, the user must create a special account on the
server host, which has the username "enable", and a
password configured by the administrator that will
support the "enable" function. This function becomes
inoperable when the authentication policy is disabled.

Connect to 10.90.90.90 (@3

DES-3028P

When this window appears, click the Enable Admin
button revealing a dialog box for the user to enter
authentication (password, username), as seen below. A Password: sesen
successful entry will promote the user to Administrator
level privileges on the Switch.

User name: € admin w

[CIremember my passward

To view the following window, click Security > Access
Authentication Control > Enable Admin: Lo J[ concel ]

Figure 10- 44. Enter Network Password dialog box
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Traffic Segmentation

Traffic segmentation is used to limit traffic flow from a single port to a group of ports on a single Switch. This method of
segmenting the flow of traffic is similar to using VLANS to limit traffic, but is more restrictive. It provides a method of directing
traffic that does not increase the overhead of the Master switch CPU.

In the Security folder, click Traffic Segmentation, to view the window shown below:

Potl +

1 1-28
2 1-28
3 1-28
4 1-28
5 1-28
6 1-28
7 1-28
2 1-28
9 1-28
10 1-28
11 1-28
12 1-28
13 1-28
14 1-28
15 1-28
16 1-28
17 1-28
12 1-28
19 1-28
20 1-28
21 1-28
22 1-28
23 1-28
24 1-28
25 1-28
26 1-28
27 1-28
28 1-28

Figure 10- 45. Traffic Segmentation window

Click on the Setup button to open the Setup Forwarding ports window, as shown below:
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Setup Forwarding ports
Port Fortl

rorard Porth il 203 14 1516 1 718 ]9 [10[11]12]13)14]15]16]17]18]19[20[21]22 23|24 25 26 [27]28

View Sethings of Al Ports

Figure 10- 46. Setup Forwarding ports window

This window allows the user to determine which port on a given switch will be allowed to forward packets to other ports on that
switch.

To configure traffic segmentation specify a port from that switch, using the Port pull-down menu. Click Apply to enter the
settings into the Switch’s Traffic Segmentation table.
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Section 11

Monitoring

CPU Utilization
Port Utilization
Packets

Packet Errors
Packet Size

MAC Address
Switch Log

IGMP Snooping Group
Browse Router Port
Static ARP Settings
Session Table

Port Access Control

CPU Utilization

The CPU Utilization displays the percentage of the CPU being used, expressed as an integer percentage and calculated as a
simple average by time interval. To view the CPU Utilization window, open the Monitoring folder and click the CPU
Utilization link.

Clear

Five CS
One Min

Five Mins

Unit:(%)

Tirne Intereal 15 ~|  Record Number  |200 | Apply
Show/Hide ¥ Five Secs ¥ One Min v Five Ming

Figure 11- 1. CPU Utilization graph

To view the CPU utilization by port, use the real-time graphic of the Switch at the top of the web page by simply clicking on a
port. Click Apply to implement the configured settings. The window will automatically refresh with new updated statistics.

The information is described as follows:
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Parameter

Description

Time Interval

Select the desired setting between 7s and 60s, where "s" stands for seconds. The default
value is one second.

Record Number

Select number of times the Switch will be polled between 20 and 200. The default value is
200.

Show/Hide

Check whether to display Five Secs, One Min, and/or Five Mins.

Clear

Clicking this button clears all statistics counters on this window.

Port Utilization

The Port Utilization page displays the percentage of the total available bandwidth being used on the port.

To view the port utilization, open the Monitoring folder and then the Port Utilization link:

Time Interval

ShowrHide

|P0rt15 'I Applyl

|1s 'I

v’ Litilization

Record Mumhber

200

W 0% |

Figure 11- 2. Port Utilization window

The user may use the real-time graphic of the Switch at the top of the web page to view utilization statistics per port by clicking
on a port. Click Apply to implement changes made. The following field can be set:

Parameter

Description

Time Interval

Select the desired setting between 1s and 60s, where “s” stands for seconds. The default
value is one second.

Record Number

Select number of times the Switch will be polled between 20 and 200. The default value is
200.

Show/Hide

Check whether to display Utilization.

Clear

Clicking this button clears all statistics counters on this window.
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Packets

The Web Manager allows various packet statistics to be viewed as either a line graph or a table. Six windows are offered.

Received (RX)

Click the Received (RX) link in the Packets folder of the Monitoring menu to view the following graph of packets received on
the Switch. To select a port to view these statistics for, use the Port pull-down menu. The user may also use the real-time graphic
of the Switch at the top of the web page by simply clicking on a port.

|P0r115 'I Applyl

Clear | View Table

Time Interval E »|  Record Mumber |00 | Apply

ShowHide v Biytes ¥ Packets

Figure 11- 3. Rx Packets Analysis window (line graph for Bytes and Packets)
To view the Received Packets Table, click the link View Table, which will show the following table:
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View Line Chart

Packet Analysis of Port 15 Time Interval m

Bytes 5 fate s

Packets 349645 a5

Unicast 7

hulticast 5962

Broadcast

Tx Packets

BEytes 2H9ETA( 945

Packets 11304 4

Figure 11- 4. Rx Packets Analysis Table

The following fields may be set or viewed:

Parameter Description

Time Interval Select the desired setting between 7s and 60s, where "s" stands for seconds. The default
value is one second.

Record Number gg:)ect number of times the Switch will be polled between 20 and 200. The default value is

Bytes Counts the number of bytes received on the port.

Packets Counts the number of packets received on the port.

Unicast Counts the total number of good packets that were received by a unicast address.

Multicast Counts the total number of good packets that were received by a multicast address.

Broadcast Counts the total number of good packets that were received by a broadcast address.

Show/Hide Check whether to display Bytes and Packets.

Clear Clicking this button clears all statistics counters on this window.

View Table Clicking this button instructs the Switch to display a table rather than a line graph.

View Line Chart Clicking this button instructs the Switch to display a line graph rather than a table.
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UMB Cast (RX)

Click the UMB Cast (RX) link in the Packets folder of the Monitoring menu to view the following graph of UMB cast packets
received on the Switch. To select a port to view these statistics for, use the Port pull-down menu. The user may also use the real-
time graphic of the Switch at the top of the web page by simply clicking on a port.

T
|P0rﬂ 'I Apply |

Clear |View Table

1000

500 Unicast  [NEEEEEEE
800 Multicast  EEER
oo Broadcast

BO0

00

400

Tirme Interval |15 x| Record Mumber  [200 =| Apply

ShowHide ¥ Unicast ¥ Multicast ¥ Broadcast

Figure 11- 5. Rx Packets Analysis window (line graph for Unicast, Multicast, and Broadcast Packets)
To view the UMB Cast Table, click the View Table link, which will show the following table:
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WView Line Chart

Rx Packets

Packet Analysis of Port 156

Bytes

Fackets

Rx Packets

Unicast

hulticast

Broadcast

Tx Packets

Bytes

Packets

Time Interval  IERE]

e

Figure 11- 6. Rx Packets Analysis window (table for Unicast, Multicast, and Broadcast Packets)

The following fields may be set or viewed:

Parameter Description

Time Interval

Select the desired setting between 7s and 60s, where "s" stands for seconds. The default
value is one second.

Record Number

Select number of times the Switch will be polled between 20 and 200. The default value is
200.

Unicast Counts the total number of good packets that were received by a unicast address.
Multicast Counts the total number of good packets that were received by a multicast address.
Broadcast Counts the total number of good packets that were received by a broadcast address.
Show/Hide Check whether or not to display Multicast, Broadcast, and Unicast Packets.

Clear Clicking this button clears all statistics counters on this window.

View Table Clicking this button instructs the Switch to display a table rather than a line graph.

View Line Chart

Clicking this button instructs the Switch to display a line graph rather than a table.

178




Transmitted (TX)

Click the Transmitted (TX) link in the Packets folder of the Monitoring menu to view the following graph of packets
transmitted from the Switch. To select a port to view these statistics for, use the Port pull-down menu. The user may also use the
real-time graphic of the Switch at the top of the web page by simply clicking on a port.

T
|P0r115 'I Apply |

Clear |View Table

Tirme Interval |15 x| Record Mumber  [200 =| Apply

ShowHide W Bytes W Packets

Figure 11- 7. Tx Packets Analysis window (line graph for Bytes and Packets)
To view the Transmitted (TX) Table, click the link View Table, which will show the following table:
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Niew LineChart

Rx Packets

Tirne Interval R

Packet Analysis of Port 15

Bytes 3 faT2

Rx Packets

Packets 17471 32

Lnicast 186 5

multicast 2957 4

Tx Packets

Broadcast

Bytes 1173600 18491

Packets 1785 ]

Figure 11- 8. Tx Packets Analysis window (table for Bytes and Packets)

The following fields may be set or viewed:

Parameter

Description

Time Interval

Select the desired setting between 7s and 60s, where "s" stands for seconds. The default
value is one second.

Record Number

Select number of times the Switch will be polled between 20 and 200. The default value is
200.

Bytes Counts the number of bytes successfully sent from the port.

Packets Counts the number of packets successfully sent on the port.

Unicast Counts the total number of good packets that were transmitted by a unicast address.
Multicast Counts the total number of good packets that were transmitted by a multicast address.
Broadcast Counts the total number of good packets that were transmitted by a broadcast address.
Show/Hide Check whether or not to display Bytes and Packets.

Clear Clicking this button clears all statistics counters on this window.

View Table Clicking this button instructs the Switch to display a table rather than a line graph.

View Line Chart

Clicking this button instructs the Switch to display a line graph rather than a table.
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Packet Errors

The Web Manager allows port error statistics compiled by the Switch's management agent to be viewed as either a line graph or a
table. Four windows are offered.

Received (RX)

Click the Received (RX) link in the Error folder of the Monitoring menu to view the following graph of error packets received
on the Switch. To select a port to view these statistics for, select the port by using the Port pull-down menu. The user may also
use the real-time graphic of the Switch at the top of the web page by simply clicking on a port.

P Jaunly |
|Pur115 vl Apphy |

Clear |View Table

1000
CreError

Drop (0 |

Tirme Interval |1 5 "I Record NumberlzDD v|

ShowfHide [ CrcErrar W UnderSize [ OwerSize ¥ Fragment W Jabber ¥ Drop

Figure 11- 9. Rx Error Analysis window (line graph)

To view the Received Error Packets Table, click the link View Table, which will show the following table:
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Wiew LineChart

Packet Analysis of Port 15 Time Interval m

Rx Error

CrecError

Undersize

Owersize

Fragment

Jabber

Drop

Figure 11- 10. Rx Error Analysis window (table)

The following fields can be set:

Parameter

Description

Time Interval

Select the desired setting between 71s and 60s, where "s" stands for seconds. The default
value is one second.

Record Number

Select number of times the Switch will be polled between 20 and 200. The default value is

200.

Crc Error Counts otherwise valid packets that did not end on a byte (octet) boundary.

UnderSize The number of packets detected that are less than the minimum permitted packets size of
64 bytes and have a good CRC. Undersize packets usually indicate collision fragments, a
normal network occurrence.

OverSize Counts packets received that were longer than 1518 octets, or if a VLAN frame is 1522
octets, and less than the MAX_PKT_LEN. Internally, MAX_PKT_LEN is equal to 1522.

Fragment The number of packets less than 64 bytes with either bad framing or an invalid CRC. These
are normally the result of collisions.

Jabber The number of packets with lengths more than the MAX_PKT_LEN bytes. Internally,
MAX_PKT_LEN is equal to 1522.

Drop The number of packets that are dropped by this port since the last Switch reboot.

Show/Hide Check whether or not to display Crc Error, Under Size, Over Size, Fragment, Jabber, and
Drop errors.

Clear Clicking this button clears all statistics counters on this window.

View Table Clicking this button instructs the Switch to display a table rather than a line graph.

View Line Chart

Clicking this button instructs the Switch to display a line graph rather than a table.
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Transmitted (TX)

Click the Transmitted (TX) link in the Error folder of the Monitoring menu to view the following graph of error packets received
on the Switch. To select a port to view these statistics for, select the port by using the Port pull-down menu. The user may also
use the real-time graphic of the Switch at the top of the web page by simply clicking on a port.

Port Apply
|P0r‘c15 'I Apply |

Clear | view Table

1000

ExDefer _

800

800

700

&00

500

400

300 croror [
200

100

T
15:0:23

Time Interval |1 5 vl Record Numherizuu v|

ShowiHide W ExDefer v LateColl W ExCaoll v SingColl v Call ¥ CRCErraor

Figure 11- 11. Tx Error Analysis window (line graph)
To view the Transmitted Error Packets Table, click the link View Table, which will show the following table:

Wiew Line Chart
Packet Analysis of Port 15 Time Interval m

Tx Error

ExDefer

LateColl

ExColl

SingCall

Call

CRCError

Figure 11- 12. Tx Error Analysis window (table)

The following fields may be set or viewed:
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Parameter

Description

Time Interval

Select the desired setting between 7s and 60s, where "s" stands for seconds. The default
value is one second.

Record Number

Select number of times the Switch will be polled between 20 and 200. The default value is
200.

ExDefer Counts the number of packets for which the first transmission attempt on a particular
interface was delayed because the medium was busy.

CRC Error Counts otherwise valid packets that did not end on a byte (octet) boundary.

LateColl Counts the number of times that a collision is detected later than 512 bit-times into the
transmission of a packet.

ExColl Excessive Collisions. The number of packets for which transmission failed due to excessive
collisions.

SingColl Single Collision Frames. The number of successfully transmitted packets for which
transmission is inhibited by more than one collision.

Coll An estimate of the total number of collisions on this network segment.

Show/Hide Check whether or not to display ExDefer, LateColl, ExColl, SingColl, and Coll errors.

Clear Clicking this button clears all statistics counters on this window.

View Table Clicking this button instructs the Switch to display a table rather than a line graph.

View Line Chart

Clicking this button instructs the Switch to display a line graph rather than a table.
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Packet Size

The Web Manager allows packets received by the Switch, arranged in six groups and classed by size, to be viewed as either a line
graph or a table. Two windows are offered. To select a port to view these statistics for, select the port by using the Port pull-down
menu. The user may also use the real-time graphic of the Switch at the top of the web page by simply clicking on a port.

P lagply
|Purt15 vl Applyl

Clear | View Table

1000
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ShowiHide W 64 v 68127 ¥ 128-255 v 286-511 W 512-1023 W 1024-1518

Figure 11- 13. Rx Size Analysis window (line graph)
To view the Packet Size Analysis Table, click the link View Table, which will show the following table:

WView Line Chart

Packet Analysis of Pert 15 Time Interval m

£ 17 19

B5-127

128-253

256-511

512-1023

1024-1518

Figure 11- 14. Rx Size Analysis window (table)

The following fields can be set or viewed:
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Parameter

Description

Time Interval

Select the desired setting between 1s and 60s, where "s" stands for seconds. The default
value is one second.

Record Number

Select number of times the Switch will be polled between 20 and 200. The default value is
200.

64 The total number of packets (including bad packets) received that were 64 octets in length
(excluding framing bits but including FCS octets).

65-127 The total number of packets (including bad packets) received that were between 65 and
127 octets in length inclusive (excluding framing bits but including FCS octets).

128-255 The total number of packets (including bad packets) received that were between 128 and
255 octets in length inclusive (excluding framing bits but including FCS octets).

256-511 The total number of packets (including bad packets) received that were between 256 and
511 octets in length inclusive (excluding framing bits but including FCS octets).

512-1023 The total number of packets (including bad packets) received that were between 512 and
1023 octets in length inclusive (excluding framing bits but including FCS octets).

1024-1518 The total number of packets (including bad packets) received that were between 1024 and
1518 octets in length inclusive (excluding framing bits but including FCS octets).

Show/Hide Check whether or not to display 64, 65-127, 128-255, 256-511, 512-1023, and 1024-1518
packets received.

Clear Clicking this button clears all statistics counters on this window.

View Table Clicking this button instructs the Switch to display a table rather than a line graph.

View Line Chart

Clicking this button instructs the Switch to display a line graph rather than a table.
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MAC Address

This allows the Switch's dynamic MAC address forwarding table to be viewed. When the Switch learns an association between a
MAC address and a port number, it makes an entry into its forwarding table. These entries are then used to forward packets
through the Switch.

To view the MAC Address forwarding table, from the Monitoring menu, click the MAC Address link:

o) (o)
MAC Address 00-00-00-00-00-00
Port Faort1 + [Find” Delete ]
| ViewAllEntry || Delete AllEntry |
MAC Address
VID VAN Name MAC Adiron I
1 default O0-50-BA-30-25-00)
1 defanlt 00-50-BA-DA-01-23 13 Djmamic:

Total Entries: 2

Figure 11- 15. MAC Address window

The following fields can be viewed or set:

Parameter Description

VLAN Name Enter a VLAN Name by which to browse the forwarding table.

MAC Address Enter a MAC address by which to browse the forwarding table.

Port Select the port by using the corresponding pull-down menu.

Find Allows the user to move to a sector of the database corresponding to a user defined port,

VLAN, or MAC address.

VID The VLAN ID of the VLAN of which the port is a member.

MAC Address The MAC address entered into the address table.

Port The port to which the MAC address above corresponds.

Type Describes the method which the Switch discovered the MAC address. The possible entries
are Dynamic, Self, and Static.

Next Click this button to view the next page of the address table.

View All Entry Clicking this button will allow the user to view all entries of the address table.
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Switch Log

The Web manager allows the Switch's history log, as compiled by the Switch's management agent, to be viewed. To view the
Switch history log, open the Monitoring folder and click the Switch Log link.

Switch Log

Figure 11- 16. Switch History Log window

The Switch can record event information in its own logs, to designated SNMP trap receiving stations, and to the PC connected to
the console manager. Click Next to go to the next page of the Switch History Log. Clicking Clear will allow the user to clear the
Switch History Log.

The information is described as follows:

Parameter Description

Sequence A counter incremented whenever an entry to the Switch's history log is made. The table
displays the last entry (highest sequence number) first.

Time Displays the time in days, hours, and minutes since the Switch was last restarted.

Log Text Displays text describing the event that triggered the history log entry.
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IGMP Snooping Group

This window allows the Switch’s IGMP Snooping Group Table to be viewed. IGMP Snooping allows the Switch to read the
Multicast Group IP address and the corresponding MAC address from IGMP packets that pass through the Switch. The number of
IGMP reports that were snooped is displayed in the Reports field.

To view the IGMP Snooping Group window, click IGMP Snooping Group on the Monitoring menu:

7TD - |fi] Search

IGMP Snooping Group

VLANID Multicast Group MAC Address

0000 00:00:00:00:00:00

Porxt Map

(O N O SO T 2 N P T T T N T

Total Entries: 0

Figure 11- 17. IGMP Snooping Group window
The user may search the IGMP Snooping Group Table by VID by entering it in the top left hand corner and clicking Search.

The following field can be viewed:

Parameter Description
VLAN Name The VLAN Name of the multicast group.
Multicast Group The IP address of the multicast group.
MAC Address The MAC address of the multicast group.
Reports The total number of reports received for this group.
Port Member These are the ports where the IGMP packets were snooped are displayed.
gy NOTE: To configure IGMP snooping for the Switch, go to the L2 Features
"'.r.' folder and select IGMP Snooping. Configuration and other information
f 4§ concerning IGMP snooping may be found in Section 7 of this manual
e under IGMP Snooping.
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Browse Router Port

This displays which of the Switch’s ports are currently configured as router ports. A router port configured by a user (using the
console or Web-based management interfaces) is displayed as a static router port, designated by S. A router port that is
dynamically configured by the Switch is designated by D.

Total Entries: 1
Browse Router Port

VLAN ID VLAN Name
1 default

IO S S S S A S S TR TR R TR VR

R T O R T T S T T T TR

Figure 11- 18. Browse Router Port window

Static ARP Settings

The Browse ARP Table window may be found in the Monitoring menu. This window will show current ARP entries on the
Switch. To clear the ARP Table, click Clear All

Add|  Clear Al |

Static ARP Settings
Tntortace Name JIP Adiress — [MAC Adiros

System 10.0.0.0 FF-FF-FF-FF-FE-FF  LocalBroadeast _Modily | X]
System 10.24.22.5 00-50-BA-DA-01-23  Dynamic _Modify | X
Systemn 10.90.90.91 00-50-BA-30-28-00  Local _Modify | X
System 10.255.255.255 FF-FE-FF-FE-FF-FF  LocalBroadcast _Modity | X]

Total Entries : 4

Figure 11- 19. Static ARP Settings window
To add an entry to the Static ARP Settings table, click the Add button.

Static ARP Settings - Add

show AL Static AETP Entries

Figure 11- 20. Static ARP Settings — Add window
To modify an entry, select it on the ARP Settings table and click Modify.
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Static ARP Settings - Edit
IP Address
MAC Address FF-FF-FF-FF-FF-FF

chow All Static ARTF Entries

Figure 11- 21. Static ARP Settings — Edit window

Session Table

The Session Table allows the user to view detailed information on the current configuration session of the Switch. Information
such as the Session ID of the user, initial Login Time, Live Time, configuration connection From the Switch, Level and Name
of the user are displayed. Click Reload to refresh this window.

Total Fntries :1
Session Table

N S S

Q0000 days 12:47.35 Q0:00:11.680 Serial Port 1 Anonymens

Figure 11- 22. Session Table window

Port Access Control

The following windows are used to monitor 802.1x statistics of the Switch, on a per port basis. To view the Port Access Control
windows, open the Monitoring folder and click the Port Access Control folder. There are six windows to monitor.

NOTE: The Authenticator State, Authenticator Statistics,

] Authenticator Session Statistics and Authenticator Diagnostics

;-Fj%y windows in this section cannot be viewed on the Switch unless 802.1x is

L : enabled by port or by MAC address. To enable 802.1x, go to the Switch
802.1x entry in the DES-30xx Web Management Tool.

RADIUS Authentication

This table contains information concerning the activity of the RADIUS authentication client on the client side of the RADIUS
authentication protocol. It has one row for each RADIUS authentication server that the client shares a secret with. To view the
RADIUS Authentication, click Monitoring > Port Access Control > RADIUS Authentication.
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Clear

RADIUS Authentication  Time Interval |[FR|

Invalidserver |dentifier ServerlPAddr LIDF Fort Challenges Rejects
1 0 DES-3028P 0 0 0 i} a ]

The user may also select the desired time interval to update the statistics, between /s and 60s, where “s” stands for seconds.

Figure 11- 23. RADIUS Authentication window
The

default value is one second. To clear the current statistics shown, click the Clear button in the top left hand corner.

The following fields can be viewed:

Parameter Description

Server The identification number assigned to each RADIUS Authentication server that the client
shares a secret with.

UDP Port The UDP port the client is using to send requests to this server.

Timeouts The number of authentication timeouts to this server. After a timeout the client may retry to
the same server, send to a different server, or give up. A retry to the same server is counted
as a retransmit as well as a timeout. A send to a different server is counted as a Request as
well as a timeout.

Requests The number of RADIUS Access-Request packets sent to this server. This does not include
retransmissions.

Challenges The number of RADIUS Access-Challenge packets (valid or invalid) received from this
server.

Accepts The number of RADIUS Access-Accept packets (valid or invalid) received from this server.

AccessRejects The number of RADIUS Access-Reject packets (valid or invalid) received from this server.

RoundTripTime

The time interval (in hundredths of a second) between the most recent Access-
Reply/Access-Challenge and the Access-Request that matched it from this RADIUS
authentication server.

AccessRetrans

The number of RADIUS Access-Request packets retransmitted to this RADIUS
authentication server.

PendingRequests

The number of RADIUS Access-Request packets destined for this server that have not yet
timed out or received a response. This variable is incremented when an Access-Request is
sent and decremented due to receipt of an Access-Accept, Access-Reject or Access-
Challenge, a timeout or retransmission.

AccessResponses

The number of malformed RADIUS Access-Response packets received from this server.
Malformed packets include packets with an invalid length. Bad authenticators or Signature
attributes or known types are not included as malformed access responses.
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BadAuthenticators

The number of RADIUS Access-Response packets containing invalid authenticators or
Signature attributes received from this server.

UnknownTypes The number of RADIUS packets of unknown type which were received from this server on
the authentication port
PacketsDropped The number of RADIUS packets of which were received from this server on the

authentication port and dropped for some other reason.
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RADIUS Accounting

This window shows managed objects used for managing RADIUS accounting clients, and the current statistics associated with
them. It has one row for each RADIUS authentication server that the client shares a secret with. To view the RADIUS

Accounting, click Monitoring > Port Access Control > RADIUS Accounting.

Clear

Invalid5erverAddr Identifier Server P Addr Server Port Mumber
1 1] DE 1P ] i} a

Figure 11- 24. RADIUS Accounting window

The user may also select the desired time interval to update the statistics, between /s and 60s, where “s” stands for seconds. The
default value is one second. To clear the current statistics shown, click the Clear button in the top left hand corner.

The following fields can be viewed:

Parameter

Description

Server IP Addr

The IP address assigned to each RADIUS Accounting server that the client shares a secret
with.

UDP Port The UDP port the client is using to send requests to this server.

Timeouts The number of accounting timeouts to this server. After a timeout the client may retry to the
same server, send to a different server, or give up. A retry to the same server is counted as
a retransmit as well as a timeout. A send to a different server is counted as an Accounting-
Request as well as a timeout.

Requests The number of RADIUS Accounting-Request packets sent. This does not include
retransmissions.

Responses The number of RADIUS packets received on the accounting port from this server.

RoundTripTime

The time interval between the most recent Accounting-Response and the Accounting-
Request that matched it from this RADIUS accounting server.

AccessRetrans

The number of RADIUS Access-Request packets retransmitted to this RADIUS

authentication server.

PendingRequests

The number of RADIUS Accounting-Request packets sent to this server that have not yet
timed out or received a response. This variable is incremented when an Accounting-
Request is sent and decremented due to receipt of an Accounting-Response, a timeout or a
retransmission.

MalformedResponses

The number of malformed RADIUS Accounting-Response packets received from this
server. Malformed packets include packets with an invalid length. Bad authenticators and
unknown types are not included as malformed accounting responses.

BadAuthenticators

The number of RADIUS Accounting-Response packets, which contained invalid

authenticators, received from this server.
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UnknownTypes The number of RADIUS packets of unknown type which were received from this server on
the accounting port.
PacketsDropped The number of RADIUS packets, which were received from this server on the accounting

port and dropped for some other reason.
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Auth Diagnostics

This table contains the diagnostic information regarding the operation of the Authenticator associated with each port. An entry
appears in this table for each port that supports the Authenticator function. To view the Authenticator Diagnestics, click
Monitoring > Port Access Control > Auth Diagnostics.

Authenticator Session Time Interval  |FIERRES

1 1] 1] 1} supplogof

Figure 11- 25. Authenticator Diagnostics window

The user may select the desired time interval to update the statistics, between /s and 60s, where “s” stands for seconds. The
default value is one second.

The following fields can be viewed:

Parameter Description

Port The identification number assigned to the Port by the System in which the Port
resides.

EntersConnecting Counts the number of times that the state machine transitions to the CONNECTING

state from any other state.

EapLogOffsConnecting Counts the number of times that the state machine transitions from CONNECTING to
DISCONNECTED as a result of receiving an EAPOL-Logoff message.

EntersAuthenticating Counts the number of times that the state machine transitions from CONNECTING to
AUTHENTICATING, as a result of an EAP-Response/ldentity message being received
from the Supplicant.

SuccessAuthenticating Counts the number of times that the state machine transitions from
AUTHENTICATING to AUTHENTICATED, as a result of the Backend Authentication
state machine indicating successful authentication of the Supplicant (authSuccess =
TRUE).
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TimeoutsAuthenticating

Counts the number of times that the state machine transitions from
AUTHENTICATING to ABORTING, as a result of the Backend Authentication state
machine indicating authentication timeout (authTimeout = TRUE).

FailAuthenticating

Counts the number of times that the state machine transitions from
AUTHENTICATING to HELD, as a result of the Backend Authentication state machine
indicating authentication failure (authFail = TRUE).

ReauthsAuthenticating

Counts the number of times that the state machine transitions from
AUTHENTICATING to ABORTING, as a result of a reauthentication request
(reAuthenticate = TRUE).

EapStartsAuthenticating

Counts the number of times that the state machine transitions from
AUTHENTICATING to ABORTING, as a result of an EAPOL-Start message being
received from the Supplicant.

EapLogOffAuthenticating

Counts the number of times that the state machine transitions from
AUTHENTICATING to ABORTING, as a result of an EAPOL-Logoff message being
received from the Supplicant.

ReauthsAuthenticated Counts the number of times that the state machine transitions from AUTHENTICATED
to CONNECTING, as a result of a reauthentication request (reAuthenticate = TRUE).
EapStartsAuthenticated Counts the number of times that the state machine transitions from AUTHENTICATED

to CONNECTING, as a result of an EAPOL-Start message being received from the
Supplicant.

EapLogOffAuthenticated

Counts the number of times that the state machine transitions from AUTHENTICATED
to DISCONNECTED, as a result of an EAPOL-Logoff message being received from
the Supplicant.

Responses

Counts the number of times that the state machine sends an initial Access-Request
packet to the Authentication server (i.e., executes sendRespToServer on entry to the
RESPONSE state). Indicates that the Authenticator attempted communication with the
Authentication Server.

AccessChallenges

Counts the number of times that the state machine receives an initial Access-
Challenge packet from the Authentication server (i.e., aReq becomes TRUE, causing
exit from the RESPONSE state). Indicates that the Authentication Server has
communication with the Authenticator.

OtherReqToSupp

Counts the number of times that the state machine sends an EAP-Request packet
(other than an Identity, Notification, Failure, or Success message) to the Supplicant
(i.e., executes txReq on entry to the REQUEST state). Indicates that the Authenticator
chose an EAP-method.

ResponsesFromSupplicant

Counts the number of times that the state machine receives a response from the
Supplicant to an initial EAP-Request, and the response is something other than EAP-
NAK (i.e., rxResp becomes TRUE, causing the state machine to transition from
REQUEST to RESPONSE, and the response is not an EAP-NAK). Indicates that the
Supplicant can respond to the Authenticator's chosen EAP-method.

AuthSuccesses Counts the number of times that the state machine receives an Accept message from
the Authentication Server (i.e., aSuccess becomes TRUE, causing a transition from
RESPONSE to SUCCESS). Indicates that the Supplicant has successfully
authenticated to the Authentication Server.

AuthFails Counts the number of times that the state machine receives a Reject message from

the Authentication Server (i.e., aFail becomes TRUE, causing a transition from
RESPONSE to FAIL). Indicates that the Supplicant has not authenticated to the
Authentication Server.
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Auth Session Statistics

This table contains the session statistics objects for the Authenticator PAE associated with each port. An entry appears in this table
for each port that supports the Authenticator function. To view the Authenticator Session Statistics, click Monitoring > Port
Access Control > Auth Session Statistics.

Authenticator Session  Time Interval

Figure 11- 26. Authenticator Session Counter window

The user may select the desired time interval to update the statistics, between /s and 60s, where “s” stands for seconds. The
default value is one second.

The following fields can be viewed:

Parameter Description

Port The identification number assigned to the Port by the System in which the Port resides.
Frames Rx The number of user data frames received on this port during the session.

Frames Tx The number of user data frames transmitted on this port during the session.
UserName The User-Name representing the identity of the Supplicant PAE.

Time The duration of the session in seconds.

Terminate Cause

The reason for the session termination. There are eight possible reasons for termination.
1) Supplicant Logoff
2) Port Failure
3) Supplicant Restart

4) Reauthentication Failure
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5) AuthControlledPortControl set to ForceUnauthorized
6) Port re-initialization

7) Port Administratively Disabled

8) Not Terminated Yet

Octets Rx The number of octets received in user data frames on this port during the session.
Octets Tx The number of octets transmitted in user data frames on this port during the session.
ID A unique identifier for the session, in the form of a printable ASCII string of at least three

characters.

Authentic Method

The authentication method used to establish the session. Valid Authentic Methods include:

(1) Remote Authentic Server - The Authentication Server is external to the Authenticator’s
System.

(2) Local Authentic Server - The Authentication Server is located within the Authenticator’s
System.

Auth Statistics

This table contains the statistics objects for the Authenticator PAE associated with each port. An entry appears in this table for
each port that supports the Authenticator function. To view the Authenticator Statistics, click Monitoring > Port Access Control

> Auth Statistics.

Authenticator Statistics Time Intereal
1 a a a u} u} u} u} u} u}

Figure 11- 27. Authenticator Statistics window

The user may select the desired time interval to update the statistics, between /s and 60s, where “s” stands for seconds. The
default value is one second.
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The following fields can be viewed:

Parameter Description

Port The identification number assigned to the Port by the System in which the Port resides.

Frames Rx The number of valid EAPOL frames that have been received by this Authenticator.

Frames Tx The number of EAPOL frames that have been transmitted by this Authenticator.

Rx Start The number of EAPOL Start frames that have been received by this Authenticator.

TxReqld The number of EAP Reg/ld frames that have been transmitted by this Authenticator.

RxLogOff The number of EAPOL Logoff frames that have been received by this Authenticator.

Tx Req The number of EAP Request frames (other than Rq/ld frames) that have been transmitted
by this Authenticator.

Rx Respld The number of EAP Resp/Id frames that have been received by this Authenticator.

Rx Resp The number of valid EAP Response frames (other than Resp/ld frames) that have been
received by this Authenticator.

Rx Invalid The number of EAPOL frames that have been received by this Authenticator in which the
frame type is not recognized.

Rx Error The number of EAPOL frames that have been received by this Authenticator in which the

Packet Body Length field is invalid.

Last Version

The protocol version number carried in the most recently received EAPOL frame.

Last Source

The source MAC address carried in the most recently received EAPOL frame.
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Auth State

This table displays the Authenticator State for each port. To view the Authenticator State, click Monitoring > Port Access
Control > Auth State.

Authenticator State  Time Interval m

Auth PAE State 3 Fortstatus
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Figure 11- 28. Authenticator State window

The user may select the desired time interval to update the statistics, between /s and 60s, where “s” stands for seconds. The
default value is one second.




Reset

The Reset function has several options when resetting the Switch. Some of the current configuration parameters can be retained
while resetting all other configuration parameters to their factory defaults.

NOTE: Only the Reset System option will enter the factory default

Fhis parameters into the Switch’s non-volatile RAM, and then restart the
/ Switch. All other options enter the factory defaults into the current

f:':r' configuration, but do not save this configuration. Reset System will
f return the Switch’s configuration to the state it was when it left the

-
factory
) Reset Proceed with system reset except IP address, log, user

account.
0 Reset Confiz Proceed with system reset

(0 Reset System Proceed with system reset (reset all, save, reboot).

Figure 11- 29. Reset window
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Reboot System

The following window is used to restart the Switch.

Reboot System

If vou do not save the sethngs, all changes made m tlus session will be
lost.

Do you want to save the settings? & Yes O No

Figure 11- 30. Reboot System window

Clicking the Yes radio button will instruct the Switch to save the current configuration to non-volatile RAM before restarting the
Switch.

Clicking the No radio button instructs the Switch not to save the current configuration before restarting the Switch. All of the
configuration information entered from the last time Save Changes was executed, will be lost.

Click the Restart button to restart the Switch.

Save Changes

The Switch has two levels of memory, normal RAM and non-volatile or NV-RAM. Configuration changes are made effective
clicking the Apply button. When this is done, the settings will be immediately applied to the switching software in RAM, and will
immediately take effect.

Some settings, though, require you to restart the Switch before they will take effect. Restarting the Switch erases all settings in
RAM and reloads the stored settings from the NV-RAM. Thus, it is necessary to save all setting changes to NV-RAM before
rebooting the switch.

To retain any configuration changes permanently, click on the Save button in the Save Changes page, as shown below.

Save Changes

» Save Config Sawng all configurations to MNWV-EAR

) Save Log maving all log information to MWV-EAN
) Save All maving all configurations and log mformation to WMV-EAN

Figure 11- 31. Save Changes window
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Logout

Click the Logout button on the Logout window to immediately exit the Switch.

Are you sure vou want logout ?

If ves, Just click the "Logout™ button and retmm to main page.

Figure 11- 32. Logout window
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Appendix A

Technical Specifications

General

Protocols

Fiber-Optic

IEEE 802.3 10BASE-T Ethernet

IEEE 802.3u 100BASE-TX Fast Ethernet
IEEE 802.3ab 1000BASE-T Gigabit Ethernet
IEEE 802.3z 1000BASE-T (SFP “Mini GBIC”)
IEEE 802.1D Spanning Tree

IEEE 802.1D/S/W Spanning Tree

IEEE 802.1Q VLAN

IEEE 802.1p Priority Queues

IEEE 802.1X Port Based Network Access Control
IEEE 802.3ad Link Aggregation Control

IEEE 802.3x Full-duplex Flow Control

IEEE 802.3 NWay auto-negotiation
IEEE802.3af standard (only for POE)

SFP (Mini GBIC) Support:
DEM-310GT (1000BASE-LX)
DEM-311GT (1000BASE-SX)
DEM-314GT (1000BASE-LH)
DEM-315GT (1000BASE-ZX)
DEM-210 (Single Mode 100BASE-FX)
DEM-211 (Multi Mode 100BASE-FX)

WDM Transceivers Supported:

DEM-330T (TX-1550/RX-1310nm), up to 10km, Single-Mode
DEM-330R (TX-1310/RX-1550nm), up to 10km, Single-Mode
DEM-331T (TX-1550/RX-1310nm), up to 40km, Single-Mode
DEM-331R (TX-1310/RX-1550nm), up to 40km, Single-Mode

Standards

CSMA/CD

Data Transfer Rates:

Ethernet
Fast Ethernet
Gigabit Ethernet

Half-duplex Full-duplex
10 Mbps 20Mbps
100Mbps 200Mbps
n/a 2000Mbps

Topology

Star

Network Cables

Cat.5 Enhanced for 1000BASE-T

UTP Cat.5, Cat. 5 Enhanced for 100BASE-TX

UTP Cat.3, 4, 5 for 10BASE-T

EIA/TIA-568 100-ohm screened twisted-pair (STP)(100m)

Number of Ports

DES-3028/DES-3028P: 24 x 10/100Base-T Ports
2 x 1000Base-T/SFP Combo Ports
2 x 1000Base-T ports

DES-3052/DES-3052P: 48 x 10/100Base-T Ports
2 x 1000Base-T/SFP Combo Ports
2 x 1000Base-T ports
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Physical and Environmental

Internal Power Supply

Input: DES-3028/DES-3052 - 100~240V, AC/0.5A, 50~60Hz
DES-3052P - 100~240V, AC/5A, 50~60Hz
DES-3028P - 100~240V, AC/2.9A, 50~60Hz

Output:

DES-3028/DES-3052: 12V, 3.3A (Max)
DES-3028P: 12V, 3.3A/50V, 3.7A (Max)
DES-3052P: 12V,10.5A/50V,7.5A (Max)

Power Consumption

DES-3028 — 25W
DES-3052 — 26W
DES-3028P — 217W
DES-3052P — 395W

DC Fans

DES-3028/DES-3052 — None
DES-3028P — one 8.5cm fan and one 17cm fan

DES-3052P — one 5cm fan, one 8.3cm fan, and one 17cm fan

Operating Temperature

0-40°C

Storage Temperature

-40 - 70°C

Humidity

5 - 95% non-condensing

Dimensions

DES-3028: 441(W) x 207(D) x 44(H) mm
DES-3028P/3052/3052P: 441(W) x 309(D) x 44(H) mm

Weight DES-3028 — 2.36kg (5.20Ibs)
DES-3028P — 4.5kg (9.9Ibs)
DES-3052 — 3.85kg (8.48lbs)
DES-3052P — 5.70kg (12.56Ibs)

EMI CE Class A, FCC Class A, C-Tick, VCCI

Safety CB Report, UL

Performance

Transmission Method

Store-and-forward

Packet Buffer

512 KB per device

Packet Filtering/
Forwarding Rate

14,881 pps (10M port)
148.810 pps (100M port)
1,488,100 pps (1Gbps port)

MAC Address Learning

Automatic update. Supports 8K MAC address

Priority Queues

4 Priority Queues per port.

Forwarding Table Age
Time

Max age: 10-1000000 seconds. Default = 300.
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PoE Features

PoE Capable Ports

DES-3028P:Random 12 ports
DES-3052P:Random 24 ports

Power feeding for PoE

DES-3028P:
Per port >15.4W (Default),

Output capacity for DES-3028P->185W
Power consumption->Max. 225W

DES-3052P:
Per port >15.4W (Default),

Output capacity for DES-3052P—->370W
Power consumption->Max. 500W

PoE Specification

1.

Supplies power to PD device up to 15.4W per port, meeting
IEEE802.3af standards and more sufficiently is able to provide
power to PD devices

2. Auto discovery feature, automatically recognize the connection of PD
device and immediately sends power to it
3. Auto disable port if the port current is over 350mA while other ports
remain active
4. Active circuit protection, automatically disables the port if there is a
short while other ports remain active
5. PD should be able to receive the power following the classification
below
Class Usage Max power used by PD
0 Default 0.44 to 12.95W
1 Optional 0.44 to 3.84W
2 Optional 3.84 to 6.49W
3 Optional 6.49 to 12.95W
4 Not allowed |Reserved
6. PSE should be provide the power following the classification below
Class Usage Max power used by PD
0 Default 15.4W
1 Optional 4.0W
2 Optional 7.0W
3 Optional 15.4W
4 Reserved 15.4W
7. DES-3028P/DES-3052P should follow the standard PSE pin-out
standard of Alternative A which is sending out power over numbern
1,2,3,6 pins of 8 wires of CAT5 UTP cable
8. DES-3028P/DES-3052P works with all D-Link 802.3af capable
devices
9. DES-3028P/DES-3052P works with all nhon-802.3af capable D-Link|
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AP, IP Cam and IP phone via DWL-P50

LED indicators

Location LED Indicative |Color Status Description
Solid Light Power On
Power Green
Light off Power Off
Per Device Solid Light Console on
Console Green Blinking POST is in progress/ POST is failure.
Light off Console off
Link/Act/ Speed |Green Solid Light Link/Act/Speed Mode
“Mode Select Button”
PoE Green Solid Light PoE Mode
When there is a secure 100Mbps Fast
Solid Green Ethernet connection (or link) at any of
the ports.
When there is reception or transmission
Blinking Green ((i.e. Activity—Act) of data occurring at a
Fast Ethernet connected port.
Link/Act/Speed |Green/Amber When there is a secure 10Mbps
Solid Amber  |Ethernet connection (or link) at